
eNetwork Personal Communications
Version 4.3
for Windows® 95, Windows 98, and Windows NT®

Quick Beginnings

GC31-8679-00

IBM





eNetwork Personal Communications
Version 4.3
for Windows® 95, Windows 98, and Windows NT®

Quick Beginnings

GC31-8679-00

IBM



Note
Before using this information and the product it supports, be sure to read the general information under “Appendix K.
Notices” on page 159.

Second Edition (January 1999)

This edition applies to Version 4.3 of IBM eNetwork Personal Communications and to all subsequent releases and
modifications until otherwise indicated in new editions.

© Copyright International Business Machines Corporation 1989, 1999. All rights reserved.
Note to U.S. Government Users — Documentation related to restricted rights — Use, duplication or disclosure is
subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corp.



Contents

About This Book . . . . . . . . . . . . . . . . . . . . . . . ix
Text Conventions Used in This Book . . . . . . . . . . . . . . . . ix
What’s in the Packages . . . . . . . . . . . . . . . . . . . . . x

Part 1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Chapter 1. Welcome to Personal Communications . . . . . . . . . . 3
Personal Communications Program Icons. . . . . . . . . . . . . . . 3

Administrative and Problem Determination (PD) Aids . . . . . . . . . 4
Product Information . . . . . . . . . . . . . . . . . . . . . . 5
Utilities . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Personal Communications Sessions. . . . . . . . . . . . . . . . . 9
Personal Communications Connections . . . . . . . . . . . . . . . 10

System/390 Emulator Connections . . . . . . . . . . . . . . . . 10
AS/400 Emulator Connections . . . . . . . . . . . . . . . . . . 12
ASCII Emulator Connections (SBCS only) . . . . . . . . . . . . . 13
S/3X Emulator Connections . . . . . . . . . . . . . . . . . . . 13
Client/Server (Peer) Connections . . . . . . . . . . . . . . . . . 13
APPN Networking . . . . . . . . . . . . . . . . . . . . . . 14
AnyNet . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Enterprise Extender (HPR over IP) . . . . . . . . . . . . . . . . 15

ActiveX/OLE 2.0 Support . . . . . . . . . . . . . . . . . . . . . 16
Object-Oriented API. . . . . . . . . . . . . . . . . . . . . . . 16
What’s New in Personal Communications 4.3 for Windows 95, Windows 98,

and Windows NT . . . . . . . . . . . . . . . . . . . . . . . 17
Programming Enhancements . . . . . . . . . . . . . . . . . . 17
Database Enhancements . . . . . . . . . . . . . . . . . . . . 17
Connectivity Enhancements . . . . . . . . . . . . . . . . . . . 17
Installation/Configuration Enhancements . . . . . . . . . . . . . . 18
Other Enhancements . . . . . . . . . . . . . . . . . . . . . 18

Part 2. Planning for and Installing Personal Communications . . . . . . . . . 21

Chapter 2. Planning to Install Personal Communications . . . . . . . . 23
Workstation Hardware . . . . . . . . . . . . . . . . . . . . . . 23

Workstation Hard Disk Requirements . . . . . . . . . . . . . . . 23
Workstation Memory Requirements . . . . . . . . . . . . . . . . 24

Workstation Software . . . . . . . . . . . . . . . . . . . . . . 24

Chapter 3. Configuring Sessions . . . . . . . . . . . . . . . . . 25
Creating a Configuration . . . . . . . . . . . . . . . . . . . . . 25

Saving Configuration Information . . . . . . . . . . . . . . . . . 27
Changing Configuration Information . . . . . . . . . . . . . . . . . 28

Changing an SNA Configuration . . . . . . . . . . . . . . . . . 28
Changing a Workstation Profile . . . . . . . . . . . . . . . . . 30

Part 3. Using Personal Communications . . . . . . . . . . . . . . . . . . . 31

Chapter 4. Starting and Stopping Emulator Sessions . . . . . . . . . 33
Starting Sessions . . . . . . . . . . . . . . . . . . . . . . . 33

Starting by Selecting the Session Icon . . . . . . . . . . . . . . . 33
Starting from a Session Window . . . . . . . . . . . . . . . . . 33

© Copyright IBM Corp. 1989, 1999 iii



Starting a Workstation Profile from the Run Command Line . . . . . . . 34
Starting Multiple Sessions . . . . . . . . . . . . . . . . . . . . 34

Creating a Batch File . . . . . . . . . . . . . . . . . . . . . 34
Using a Batch File . . . . . . . . . . . . . . . . . . . . . . 37
Editing an Existing Batch File . . . . . . . . . . . . . . . . . . 37
Starting Multiple Sessions without a Batch File . . . . . . . . . . . . 38

Automatically Starting Sessions . . . . . . . . . . . . . . . . . . 38
Stopping Sessions . . . . . . . . . . . . . . . . . . . . . . . 38

Chapter 5. Using Emulator Sessions . . . . . . . . . . . . . . . . 39
Printing . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Using the Windows Printer Driver. . . . . . . . . . . . . . . . . 39
Using Printer Definition Table (PDT) Files . . . . . . . . . . . . . . 39
Using Host Print Transform (5250 only) . . . . . . . . . . . . . . 40
Page Setup . . . . . . . . . . . . . . . . . . . . . . . . . 40
Scalable (Truetype) APL-Font Support on Printers . . . . . . . . . . 40

ZipPrint (3270 Only) . . . . . . . . . . . . . . . . . . . . . . 40
Preparing to Use ZipPrint. . . . . . . . . . . . . . . . . . . . 41
Starting ZipPrint . . . . . . . . . . . . . . . . . . . . . . . 41
Using ZipPrint . . . . . . . . . . . . . . . . . . . . . . . . 41
IBM 5586-H02 Printer (Japanese Only) . . . . . . . . . . . . . . 42

Editing . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Editing by Linking to Windows Application Programs. . . . . . . . . . 43
Copying Table Data to a Spreadsheet . . . . . . . . . . . . . . . 44
Input Method Editor (Japanese Only) . . . . . . . . . . . . . . . 46
DBCS IME Auto-Start Switch (DBCS only) . . . . . . . . . . . . . 46
DOS GAIJI Files (Japanese Only) . . . . . . . . . . . . . . . . 47
Using the User Font Defined on AS/400 (Japanese Only) . . . . . . . . 47
Example . . . . . . . . . . . . . . . . . . . . . . . . . . 47
What Is Different from Windows 3.1 . . . . . . . . . . . . . . . . 48

Transferring Files. . . . . . . . . . . . . . . . . . . . . . . . 48
ASCII Host Data Transfer . . . . . . . . . . . . . . . . . . . 49
Getting Help . . . . . . . . . . . . . . . . . . . . . . . . 50

Setting Up a Session Window’s Appearance. . . . . . . . . . . . . . 50
Tool Bar Setup . . . . . . . . . . . . . . . . . . . . . . . 51
Showing or Hiding the Menu Bar, Status Bar and Tool Bar . . . . . . . 51
Windows Setup . . . . . . . . . . . . . . . . . . . . . . . 52
Getting Help . . . . . . . . . . . . . . . . . . . . . . . . 52

Setting Up and Using the Assist Functions . . . . . . . . . . . . . . 52
Keyboard, Macro and Script Functions . . . . . . . . . . . . . . . 52
CM Mouse (Sample Application) . . . . . . . . . . . . . . . . . 53
Hotspots Setup . . . . . . . . . . . . . . . . . . . . . . . 53
Using Hotspots . . . . . . . . . . . . . . . . . . . . . . . 54
Keyboard Setup . . . . . . . . . . . . . . . . . . . . . . . 54
Pop-Up Keypad Setup . . . . . . . . . . . . . . . . . . . . . 56
Mouse Setup . . . . . . . . . . . . . . . . . . . . . . . . 57
Macro/Script Setup . . . . . . . . . . . . . . . . . . . . . . 57
Web Browser Setup. . . . . . . . . . . . . . . . . . . . . . 60
Tab Setup . . . . . . . . . . . . . . . . . . . . . . . . . 60

Managing Emulator Sessions . . . . . . . . . . . . . . . . . . . 60
Getting Help . . . . . . . . . . . . . . . . . . . . . . . . 60

Chapter 6. Utilities . . . . . . . . . . . . . . . . . . . . . . . 63
32-bit ODBC Administrator . . . . . . . . . . . . . . . . . . . . 63
Database Access. . . . . . . . . . . . . . . . . . . . . . . . 67
CM Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . 67

iv Personal Communications Quick Beginnings



Menu-Bar-Customization . . . . . . . . . . . . . . . . . . . . . 68
Multiple Sessions . . . . . . . . . . . . . . . . . . . . . . . 68
ZipPrint . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Convert Macro to a VBScript . . . . . . . . . . . . . . . . . . . 68
PC Organizer . . . . . . . . . . . . . . . . . . . . . . . . . 69

Starting the PC Organizer . . . . . . . . . . . . . . . . . . . 69
Getting Help . . . . . . . . . . . . . . . . . . . . . . . . 70

Data Transfer . . . . . . . . . . . . . . . . . . . . . . . . . 70
Text Assist (SBCS Only) . . . . . . . . . . . . . . . . . . . . . 71

Text Assist Key Functions . . . . . . . . . . . . . . . . . . . 72
AS/400 Network Drives (Shared Folders) . . . . . . . . . . . . . . . 73

Setting Up AS/400 Network Drives . . . . . . . . . . . . . . . . 73
Assigning (Mapping) Drives . . . . . . . . . . . . . . . . . . . 74

Chapter 7. Enabling Client/Server Applications . . . . . . . . . . . 75
Configuring a Node . . . . . . . . . . . . . . . . . . . . . . . 75
Starting the SNA Node. . . . . . . . . . . . . . . . . . . . . . 76
Stopping the SNA Node . . . . . . . . . . . . . . . . . . . . . 76
APING Requirements . . . . . . . . . . . . . . . . . . . . . . 77

Chapter 8. Where to Find More Information . . . . . . . . . . . . . 79
Online Help . . . . . . . . . . . . . . . . . . . . . . . . . . 79

How to Use Online Help . . . . . . . . . . . . . . . . . . . . 79
Messages . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Page Fault Messages . . . . . . . . . . . . . . . . . . . . . 79
OIA Messages. . . . . . . . . . . . . . . . . . . . . . . . 80

Personal Communications Library . . . . . . . . . . . . . . . . . 80
Related Publications . . . . . . . . . . . . . . . . . . . . . . 80
Contacting IBM . . . . . . . . . . . . . . . . . . . . . . . . 81

Support Options . . . . . . . . . . . . . . . . . . . . . . . 81

Part 4. Appendixes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 83

Appendix A. Directories and System File Modifications . . . . . . . . 85
Directories Created by the Installation Program . . . . . . . . . . . . 85

PRIVATE Subdirectory . . . . . . . . . . . . . . . . . . . . . 85
SAMPLES Subdirectory . . . . . . . . . . . . . . . . . . . . 85
PDFPDT Subdirectory . . . . . . . . . . . . . . . . . . . . . 86
ECL Subdirectory . . . . . . . . . . . . . . . . . . . . . . 86

Appendix B. Attachment Considerations . . . . . . . . . . . . . . 87
COAX Attachment . . . . . . . . . . . . . . . . . . . . . . . 87

Avoiding Machine Check 207 . . . . . . . . . . . . . . . . . . 87
Polling Feature . . . . . . . . . . . . . . . . . . . . . . . 87
Functions Not Available with DFT Attachment . . . . . . . . . . . . 88
PCMCIA and PCI Configuration for a DFT Attachment . . . . . . . . . 88

LAN via IEEE 802.2 Attachment . . . . . . . . . . . . . . . . . . 89
PIU Size . . . . . . . . . . . . . . . . . . . . . . . . . . 89
Receive Window Count . . . . . . . . . . . . . . . . . . . . 89
Using a PCMCIA Token-Ring or Ethernet Card . . . . . . . . . . . . 89

TCP/IP Connection . . . . . . . . . . . . . . . . . . . . . . . 89
TCP/IP Protocol Driver. . . . . . . . . . . . . . . . . . . . . 89
Screen Size . . . . . . . . . . . . . . . . . . . . . . . . 89
Terminal Type to Be Negotiated With TN3270 . . . . . . . . . . . . 90
Telnet3270, TN3287, and TN3270E Connection . . . . . . . . . . . 90
TCP/IP Function Enhancements . . . . . . . . . . . . . . . . . 90

Contents v



SDLC MPA Attachment . . . . . . . . . . . . . . . . . . . . . 91
Line Speed . . . . . . . . . . . . . . . . . . . . . . . . . 91
V.25bis Autodial . . . . . . . . . . . . . . . . . . . . . . . 91
Performance Considerations . . . . . . . . . . . . . . . . . . 91
Preventing Conflicts with Non-PCI MPA Adapters . . . . . . . . . . . 92

IBM Global Network - SNA over Async Attachment . . . . . . . . . . . 93
Line Speed . . . . . . . . . . . . . . . . . . . . . . . . . 93
Updating Phone List . . . . . . . . . . . . . . . . . . . . . 93

IBM Global Network Connection Attachment. . . . . . . . . . . . . . 94
Line Speed . . . . . . . . . . . . . . . . . . . . . . . . . 94
Updating Phone List . . . . . . . . . . . . . . . . . . . . . 94
Functions Not Available with the IBM Global Network Connection . . . . . 95

Home3270 Attachment . . . . . . . . . . . . . . . . . . . . . 95
Setting the Screen Colors in a Home3270 Session . . . . . . . . . . 95

3270 Attachment via the AS/400 System . . . . . . . . . . . . . . . 96
AS/400 System Setup . . . . . . . . . . . . . . . . . . . . . 96
Error Messages from the AS/400 System . . . . . . . . . . . . . . 97

IBM PC720 Modem Initialization (Japan Only) . . . . . . . . . . . . . 97
Practical Peripherals 14400MT Modem Considerations . . . . . . . . . . 97
Twinax Attachments. . . . . . . . . . . . . . . . . . . . . . . 97
IBM SDLC PCMCIA Adapter and Modem (Japan Only) . . . . . . . . . . 98

IBM SDLC PCMCIA Adapter . . . . . . . . . . . . . . . . . . 98
IBM SDLC PCMCIA Modem. . . . . . . . . . . . . . . . . . . 98
SDLC Attachment and IBM 7852 Modems . . . . . . . . . . . . . 99

IBM PCI Multiprotocol Adapter . . . . . . . . . . . . . . . . . . . 99
WAC Attachments . . . . . . . . . . . . . . . . . . . . . . . 100

EIB Support . . . . . . . . . . . . . . . . . . . . . . . . 100
Supported Adapters . . . . . . . . . . . . . . . . . . . . . . 100
Potential Configuration Issues . . . . . . . . . . . . . . . . . . 100
System Resources . . . . . . . . . . . . . . . . . . . . . . 100

3174 Peer Communications Support (Lan over Coax) . . . . . . . . . . 101
Installation . . . . . . . . . . . . . . . . . . . . . . . . . 101
Configuration . . . . . . . . . . . . . . . . . . . . . . . . 101
Multiple Adapter Coexistence . . . . . . . . . . . . . . . . . . 102

Twinaxial Console . . . . . . . . . . . . . . . . . . . . . . . 102
Asynchronous Console . . . . . . . . . . . . . . . . . . . . . 102

Restrictions for Asynchronous Console Sessions . . . . . . . . . . . 103
Adapter Setup Hints and Tips . . . . . . . . . . . . . . . . . . . 103

Using Coax (3270) Adapters . . . . . . . . . . . . . . . . . . 103
OEM Adapters. . . . . . . . . . . . . . . . . . . . . . . . 104
Using Twinax (5250) Adapters . . . . . . . . . . . . . . . . . . 104

Appendix C. AS/400 Configuration Examples . . . . . . . . . . . . 107
AS/400 Device Description . . . . . . . . . . . . . . . . . . . . 108

5250 Sessions through One Link . . . . . . . . . . . . . . . . . 108
AS/400 System Mode Description . . . . . . . . . . . . . . . . . 109
AS/400 Device Description for Twinaxial Attachments (APPC) Example . . . . 110
AS/400 Device Description for Asynchronous Attachment Example . . . . . 112
AS/400 VT Asynchronous Attachment Example . . . . . . . . . . . . 115
AS/400 Configuration for SDLC Example . . . . . . . . . . . . . . . 117

Network Attributes . . . . . . . . . . . . . . . . . . . . . . 117
SDLC Leased Configuration. . . . . . . . . . . . . . . . . . . . 118

Creating a SDLC Line Description . . . . . . . . . . . . . . . . 118
SDLC Controller Description . . . . . . . . . . . . . . . . . . 120

SDLC Switched Configuration . . . . . . . . . . . . . . . . . . . 121
SDLC Line Description. . . . . . . . . . . . . . . . . . . . . 121

vi Personal Communications Quick Beginnings



SDLC Controller Description . . . . . . . . . . . . . . . . . . 123
LAN Configuration Example . . . . . . . . . . . . . . . . . . . . 124

LAN Controller Description . . . . . . . . . . . . . . . . . . . 125

Appendix D. AnyNet Configuration Examples . . . . . . . . . . . . 127
Example 1. 5250 Emulation Over a TCP/IP Network . . . . . . . . . . . 127

Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 127
Example 2. Running APPC or CPI-C Applications over a TCP/IP Network . . . 128

Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Example 3. APPC3270 Emulation over a TCP/IP Network. . . . . . . . . 130

Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Example 4. 3270 Emulation via DLUR over a TCP/IP Network . . . . . . . 131

Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 131
Example 5. 3270 Emulation over a TCP/IP Network via an SNA Gateway to a

VTAM Host on an SNA Network . . . . . . . . . . . . . . . . . 132
Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 132

Example 6. 3270 Emulation via an SNA Gateway over a TCP/IP Network . . . 133
Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 133

Example 7. 3270 Emulation over a TCP/IP Network via an AnyNet SNA/IP
Gateway to a VTAM Host on an APPN Network . . . . . . . . . . . 134
Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 134

Example 8. 3270 Emulation from a Windows NT Workstation and a Windows
95 Workstation on Different IP Networks . . . . . . . . . . . . . . 135
Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 135

Appendix E. Configuring Multiple Links . . . . . . . . . . . . . . 139
Configuring a Second 3270 Emulation Link . . . . . . . . . . . . . . 139
Configuring a Second 5250 Emulation Link . . . . . . . . . . . . . . 139
Configuring a Second Link of a Different Kind . . . . . . . . . . . . . 140

Appendix F. Default Key Function Assignments . . . . . . . . . . . 141
Default Key Functions for a 3270 Layout . . . . . . . . . . . . . . . 141
Default Key Functions for a 5250 Layout . . . . . . . . . . . . . . . 143

Setting the 5250 Keyboard Layout Default . . . . . . . . . . . . . 146
Default Key Functions for the Combined Package. . . . . . . . . . . . 146
Default Key Functions for the VT Emulator Layout . . . . . . . . . . . 147

Appendix G. Configuring Your Workstation for Thai, Arabic, or Hebrew . . 149
Configuring for Thai . . . . . . . . . . . . . . . . . . . . . . . 149
Configuring for Arabic or Hebrew . . . . . . . . . . . . . . . . . . 149

File Transfer . . . . . . . . . . . . . . . . . . . . . . . . 150
Data Transfer for Arabic . . . . . . . . . . . . . . . . . . . . 150

Appendix H. Installation and Limitations of Personal Communications on
ChineseStar and RichWin . . . . . . . . . . . . . . . . . . . 151

Installing Personal Communications on ChineseStar and RichWin. . . . . . 151
Limitations of Personal Communications on ChineseStar and RichWin . . . . 151

Appendix I. API Client Attachments . . . . . . . . . . . . . . . . 153
Communications Server for Windows NT and NetWare for SAA . . . . . . 153

Support for Communications Server/NT . . . . . . . . . . . . . . 153
Support for NetWare for SAA . . . . . . . . . . . . . . . . . . 153
NetWare Coexisting with LAN . . . . . . . . . . . . . . . . . . 154

Appendix J. Trademarks . . . . . . . . . . . . . . . . . . . . 157

Contents vii



Appendix K. Notices . . . . . . . . . . . . . . . . . . . . . . 159

Glossary . . . . . . . . . . . . . . . . . . . . . . . . . . 161

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175

viii Personal Communications Quick Beginnings



About This Book

This book describes how to install, configure, and start Personal Communications.
After you get Personal Communications up and running and begin to perform
various tasks, use the online help whenever you need additional information. See
“Chapter 8. Where to Find More Information” on page 79 for information about
online help, the Personal Communications library, and related publications. See the
glossary on page 161 for definitions of technical terms used throughout this book.

This book is for users of:

v IBM eNetwork Personal Communications V4.3 for Windows 95, Windows 98, and
Windows NT

v IBM eNetwork Personal Communications AS/400 V4.3 for Windows 95, Windows
98, and Windows NT

See “What’s in the Packages” on page x for information regarding what is in each
package.

The screens in this book are representative of ones that you might see while
working with Personal Communications. Minor variations could occur between what
you see on your display and what is in the book.

In this book, Windows refers to Windows 95, Windows 98, or Windows NT 4.0.
When information is specific to only Windows 95, Windows 98, or Windows NT 4.0,
this will be indicated in the text.

Text Conventions Used in This Book

This book uses the following text conventions:

UPPERCASE
Uppercase indicates commands, program keywords, and default values.
You can enter these values in uppercase or lowercase.

Bold Bold type indicates the names of window controls, such as lists, check
boxes, entry fields, menu choices, and push buttons

Italics Italics indicate:

v Special emphasis in text or a reference citation

v Variables that you supply a value for

Example type
Example type indicates information that the user is instructed to type at a
command prompt or in a window.

This book also uses icons (pictures) in the text to help you find different types of
information.

This icon represents a note, important information that can affect the
operation of Personal Communications, or the completion of a task.

© Copyright IBM Corp. 1989, 1999 ix



This icon represents a tip or additional information that can help you
complete a task.

What’s in the Packages

Personal Communications V4.3 provides two different CD-ROM package options.
The packages are:

1. A CD-ROM (V4.3) containing IBM eNetwork Personal Communications for
Windows 95, Windows 98, and Windows NT which provides 5250, 3270, and
VT emulation and connections to AS/400, S390, ASCII, and S/3X host systems.

2. A CD-ROM (V4.3) containing IBM eNetwork Personal Communications AS/400
for Windows 95, Windows 98, and Windows NT which provides 5250 and VT
emulation and SNA connections to remote systems.

The information in this book applies to both packages.

In addition to the products previously mentioned, both CD-ROMs contain the
following:

v Other products to use in conjunction with the Personal Communications product

v Adobe Acrobat reader to enable you to read softcopy books (*.PDF) available on
the CD

v Book files in *.PDF format, which allow you to view the books shipped with the
products

v Personal Communication products for other platforms such as OS/2 and
Windows V3.1
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Chapter 1. Welcome to Personal Communications

Personal Communications brings the power of personal networking to your
workstation by exploiting the networking capabilities to provide a variety of
connectivity options supporting local area network (LAN) and wide area network
(WAN) environments. Whether it’s for host terminal emulation, client/server
applications, or connectivity, Personal Communications offers a robust set of
communications, networking, and administrative features.

Personal Communications is a full-function emulator. In addition to host terminal
emulation, it provides these useful features:

v File transfer

v Dynamic configuration

v An easy-to-use graphical interface

v APIs for SNA-based client applications

v An API allowing TCP/IP-based applications to communicate over an SNA-based
network

A variety of SNA-based client application programming interfaces (APIs) are
supported by Personal Communications. You can create applications that use the
peer-to-peer client APIs, which are based on LU 6.2 and provided by Personal
Communications. These APIs let you simultaneously access and process
information on peer workstations.

Personal Communications supports Advanced-Peer-to-Peer Networks (APPN) as an
end node, and uses the advanced network features: high performance routing
(HPR) and dependent LU requester (DLUR).

AnyNet SNA over TCP/IP is a feature of Personal Communications which allows
emulator and client/server SNA applications to communicate over a TCP/IP network.

The AnyNet Sockets over SNA access node function enables TCP/IP application
programs using the WinSock 1.1 or WinSock 2.0 socket interface to communicate
over an SNA network.

Personal Communications V4.3 provides many enhancements. See “What’s New in
Personal Communications 4.3 for Windows 95, Windows 98, and Windows NT” on
page 17 for a complete list of the new enhancements for Personal Communications
4.3.

Personal Communications Program Icons

When you have installed Personal Communications, the main functions that you
can use are displayed as icons. Icons are grouped in subfolders of the IBM
Personal Communications program folder.

A brief explanation of each function follows:
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Start or Configure Session
Use this icon to start or configure new emulator sessions. During
configuration, you can specify the session type, screen size, LU number,
graphics support, the type of communications link and its parameters, as
well as other information. You can save all this information in a workstation
profile. After saving, you can start the session by just clicking the session
icon.

SNA Node Configuration
Use this icon to configure an SNA node and associated resources or to
change advanced configuration parameters. Although most emulator
sessions can be configured without the use of this utility, you will need to
create an SNA node configuration to enable client/server and peer
communications.

IBM Software Registration
Use this icon if you want to be notified of any program updates provided by
IBM.

Administrative and Problem Determination (PD) Aids

Display SNA Sense Data
Use this icon to display SNA sense data and associated explanations.
Sense data is SNA error information located in internal SNA flows, error
logs, error messages, and traces. Some Personal Communications error
messages include sense data.

Information Bundler
Use this icon to gather system files and specific trace and log files, as well
as registry information such as the software installed or running on a
machine.

Internet Service
Use this icon to send system and diagnostic data collected by the
Information Bundler to an FTP server.

Introduction
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Log Viewer
Use this icon to view, merge, and sort the Personal Communications
message and trace logs. Personal Communications logs errors and
informational messages during initialization and operation.

Migration Utility
Use this icon to migrate your configuration files to Personal
Communications 4.3.

SNA Node Configuration Verification
Use this icon to verify that the ASCII editing changes that you have
manually made to the SNA node configuration data are valid.

SNA Node Operations
Use this icon to perform SNA node operations, such as starting or stopping
resources or displaying resource information.

Trace Facility
Use this icon to turn trace functions on and off and to capture
communication-protocol information that passes between your workstation
and other host systems. You can use traces to resolve communication
problems.

Product Information

Readme-Please!
The Readme file includes important information that became available too
late to be included in this book or that might be of special interest.

Manuals

You can install the following books so they can be available online to you
by choosing Custom Install . The books can be viewed from the CD-ROM,
or by installing Adobe Acrobat Reader.

Introduction
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Quick Beginnings
This book, which you are now reading, describes how to install, configure,
and start Personal Communications.

Reference
This set of books contains reference information that you might need when
installing or using Personal Communications.

Emulator Programming
This book provides necessary programming information for you to use the
IBM Personal Communications Emulator High-Level Language Application
Program Interface (EHLLAPI), Dynamic Data Exchange (DDE), Personal
Communications API (PCSAPI), and Server-Requester Programming
Interface (SRPI).

Client/Server Communications Programming
This book describes support for the APPC and LUA application
programming interfaces (APIs).

System Management Programming
This book describes how to use the Node Operations Facility (NOF)
application programming interface (API).

CM Mouse User’s Guide and Reference
This book describes how to use the CM Mouse interface.

Configuration File Reference
This book describes how to edit and verify configuration data using an
ASCII editor.

Host Access Class Library
This html document describes how to write an ActiveX/OLE 2.0 compliant
application to use Personal Communications as an embedded object.

Host Access Beans for Java
This html document describes Personal Communications emulator functions
delivered as a set of Java Beans.

Host Access Class Library for Java
This book provides a core set of classes that allow the development of
platform independent applications that can access host information at the
data stream level.
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6 Personal Communications Quick Beginnings



Utilities

Note

32-bit ODBC Administrator
Use this icon to open a window where you can add, delete, or
configure data sources, or install new open database connectivity
(ODBC) drivers. ODBC is an industry standard defined by the
Microsoft Corporation for database connectivity.

The APING and AFTP utilities are available in U.S. English only.

THESE PROGRAMS ARE PROVIDED ON AN AS-IS BASIS WITHOUT ANY
WARRANTY OF ANY KIND, INCLUDING THE WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
WHICH ARE EXPRESSLY DISCLAIMED.

Check Connection (APING)
Use this sample CPI-C program to verify network connections. You can use
APING to establish network connections, diagnose problems, and take
simple performance measurements. APING exchanges data packets with a
partner computer and measures how long the data transfer takes.

CM Mouse
Use this icon to define mouse buttons to perform any sequence of host
keystrokes, including PF keys and special emulator control keys. You can
also build pop-up menus to control host applications without making any
changes to those host programs.

Introduction
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Note

CM Mouse is a sample application that has been provided for
use as a utility. It is English only and only runs on SBCS
systems.

CM Mouse Configuration
Use this icon to configure the CM Mouse Scripting utility.

Data Transfer (AS/400 only)
Use this icon to transfer data between a workstation and an AS/400
database.

Database Access
Use this icon to start the Database Access utility that lets you retrieve data
from a database, such as an SQL server, Microsoft Excel, Lotus 1-2-3, or
dBASE database (that complies with Microsoft ODBC standards, Level 1).
You can then directly pass the retrieved data to Excel, Lotus 1-2-3, and
other applications.

DOS EHLLAPI
Use this icon to enable or disable DOS-Based EHLLAPI programs that
communicate with the 32-bit Personal Communications emulator.

Certificate Management
Use this icon to enable Secure Sockets Layer (SSL) communication
between your communications server and client.

Introduction
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Certificate Wizard
Use this icon to launch the Certificate Wizard which allows you to enable
Secure Sockets Layer (SSL) communication between your communications
server and client.

Menu-Bar Customization Utility
Use this icon to customize the menu bar in the session window.

Multiple Sessions
Use this icon to create batch files (*.BCH), which specify multiple emulator
sessions (workstation profiles) or other Windows 95, Windows 98 or
Windows NT programs that you want to start concurrently. You can create
an icon for each batch file and start the programs just by clicking the icon.

Transfer File (AFTP)
Use this program to provide a fast and efficient transfer of text and binary
files.

ZipPrint (3270 only)
Use this icon to start the ZipPrint program, which allows you to print host
system files or screens, PROFS or OfficeVision notes, calendars, and
documents, CMS files, and XEDIT workspaces. When started, ZipPrint adds
an item to the menu bar of the session window.

Convert Macro to VBScript
Use this icon to convert an existing Personal Communications Macro to a
VBScript file.

Personal Communications Sessions

The sessions that Personal Communications provides are logical connections
enabling communication between your workstation and a host system. The following
session types are available:

Display session
Use your workstation as a display terminal connected to the host system.

Introduction
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Printer session
Use your workstation printer as a host system printer.

Client/server session
Establish connections that allow peer communications using CPI-C and
APPC (LU 6.2).

Personal Communications Connections

Personal Communications supports a variety of connections to the following host
systems. Following are the icons and text you will encounter when you begin to
configure an emulator session:

S/390

AS/400

ASCII

S/3X

System/390 Emulator Connections

Interface Attachment

LAN

LAN via IEEE 802.2

3270 via NWSAA or Communications Server for Windows NT

Telnet3270

3270 via AS/400 (passthru)

APPC 3270 via LAN

Microsoft SNA client over FMI

Microsoft SNA client (using the LUA interface)

Microsoft SNA client (using the APPC interface)

Dependent LU Requester (DLUR)

3174 Peer Communications

VT-over-Telnet (TCP/IP)

COAX

SNA Distributed Function Terminal

Non-SNA Distributed Function Terminal
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Interface Attachment

COM
port

SNA-over-Async

IBM Global Network (not in Japan)

Home3270

IBM Global Network - SNA-over-Async

Dependent LU Requester (DLUR) via

SNA-over-Async

Hayes AutoSync

Hayes** AutoSync

APPC 3270 via:

SNA-over-Async

Hayes AutoSync

VT over Async

Telnet 3270

VT over Telnet (TCP/IP)

X.25 Hayes AutoSync

X.25 DLUR via Hayes AutoSync

X.25 APPC 3270 via Hayes AutoSync

5250

3270 via AS/400

Dependent LU Requester (DLUR)

SDLC

Synchronous Data Link Control

3270 via AS/400 (passthru)

APPC 3270 via SDLC

Dependent LU Requester (DLUR)

SNA/IP

LU 0, 1, 2, 3

APPC 3270

LU 0,1,2,3 via DLUR

IBM ISA/
MCA WAC

Synchronous Data Link Control

3270 via AS/400 (passthru)

APPC 3270 via SDLC

Dependent LU Requester (DLUR)

X.25 Qualified Logical Link Control

X.25 3270 via AS/400

APPC 3270 via X.25

X.25 DLUR

API
Client

NetWare for SAA client

Communications Server client

Communications Server

EE-
IBMDLC

LU (0, 1, 2, 3) via DLUR

APPC 3270

Introduction

Chapter 1. Welcome to Personal Communications 11



Interface Attachment

OEM

LU (0, 1, 2, 3)

3270 via AS/400 (passthru)

APPC 3270

Dependent LU Requester (DLUR)

AS/400 Emulator Connections

Interface Attachment

LAN

LAN via IEEE 802.2

Telnet5250 over TCP/IP

Telnet5250 over IPX/SPX

VT over Telnet

5250

Twinaxial Data Link Control (APPC)

Twinaxial Data Link Control (Console)

COM
port

SNA-over-Async

Hayes AutoSync

SNA-over-Async (Console)

VT over Async

VT over Telnet

Telnet 5250

X.25 Hayes AutoSync

SDLC

Synchronous Data Link Control

SNA/IP

5250

IBM ISA/
MCA WAC

Synchronous Data Link Control (WAC)

X.25 Qualified Logical Link Control

EE-
IBMDLC

5250

OEM

APPC 5250
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ASCII Emulator Connections (SBCS only)

Interface Attachment

LAN

VT over Telnet (TCP/IP)

COM
port

VT over Async

VT over Telnet (TCP/IP)

S/3X Emulator Connections

Interface Attachment

5250

Twinaxial Data Link Control (Console)

Client/Server (Peer) Connections

Personal Communications provides APPN end node support for workstations,
allowing them to communicate more flexibly with other systems in the network.

When your workstation is defined as an APPN end node, an APPN network node
server provides the following directory and routing services for your workstation:

v Intermediate session routing

v Directory services

v Topology and route selection services

Using Personal Communications, you can establish client/server connections to a
variety of computers and to workstations running OS/2, Windows 3.x, Windows 95,
Windows 98, or Windows NT. Another option is to connect the computers to a
workstation running Communications Server. Available SNA client/server connection
types are:

v LAN via IEEE 802.2

v Synchronous Data Link Control

v SNA-over-Async

v AnyNet SNA over TCP/IP

v Hayes AutoSync

v IBM Global Network – SNA over Async

v Twinaxial Data Link Control (APPC)

v X.25

v OEM Deep adapter

v WAC

v Enterprise Extender
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APPN Networking

Advanced Peer-to-Peer Networking (APPN) is the underlying networking protocol
that routes APPC traffic through intermediate nodes in the network. For instance,
when Program A uses APPC to talk to Program B, APPN finds the node where
Program B is located and directs the APPC traffic through the network.

APPN includes several features that help reduce the amount of configuration
required to set up and maintain a network. These features automate many tasks
that are time consuming, complicated, and error prone. For example, if you’re
installing a new workstation that uses APPN, you don’t have to set up configuration
information for every workstation you want to communicate with. You simply provide
the name of the computer and the address of the intermediate node that handles
your traffic. APPN takes care of the rest of the information needed to route APPC
traffic to and from your workstation.

If you connect to an APPN network, you simplify your own configuration and make it
easier for other computers in the network to find you.

Refer to “SNA Client/Server Concepts” in the Personal Communications Reference
Volume II for more information.

APPC

Advanced program-to-program communication (APPC), also known as LU 6.2, is
software that enables high-speed communications between programs on different
computers, from portables and workstations to midrange and host computers. APPC
software is available for many different operating systems, either as part of the
operating system or as a separate software package.

APPC is a communications protocol that enables programs on different computers
to “talk to” each other. APPC provides the interface between the programs and the
networking hardware and software and defines the rules that programs use to
exchange information.

APPC serves as an interface between application programs and the network. When
the communications application on your workstation passes information to the
APPC software, APPC takes the information and sends it on to a network interface,
such as a Token-Ring adapter card. The information travels across the network to
another computer, where the APPC software receives the information from the
network interface. APPC puts the information back into its original format and
passes it to the corresponding communications application.

Refer to “SNA Client/Server Concepts” in the Personal Communications V4.3
Reference Volume II for more information.

APPN Network

By participating in an APPN network, Personal Communications workstations can
also take advantage of two additional functions:

v High-performance routing

v Dependent LU requester

High-Performance Routing (HPR): Personal Communications supports
high-performance routing (HPR) over token-ring and Ethernet connections, which
increases data routing performance and reliability. HPR supports the rapid transport
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protocol to provide nondisruptive rerouting around network outages, efficient
selective retransmission, and end-to-end data integrity and congestion control.

Dependent LU Requester (DLUR): DLUR allows dependent LUs (LU 0, 1, 2, 3,
and dependent LU 6.2) to benefit from an APPN network. It supports dynamic and
multiple paths through the network and eliminates the need for dependent LUs (or
their gateway) to be adjacent to the VTAM host.

A DLUR is an APPN end node or network node that owns dependent LUs, but
requests that a dependent LU server (DLUS) provide the system services control
point (SSCP) for those dependent LUs. A DLUS controls conversion from a subarea
environment to an APPN environment, allowing you to maintain central
management of remote dependent LUs while benefiting from an APPN network.

Personal Communications uses the support in VTAM V4R2 for dependent LUs
through APPN networks and combined subarea and APPN networks. The
dependent LU server function (in VTAM) provides dependent secondary logical unit
(SLU) support by establishing an LU 6.2 session between a dependent LU
requester node (DLUR), and a dependent LU server node (DLUS).

See “SNA Client/Server Concepts” in the Personal Communications Reference
Volume II for more information.

AnyNet

AnyNet allows any application to communicate over any networking protocol and to
extend the reach of applications over multiple networks. Using AnyNet function, you
can reduce the number of installed network protocols and reduce operational
complexity without modifying your existing applications or hardware. Personal
Communications includes AnyNet SNA over TCP/IP support, which allows SNA
emulator and client/server applications to communicate over a TCP/IP network.

Refer to “Introducing AnyNet SNA Over TCP/IP” in the Personal Communications
Reference Volume II for more basic information about AnyNet.

Personal Communications also includes AnyNet Sockets over SNA support, which
enables TCP/IP application programs using the WinSock 1.1 or WinSock 2.0 socket
interface to communicate over an SNA network. For more information, refer to
“AnyNet Sockets over SNA” in the Personal Communications Reference.

Refer to “Appendix D. AnyNet Configuration Examples” on page 127 for examples of
how to set up AnyNet connections.

Enterprise Extender (HPR over IP)

Enterprise Extender allows you to extend the reach of SNA applications and data to
include IP networks and IP-attached clients with similar levels of reliability,
scalability, and control as SNA users. Enterprise Extender integration uses standard
IP technology and does not require new hardware or software in the IP backbone.

Enterprise Extender is a simple set of extensions to the existing HPR technology,
and provides the following:

v Non-disruptive backup from desktop to host

v SNA transport over native IP network
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v End-to-end failure protection

v End-to-end data prioritization

v Scalable and cost-effective connectivity

ActiveX/OLE 2.0 Support

Personal Communications V4.3 sessions can now be included as part of a
compound document. A compound document is a document that appears to be a
single unit, but which is in fact made up of information from more than one
program. For example, a compound document could include data that allows
Personal Communications to execute within the context of the spreadsheet
program.

When included as part of another program, Personal Communications is known as
an embedded or linked object and the program is known as a container. Personal
Communications supports ActiveX/OLE 2.0 compliant containers such as Lotus
Notes, Lotus Word Pro, and Microsoft Word. For most containers you can embed
an object by using a menu sequence (for example, in MS Word, use Insert , then
Object ), or by dragging and dropping a workstation profile into the document.

As an embedded object, Personal Communications can change its appearance to
be part of the container program, providing the container program allows this
change to occur. Or, Personal Communications can be started so that it runs in its
own separate window utilizing its own profile and screen displays.

There is a variety of ways that Personal Communications can be activated as an
embedded object. For example, Personal Communications can be shown as an
icon within another program, and be activated by double-clicking. Another way
Personal Communications can be activated is through a script; Visual Basic or
Lotus Script are examples of scripting languages supported by Personal
Communications, but any ActiveX/OLE automation scripting language can be used.

The use of scripts allows Personal Communications to be activated as a part of an
automation request. For example, a script can be written to automatically start
Personal Communications every time the container object is started, or a script can
be used to automatically put data on host entry screens.

The Personal Communications session ends when the container is closed or when
you close the Personal Communications window. If Personal Communications was
actuated as a linked object, it must be closed separately.

Object-Oriented API

Personal Communications provides a new language-independent object-oriented
API. There are seven objects that can be used in conjunction with Visual Basic,
Lotus Script, or any ActiveX/OLE automation scripting language to produce
compound documents where Personal Communications is an embedded object
within another program.

If you are interested in writing an application that includes Personal
Communications as an object within your ActiveX/OLE 2.0 compliant program, refer
to the IBM eNetwork Personal Communications Host Access Class Library (HACL)
programming manual. This manual describes the objects that Personal
Communications provides and describes what you need to do to access the
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Personal Communications data. Information is provided for programmers using
Visual Basic scripts, Lotus scripts, and the C++ programming language. Samples of
Visual Basic and Lotus scripts are provided on the Personal Communications CD.

What’s New in Personal Communications 4.3 for Windows 95,
Windows 98, and Windows NT

Personal Communications Version 4.3 is based on the popular Personal
Communications Version 4.2. If you are familiar with Personal Communications
Version 4.2, you might want to review some of the new functions and
enhancements.

The following sections briefly describe each new Personal Communications function
listed in the table above.

Programming Enhancements
Session Level Interface (SLI) Support

Allows the migration of various banking applications from OS/2 to Windows
NT using SLI.

WinHLLAPI Support
Encompasses all of the functions included in EHLLAPI, and adds extended
functions that take advantage of the Windows message driven environment.

Industry Standard 32-bit HLLAPI
Includes all of the existing functionality of the EHLLAPI and takes
advantage of the 32-bit environment.

Java Interface for HACL
Provides a Java Interface to the eNetwork Personal Communications Host
Access Class Library (HACL).

Convert Macro to VBScript Utility
Allows an existing Personal Communications Macro file to be converted to
a VBScript file.

JavaBeans
Personal Communications provides a set of JavaBeans for component
based application development.

ActiveX Controls
Personal Communications provides ActiveX Controls for component based
application development.

Database Enhancements
ODBC Version 3.0 Support

Provides ODBC 3.0 level capability that allows applications to access data
for DB2 AS/400 and DB2 MVS databases via APPC.

Connectivity Enhancements
IWSAA and CS/NT Support

Personal Communications Version 4.3 provides Load Balancing,
HotStandby, and Service Location Protocol (SLP) support for LU2 Queue
Element/Message Unit (QEL/MU) connectivity. This function adds support
for SLP, IP, Load Balancing, and HotStandby for the IPX protocol.
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Personal Communications also provides Load Balancing Support for
TN3270 and TN5250 connectivity using the SLP interface.

PCI MPA Adapter Support
This release of Personal Communications supports the IBM PCI MPA
adapter.

Secure Sockets Layer
Allows security to be set for a connection to a TN3270, TN5250, or
TNASCII server. This security uses SSL to provide data encryption and
server authentication using signed certificates.

Enterprise Extender
Personal Communications supports HPR routing over IP to provide
non-disruptive backup from the desktop to the host.

Link Reactivation
Personal Communications enables automatic link reactivation.

Installation/Configuration Enhancements
Configuration Update File Support

This command line only function allows you to create a file containing only
changes to the Personal Communications SNA configuration and use that
file to update an *.ACG configuration file. For more information about this
feature, refer to Personal Communications Version 4.3 Reference Volume I.

Initial Configuration Definitions
Personal Communications Version 4.3 allows you to pre-load a set of
parameter definitions that can be customized and distributed to your users.
This is done by creating an initial configuration definitions file containing
complete definitions for new configurations. For detailed information about
creating this file, refer to Personal Communications Version 4.3 Reference
Volume I.

Migrating from CM/2 to Personal Communications

Enables users to migrate Communications Manager/2 response files
(*.RSP) to Personal Communications configuration files (*.ACG and *.WS).

Tivoli Support
Personal Communications Version 4.3 provides support for Tivoli remote
management functions, which include the following:

v Distribution

v Installation

v SNA Node Administration

Install Improvements
Personal Communications Version 4.3 provides improvements to make
installation easier.

Other Enhancements
Status Bar

Personal Communications provides the following status bar support:

Connection Messages
Connection messages can be displayed in a status bar.

Status Bar History
Allows you to view status bar messages from oldest to most recent.

What’s New
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Enhanced Log Viewer
Personal Communications Version 4.3 provides several enhancements to
the Log Viewer. With these new enhancements, Log Viewer allows you to:

v view trace logs as well as message logs

v merge message and trace log entries

v sort log entries in ascending and descending order

v filter log entries to display only those entries you want to view

VT Enhancements
Personal Communications Version 4.3 provides the following VT
Enhancements:

v VT340 Text Mode Enhancements

v VT340 ReGIS and Sixel Graphics

Euro Sign
Code page tables, fonts, and keyboard layouts have been changed to
support the new euro sign.

Printer support for this currency sign depends on the printer and printer
driver supporting it.

Internet Service
This facility allows data gathered by the Information Bundler to be
transferred from a PC to Personal Communications service through the
Internet.

Extended Katakana Support
Support for Japanese Extended Katakana has been added for this release.

IBM Global Network Support
Advantis (IIN) has been replaced with IBM Global Network.

Copy/Cut Enhancements
A new parameter, “Only if a trim-rectangle is marked”, has been added to
the Edit, Options panel. When this parameter is selected copy/cut
operations are ignored when no screen area is marked.

PCSMincho Font
Provides support for the PCSMincho font.

New code pages
Provides support for code pages for three languages:

v 1252 (Latin 1)

v 1254 (Turkish)

v 943 (Japanese)

v Personal Communications is now using the IBM CDRA Tables (for SBCS
versions only).

Polish Keyboard 457 Support
Provides support for the Polish Keyboard 457.

Japan Postal Barcode Support
Provides printing support for the new postal bar code implemented in
Japan.

ChineseStar and RichWin Support
Allows the Personal Communications program to support Chinese
characters on the English version of Windows using these two Chinese
Shell products.

What’s New
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Page Setup
Personal Communications has improved the way in which printers are set
up.

Record Scripts
Personal Communications Version 4.3 allows you to record VBScripts.

What’s New
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Part 2. Planning for and Installing Personal Communications
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Chapter 2. Planning to Install Personal Communications

Personal Communications supports a wide range of workstations that use different
bus architectures and peripheral components. There are hardware and software
requirements, as well as memory and storage requirements, to consider when
planning the installation of Personal Communications.

The following sections describe and list support for monitors, adapters, and
keyboards.

For detailed instructions on installing Personal Communications, refer to the
Personal Communications Version 4.3 CD-ROM Guide to Installation.

Workstation Hardware

Table 1 shows the workstation hardware support for Personal Communications.
Personal Communications supports workstations with the following hardware:

Table 1. Workstation Hardware Support

System units The recommended system unit has an Intel** 80486** or faster
microprocessor and access to a CD-ROM drive.

Display monitors All display monitors supported by Windows 95, Windows 98, or
Windows NT.

Video adapters All video adapters supported by Windows 95, Windows 98, or
Windows NT.

Keyboards
v Enhanced keyboard (101-key, 102-key, 104-key) (Only the

101-key for Japanese)

v Space-saving keyboard

v Microsoft Natural Keyboard

v 5576-001/002/003/A01/B01/B05 (Japanese)

Printers All printers supported by Windows 95, Windows 98, and Windows
NT when a PDT file is not used. For more details about printers
supported in PDT mode, refer to the Personal Communications
Reference manual.

Communication
adapters

LAN, SDLC, coaxial, twinaxial, WAC, COM Port, OEM, and
Multiprotocol communication adapters.

Modems All asynchronous modems that use the Hayes AT command set and
are supported by Windows 95, Windows 98, or Windows NT.

Synchronous (SDLC) modems attached to a Multiprotocol adapter
(MPA), SDLC or WAC adapter.

Workstation Hard Disk Requirements

This section tells the amount of disk space you will need to install the full IBM
eNetwork Personal Communications for Windows 95, Windows 98 and Windows NT
on your workstation.

If you are running Windows 95 or Windows 98, Personal Communications files will
need 700 KB of disk space on the disk drive where Windows 95 or Windows 98 is
installed.
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If you are running Windows NT, Personal Communications files will need 9 MB of
disk space on the disk drive where Windows NT is installed.

In addition, for each item in the following table that is not already installed, you will
need the amount of space shown. The space must be on the same disk drive
where Windows is installed:

Software Package Space Required

VBScript Runtime Libraries 1.8 MB

Microsoft Shared Libraries 2.4 MB

Refer to the Personal Communications Readme for the most current information on
space requirements.

If you use the Install on a workstation to from a server installation option,
Personal Communications requires less than 12 MB of disk space on your
workstation.

In addition to the amount of space Personal Communications takes, you need 3 MB
of disk space for temporary files or work space during installation.

Workstation Memory Requirements

For Personal Communications the amount of memory you need depends on several
factors, including the operating system you are running on, the attachment type,
number of sessions, and the use of programming interfaces such as Emulator
High-Level Language Application Programming Interface (EHLLAPI) and Dynamic
Data Exchange (DDE). Personal Communications for Windows 95 and Windows 98
will run on 16-MB workstations; a minimum of 32 MB of memory is recommended
for Windows NT.

If you want to run Personal Communications and other applications simultaneously,
you might need to add more memory to your workstation.

Workstation Software

For SNA client attachment to a NetWare for SAA 2.0 (or later) gateway, or to a
Communications Server for NT gateway, you need the API Client for NetWare for
SAA and IBM Communications Server for Windows NT (provided with Personal
Communications).

For attachment to the Microsoft SNA Server for Windows NT, you need the
Microsoft SNA Server Windows NT Client; for attachment to the Microsoft SNA
Server for Windows 95 and Windows 98, you need the Microsoft SNA Server
Windows 95 or Windows 98 Client.

Host Requirements

Refer to the Personal Communications V4.3 Reference Volume I for
information about software and hardware requirements for host systems.

Getting Ready
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Chapter 3. Configuring Sessions

Personal Communications saves emulator configuration information to a workstation
profile (*.WS) and SNA information to a configuration file (*.ACG). Depending on
your Personal Communications configuration, you might have a workstation profile
only or both a workstation profile and a configuration file. The workstation profile
can be used later by other Personal Communications sessions, or to restart this
session. The SNA configuration file (*.ACG) is used to initialize the SNA node of
Personal Communications.

You can have an icon created for each workstation profile. Then you can select the
session icon to establish communication with the host system using the saved
workstation profile.

Note

If you configure more than one workstation profile, we strongly
recommend that you use the same SNA configuration file for all of
them. If you do not use a common SNA configuration file, make sure
that there are no conflicts of link names or PU names (for 3270
sessions) between the two configuration files. In addition, the local
system information should be the same on the Configure Local
System windows. Failure to do this might result in unpredictable or
inconsistent behavior.

Configuring for AS/400

To connect to an AS/400 system, specific configuration information in
the workstation profile must correspond to the information specified at
the AS/400 system. See “Appendix C. AS/400 Configuration
Examples” on page 107 for more information about creating display,
line, and controller descriptions on the AS/400 system.

If you want to configure multiple links, see “Appendix E. Configuring Multiple Links”
on page 139.

Creating a Configuration

To configure a session:
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1. From the Start menu, select:

Programs
IBM Personal Communications

Start or Configure Session

The logo panel appears. A message tells you that you must configure a
connection.

2. Click OK to continue. The Customize Communication window appears.

3. Select the type of host from the Type of Host drop-down listbox. The choices
are:

v S/390 for connections to an S/390 system

v AS/400 for connections to an AS/400 system

v ASCII for connections to an ASCII system

v S/3x for connection to System 36 and System 38 computers

4. Select the Interface you will use from the Interface drop-down listbox.

5. Select the attachment type you want to use from the Attachment drop-down
listbox.

6. Click Session Parameters .

The Customize Communication – 3270, 5250, ASCII, or S/3x– Host window
appears (depending on the host you selected in step 3). Click OK.

7. Click Link Parameters .

Depending on the attachment type selected, a wizard or a window will be
displayed.

If you selected an SNA attachment a wizard will provide prompts for configuring
an SNA attachment. Enter the appropriate information for each page and click
Next to continue. Click Finish when you are done.

Save the SNA configuration, as described on page 27.
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If you selected an attachment type other than SNA, make your selections for the
parameters in the window displayed. Click Help or press F1 to display
parameter details. Click OK when you are done. You will not need to save an
SNA configuration.

8. Click OK on the Customize Communication window. The session is displayed
automatically.

Save the workstation profile as described on page 27.

Note

If you have a user profile that was created by a previous version of
Personal Communications, Auto-Logon (when connecting to an
AS/400 host) may not work. In this case, you must recreate. Select
Configure User Profile in the Customize Communication – 5250
Host window.

Saving Configuration Information

This section describes how to save configuration information. SNA configuration
information is stored in an *.ACG file, and emulator configuration information is
stored in a workstation profile (*.WS).

Saving an SNA Configuration

The Save As window appears automatically after you create or change a
configuration with an SNA attachment. To save this information in a configuration
file:

1. Type the file name and then click Save. The default file type is *.ACG and the
default directory is the PRIVATE subdirectory in your Personal Communications
directory.

When you save an SNA configuration file, you are also making it the default
configuration for the SNA node.

You are returned to the Customize Communication window.

2. Click OK until you return to the session window, and then save your workstation
profile, as described in the next section, Saving a Workstation Profile.

Saving a Workstation Profile

If you save your emulator configuration information, the session will have the same
characteristics the next time you start it. If you have an icon added to the Personal
Communications folder, you can restart the session with the saved configuration
information by clicking on this icon from the Start menu. You are automatically given
the opportunity to save your session information when you close a session.
However, if you want to save the information at any time, do as follows:

1. Click Save from the File menu in the session window.

The Save WorkStation Profile as window appears.

Configuring Sessions
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2. Type a file name (*.WS) and then click OK. The name you enter will become
the icon’s title unless you enter a description.

Tip

If you want a longer or more descriptive title, enter the text you
want in the Description field.

Note that you can choose the directory where this file is saved, but the default
location is the PRIVATE subdirectory.

3. A message appears that lets you choose to have an icon created.

4. If you select Yes, an icon is created in the folder or program group you specify.
You can start the workstation profile by selecting this icon.

If you select No, you can start the session by clicking Run from the Start menu,
and entering:
C:\PROGRAM FILES\PERSON˜1\PCSWS.EXE C:\PERSON˜1\PRIVATE\xxx.WS

where xxx.WS is the workstation profile name.

Note that you must specify all paths and directories. You can type the name of
the directory as either PERSON˜1 or PERSONAL COMMUNICATIONS.

Changing Configuration Information

You can change all of the configuration parameters in the workstation profile and
the SNA configuration .

Changing an SNA Configuration

You can change the basic configuration parameters of an SNA configuration for
your session in the following three ways:

v Using the Emulator Configuration

v Using the SNA Node Configuration

v Editing the configuration file with an ASCII editor

Configuring Sessions
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Note

To change advanced configuration options or to specify a different
default configuration, you need to use the SNA Node Configuration
program. In fact, we recommend that you use the SNA Node
Configuration program whenever possible. If you manually edit the
configuration files, we strongly suggest that you use the SNA Node
Configuration Verification utility prior to making use of the file for the
first time.

Using the Emulator Configuration

To change an SNA configuration:

1. Click Configure from the Communication menu, then click Session
Parameters .

2. Change the parameters on this window, as necessary and click OK.

3. Click Link Parameters .

Your default configuration file should be opened automatically. If you want to
change a different configuration, click Existing and choose the configuration file
you want to change.

A wizard is displayed to prompt you through the configuration.

4. Make your changes and then click Next .

Now you can proceed through the Wizard and make additional changes, if
necessary.

5. Click Finish when you are done.

6. If you want to replace the existing configuration, click Yes to overwrite it. If you
want to create a new configuration that is based on the existing one, type a new
file name; however, you must use SNA Node Configuration to make a new
configuration the default configuration.

7. Click OK until you return to the session window.

Using the SNA Node Configuration Program

For Personal Communications 4.3, all SNA data is stored in the SNA node
configuration files (extension .ACG). The SNA Node Configuration program is a
Graphical User Interface (GUI) for managing the content of these .ACG files. This
program allows you to define individual SNA resources or change the definition of
these resources.

Using an ASCII Editor to Change Your Configuration Files

You can create and modify a configuration file without going through the SNA Node
configuration interface. You can use the ASCII editor of your choice. A verification
tool is available to ensure that you have not made errors when editing your file.
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Refer to the Personal Communications Configuration File Reference manual for
information on how to edit your configuration data using an ASCII editor and how to
verify your editing changes.

Changing a Workstation Profile

To change a workstation profile:

1. If your session window is not active, select the icon corresponding to the
workstation profile to be changed.

The session window appears.

2. Click Configure from the Communication menu.

The subsequent steps are the same as for creating a new configuration,
beginning with step 3 on page 26.

3. After you have made your changes, the following message appears:
Because you have changed the configuration,
communication will be terminated if you
proceed. Are you sure?

If you click OK, communication ends, but then you are reconnected using the
new configuration information.

To save the changes in your workstation profile, click Save from the File menu
in the session window and then click Yes to replace the existing file. Otherwise,
click No to save this information in a new configuration file.

Tip

Unless you have unchecked Save on Exit from the File menu,
changes are saved in the workstation profile automatically whenever
you exit a session.

Configuring Sessions
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Chapter 4. Starting and Stopping Emulator Sessions

This chapter describes how to start and stop single and multiple emulator sessions.

If your emulator configuration information was saved, as described in “Saving
Configuration Information” on page 27, it is stored in a workstation profile (*.WS). If
you have a session icon, you can select it to start a session, using the saved
configuration information.

Note

If you are a first-time user of Personal Communications, or there are
no session icons in your Personal Communications folder or program
group, refer to Chapter 3. to create a configuration.

Starting Sessions

You can use the methods described below to start sessions:

v Select an already-configured session icon from the Explorer or from the Start
menu.

v Start from an existing session window.

v Specify a workstation profile name in the Run window. For example:
C:\PROGRAM FILES\PERSON˜1\PCSWS.EXE C:\PROGRAM FILES\PERSON˜1\PRIVATE\MY.WS

v Start multiple sessions with a batch file.

When you start multiple sessions, the titles of session windows are Session A,
Session B, and so on, unless you have customized them using a batch file.

Note: Connection status messages will be displayed on a status bar at the bottom
of your session window during connection to the host.

Starting by Selecting the Session Icon

To start a session, click the relevant Session icon from the Personal
Communications folder on the Start menu.

Starting from a Session Window

Use the following methods to start from an existing session window:

Starting Another Session Using the Same Profile

Select Run the Same from the File menu. Another session starts, using the same
profile.
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Starting Another Session Using a Different Profile
1. Select Run Other from the File menu.

The Open Other Workstation Profile window appears.

2. Double-click the desired workstation profile in the File Name list.

3. Select OK.

Another session starts, using the profile specified in step 2.

Starting a Different Type of Session from a Session Window
1. Select Open from the File menu.

2. Specify the desired workstation profile and then select OK.

The current session ends and then another session starts, using the selected
profile.

Starting a Workstation Profile from the Run Command Line

To start the session:

1. Select Start and then Run .

2. Type the following command in the Command Line field and then select OK.
C:\PROGRAM FILES\PERSON˜1\PCSWS.EXE C:\PROGRAM FILES\PERSON˜1\PRIVATE\MY.WS

where MY.WS is the workstation profile stored in the

C:\PROGRAM FILES\PERSON˜1\PRIVATE

directory.

Starting Multiple Sessions

If you installed the Multiple Sessions utility, you can use the batch program, which
runs batch files (*.BCH), to start two or more workstation profiles at the same time.
Personal Communications batch files can also start other programs when you
include their startup commands. This is especially useful if you always want to start
an application when you start a session. For example, you might want to start an
application, such as ZipPrint, that uses a Personal Communications API.

If you created an icon for your batch file, you can start workstation profiles and
other programs in the batch file just by selecting the icon.

Creating a Batch File

To configure a session:

1. From the Start menu, select the Multiple Sessions icon in the Personal
Communications folder.

Starting Emulator Sessions
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The Create/Modify Batch File window appears.

2. There are four methods for including profiles or programs in a batch file. Use
the method you prefer:

v Double-click the file names in the File Name list box.

v Drag and drop the file names (using the right mouse button) from the File
Name box to Batch-File Entries .

v Select a file name from the File Name list box and then select Add .

v Type the complete path and command file name in the batch files entries
area.

Personal Communications places the full path and command that is needed to
run the workstation profile or other program above the cursor line in the edit
area. If there is no cursor, the command will be added to the last line.

To see the contents of the profile you added to the batch file, click it in the File
Name list box and then click View File or the magnifying glass.
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Note

Some brief instructions appear at the top of Batch-File Entries ;
you need not remove them, because they do not affect the running
of the batch file.

There is one exception—if you are using the Japanese version of
Windows NT, you must delete these instructions. One way to do
this is to select New from the File menu of the Create/Modify
Batch File dialog before adding any files.

3. Repeat step 2 for each subsequent file to be added.

PCSWS.EXE Options

v To suppress the IBM logo when you start one or more sessions, add the
parameter /Q to the first command in the batch file:

C:\dir\PCSWS.EXE C:\dir\PRIVATE\TCPIP1.WS /Q

where dir is the directory where you have Personal Communications
installed.

v To start a session as an icon, not as a window, add the parameter /I to
the command in the batch file:

C:\dir\PCSWS.EXE C:\dir\PRIVATE\TWINAX.WS /I

where dir is the directory where you have Personal Communications
installed.

v To start a session with a specific short session ID, insert the parameter
/S=m after PCSWS.EXE in the batch file:

C:\dir\PCSWS.EXE /S=m C:\dir\PRIVATE\LAN1.WS

where m is the short session ID and dir is the directory where you have
Personal Communications installed.

Note: If you use the /S option to assign A as the short session ID, you
should use this option for all of the sessions in the batch file.
Otherwise, if another session starts first, it becomes the A
Session and the session with the /S=a option will not start
because of the conflicting short session IDs. Another way to
prevent conflicts is to assign a character later in the alphabet for
the short session ID.

4. When you complete the edit, save the created batch file by selecting Save from
the File menu.

The Save Batch File As window appears.

5. Enter a name for the batch file (*.BCH).
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The name you enter is used as the icon title, unless you enter a description as
well.

6. Select OK to continue.

7. Select Yes if you want to create an icon for the batch file.

The Personal Communications window appears.

8. Specify the program folder to which the batch file icon is to be added and then
select OK.

A message appears, asking you to save the batch file.

9. Select OK.

The batch file icon appears in the specified program group.

The following example is a batch file that runs six workstation profiles, saved in the
C:\PROGRAM FILES\PERSON˜1\PRIVATE directory, and then runs MYAPP.EXE.

Sample Batch File
C:\dir\PCSWS.EXE C:\dir\PRIVATE\COAX1.WS /Q
C:\dir\PCSWS.EXE C:\dir\PRIVATE\COAX2.WS /I
C:\dir\PCSWS.EXE C:\dir\PRIVATE\SLAN1.WS
C:\dir\PCSWS.EXE C:\dir\PRIVATE\SLAN2.WS
C:\dir\PCSWS.EXE C:\dir\PRIVATE\AS4Y1.WS
C:\dir\PCSWS.EXE C:\dir\PRIVATE\VT220.WS
C:\APPL\MYAPP.EXE

where dir is the directory where you have Personal Communications installed.

Using a Batch File

You can use one of the following methods to run a batch file:

v Select the batch file icon from the Explorer or from the Start menu.

v Run the batch file from the Run command line:
[drive]:\[path]\PCSBAT.EXE [drive]:\[path]\xxxx.BCH /R

Note: To run a batch file, specify the /R option.

v Start the Multiple Sessions icon.

1. Select Open from the File menu in the Create/Modify Batch File window.

2. Select the desired batch file and then select OK.

The contents of the batch file appears in the edit area.

3. Select Run from the Run menu.

Editing an Existing Batch File

To edit an existing batch file:

1. Select the Multiple Sessions icon from the Start menu.

The Create/Modify Batch File window appears.

2. Select Open from the File menu.

The Open Batch File window appears.

3. Select the batch file you want to edit and then select OK.

The contents of the batch file you selected appear in the edit area of the
Create/Modify Batch File window.

Starting Emulator Sessions

Chapter 4. Starting and Stopping Emulator Sessions 37



4. Edit the batch file. Refer to step 2 on page 35 for more details.

Refer to the online help for details about the menu bar Edit functions. Select
Index from the Help menu and then click Menu-Bar Commands on the
Batch-Program Window.

5. When you complete the edit, save your changes by selecting Save or Save As
from the File menu.

v Select Save to save your changes in the existing file.

v Select Save As to save your changes in a new file and then continue with
step 5 on page 36.

6. Exit the Create/Modify window.

Starting Multiple Sessions without a Batch File

To start multiple sessions without a batch file:

1. Select the icon for the session you want to start first from the Start menu.

2. After it connects to the host, select one of the following choices from the File
menu:

v Run the Same... to start another session with the same configuration.

v Run Other... to start a session with a different configuration.

When the Open Other Workstation window appears, select the profile you
want to start and then click OK.

Automatically Starting Sessions

To start one or more sessions automatically, do as follows:

1. From the Start menu, select:

Settings
Taskbar

2. Click the Start Menu Programs tab and then click Add .

3. Click Browse and then open the PRIVATE subdirectory in the Personal
Communications directory.

4. Change the file type to All Files.

5. Double-click the session icon or the batch icon.

6. Click Next and then double-click the Startup folder.

7. Accept the icon name or type a new one.

8. Click Finish and then OK when you are done.

Stopping Sessions

To stop a session, click the X in the upper-right corner or double-click the upper-left
corner of the session window, or select Exit from the File menu.

To stop multiple sessions at the same time, select Exit All from the File menu. All
emulator sessions end, and the associated session windows are closed.
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Chapter 5. Using Emulator Sessions

This chapter describes how to use the printing, editing, and data-transfer functions
in an emulator session. It also describes the choices on the Appearance, Assist,
and Window menus in the emulator session windows.

Printing

You can use Personal Communications to print from display or printer sessions:

v From display sessions, you can print all (Print Screen ) or part (Trim Print ) of the
screen of your session window on a workstation printer.

To print only part of the session window, drag the mouse to create a trimming
rectangle around the part of the window you want to print and then select Print
Screen from the File menu.

v With printer sessions, you can print files directly from a host system to a
workstation printer. Refer to the online help for more information.

Configure a printer session to designate a workstation printer as a system printer
that will use either the printer definition tables (PDTs) provided with Personal
Communications or the Windows printer drivers. Refer to the online help for more
information.

To print, the following methods apply:

v You can use Windows printer drivers that you configure through printer setup in
the file menu of the session window.

v You can use printer definition tables (PDTs), which give greater control over the
print data stream.

v For 5250 only: You can use Host Print Transform, where the host formats and
builds the printer commands.

For more information about printing, refer to the Personal Communications V4.3
Reference Volume I.

Using the Windows Printer Driver

To set up your printer to use a Windows printer driver:

1. Select Printer Setup from the File menu of the session window.

The Printer Setup window lists the supported printers.

2. Select the printer driver to be used from the Printer list box.

3. Confirm that the Use PDT file check box is not selected and then select OK.

Personal Communications will now use the printer driver you selected, and the
Printer Setup window is closed.

Using Printer Definition Table (PDT) Files

Printer Definition Table files define the transfer of characters and control codes to a
printer, and the printer output format. If a PDT file is used, the Windows printer
driver is not used, and Personal Communications generates print output based on
printer control information defined in the PDT file.

Refer to the Personal Communications V4.3 Reference Volume I for more
information about PDT files.
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To use PDT files:

1. Select Printer Setup from the File menu of the session window.

The Printer Setup window appears.

2. Select the port to be used from the Printer list box.

Selected PDT files are available for the port selected here.

3. Select Setup and then specify the paper size of the selected printer driver.

4. Select the Use PDT file check box and then select Select PDT .

The Select PDT file window appears.

5. To use an existing PDT file, select a PDT file to be used and then select OK.

Using Host Print Transform (5250 only)

To use Host Print Transform (HPT):

1. When configuring a 5250 session, the HPT mode may be selected.

2. From the Configure panel, click Advanced .

3. Select HPT Yes.

The following window items become available.

4. Enter the Printer Module.

5. Enter Drawer 1, Drawer 2, and Envelope form names.

6. Enter Code Page 899, Y or N.

7. Select Customizing Object and Library (optional)

Page Setup

Personal Communications allows you to set Page Setup parameters, such as the
maximum number of lines per page, the maximum number of columns, and fonts.
For detailed information and instructions on Page Setup, refer to the Personal
Communications V4.3 Reference Volume I

Scalable (Truetype) APL-Font Support on Printers

Because special APL characters are not provided for printers, when APL characters
are printed, the APL fonts provided for displays are used. In some cases, APL
characters are printed rather small. To print larger APL characters, you should install
a scalable (Truetype) APL font as follows.

1. Open the Control Panel Folder.

v Click Start on the task bar.

v Move the pointer to Settings and click Control Panel .

2. Open the Fonts folder. (Double-click the Fonts icon.)

3. On the File menu, click Install New Font .

4. Click the drive and folder where Personal Communications is installed.

5. Double-click on AICAPL .

ZipPrint (3270 Only)

Use ZipPrint to print PROFS or OfficeVision notes, calendars, OV documents, CMS
files, XEDIT workspaces, and 3270 session screens.

Printing
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Preparing to Use ZipPrint

Before you can use ZipPrint, DDE/EHLLAPI must be enabled for the sessions. To
do this, select API Settings from the File menu and refer to the online help for
detailed instructions. DDE/EHLLAPI is enabled by default.

Note

By default, PROFS-oriented functions of ZipPrint are U.S. English
PROFS. You can customize ZipPrint for other languages. Start
ZipPrint before you start any display sessions.

Starting ZipPrint

Start ZipPrint before you start any display sessions. The ZipPrint menu is added to
the menu bar of the specified session window; then you can use it from the menu
bar the same as with the other functions.

Start ZipPrint by selecting the ZipPrint icon in the Personal Communications
program folder. This starts ZipPrint for Session A only.

You can also start ZipPrint by placing it as the first command in a Personal
Communications batch file.

For more information about ZipPrint, including information about using ZipPrint for
additional emulator sessions, search for ZipPrint in Help.

Using ZipPrint

Keep the following consideration in mind when using ZipPrint:

ZipPrint uses the Personal Communications File-Transfer function to print VM/CMS
notes and files. On slower communication lines such as SDLC, Async (IIN), or
Home3270 attachment, or when using a large packet or block size, you might
experience a file-transfer timeout. If this happens, you should increase the timeout
delay as follows:

1. Select Transfer from the menu barof the session window.

2. Select Setup - Miscellaneous Setting .

3. Increase the timeout value to 150 seconds or longer.

When using ODPS (Japanese PROFS or other DBCS PROFS), ZipPrint uses the
Hankaku (SBCS) font. So when using a ZENKAKU font, such as KANJI or
HIRAGANA, the font setting should be changed as follows:

1. Click Configure ZipPrint from the ZipPrint menuin your session window.

2. Click Setup font .

3. Select a ZENKAKU font such as MINCHO and GOTHIC and then click OK.
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IBM 5586-H02 Printer (Japanese Only)

Use IBM5585.PDT for PDT mode printing with the IBM 5586-H02 printer.

Editing

You can edit the contents of your session window using the Windows clipboard and
the Edit menu.

Note: When using copy/cut functions, Personal Communications takes the entire
contents from the session window and places it on the clipboard. To copy or
cut only marked sections from the session window, you need to update the
Cut/Copy options. To update the Cut/Copy options, do the following:

1. From the Edit menu, select Options... .

2. From the Edit Options window, select the Cut/Copy tab.

3. From the Cut/Copy page, select the Only if a trim-rectangle is marked
checkbox.

4. Close the Edit Options window.

Undo Cancels the most recent Edit operation, except for Copy Link, and restores
the contents of the session window and the clipboard accordingly.

Cut Copies the marked area into the clipboard and removes it from the display
session window.

Copy Copies (or duplicates) the marked area into the clipboard without removing
it from the display session window.

Copy Append
Copies the marked area into the clipboard without removing it from the
display session window. If there is already data in the clipboard, Copy
Append adds the new data to it.

Paste Overlays the current contents of the clipboard into the session window,
starting at the current cursor position.

Clear Removes the marked area of the session window. The clipboard contents
are not altered.

Copy Link
Supports the DDE Copy Link function. To start a link between Personal
Communications and another application program, mark an area of the
session window, select Copy Link , and then select Paste Link in the other
application program.
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Note

The command you should use for PasteLink or PasteSpecial
depends on the application program you are using.

Unmark
Removes the clipping (or marking) rectangle. The session window and the
clipboard contents are not altered.

Select All
Marks the entire session window.

Options
Allows you to control the behavior of pasting to a VM screen

Editing by Linking to Windows Application Programs

Linking to Windows application programs supporting PasteLink lets you paste
session-window data to the windows of those application programs. You can run
CopyLink when DDE/EHLLAPI is usable.

Confirming the DDE/EHLLAPI Settings

To check whether DDE/EHLLAPI is currently set to usable status:

1. Select API Settings from the File menu.

2. Make sure the DDE/EHLLAPI check box is selected.

If the box is checked, DDE/EHLLAPI is set to usable status. Continue to step 4.

3. If the box is not checked:

a. Click the DDE/EHLLAPI check box and then click OK.

b. Stop and then start your session to enable the new settings.

4. If DDE/EHLLAPI was already set to usable status, select OK.

Using CopyLink and PasteLink
1. Mark the session window area for which CopyLink should be issued.

2. Select CopyLink from the Edit menu.

If the session window is already linked with an application program, CopyLink
appears in gray and cannot be selected. In this case, force the application
program to end the linkage, or stop the application program. Then you can
select CopyLink .

3. Start the Windows application program for the window to which an area should
be copied.

4. Specify the location for which PasteLink should be run.

5. Issue PasteLink or PasteSpecial by using the menu for the application
program.

The contents of the marked area are pasted into the specified location in the
window of the application program.
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CopyLink is now completed.

When the contents of the marked area in the session window are updated during
linking, the contents of the area pasted to the window of the linked application
program are also updated.

See the online help for more information about the CopyLink and PasteLink
functions.

Copying Table Data to a Spreadsheet

You can use the Cut , Copy , CopyLink , or CopyAppend choices in the Edit menu
to copy data in the session window to the window of a Windows spreadsheet
application program.

To use Copy , select the Paste or PasteLink choice in the application program
window into which data is to be copied.

Data in the marked area can be copied in the following three data formats,
depending on the format supported by the spreadsheet for the window to which
data is to be copied:

Sylk format
Data format for general-purpose spreadsheets, such as Multiplan**

Biff3 format
Data format for Microsoft Excel**

Wk3 format
Data format for Lotus** 1-2-3**

Note

Whether application programs, such as Excel or Lotus 1-2-3, also
support these data formats in subsequent versions depends on
individual application program specifications.

Individual items of data in tables of the session window are divided automatically
such that they are suitable for spreadsheets, and they are copied into individual
cells of tables in the application program.

Copying Marked Data without Dividing It into Cells

To paste data in the marked area per line, without dividing it into individual cells,
add the following lines to the workstation profile:
[Edit]
Sylk=N (If Sylk format data is not divided into cells)
Biff3=N (If Biff3 format data is not divided into cells)
Wk3=N (If Wk3 format data is not divided into cells)
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Copying Lines Containing Only Operational Signs

If data in the marked area contains signs, such as +, −, =, or |, the signs are
regarded as being ruled lines of the table. Once they are removed, only numeric
data is copied.

+------+----+----+----+----+ ┌──────┬────┬────┬────┬────┐
| | 1 | 2 | 3 | 4 | │ │ 1 │ 2 │ 3 │ 4 │
+======+====+====+====+====+ ├──────┼────┼────┼────┼────┤
| 1990 | 60 |-63 | 71 | 58 | ──────Ê │ 1990 │ 60 │-63 │ 71 │ 58 │
+------+----+----+----+----+ Copy ├──────┼────┼────┼────┼────┤
| 1991 |+69 | 69 | 90 | 80 | │ 1991 │ 69 │ 69 │ 90 │ 80 │
+------+----+----+----+----+ ├──────┼────┼────┼────┼────┤
| 1992 | 71 | 80 | 80 |-30 | │ 1992 │ 71 │ 80 │ 80 │-30 │
+------+----+----+----+----+ └──────┴────┴────┴────┴────┘
Table Data in the Marked Area Spreadsheet

To copy these signs without replacing them with null characters, add the following
lines to the workstation profile:
[Edit]
MaskGridCharacter=N

Copying Data in Cells As Text Data

Data in the marked area is treated as numeric data by default. Therefore, currency
signs, such as $, and punctuation marks, such as commas, are removed before
copying. To copy data containing such signs and marks as text data rather than
numeric data, add the following lines to the workstation profile:
[Edit]
ConvertToNumeric=N

Data in the marked area containing signs and marks is then copied as text data. In
addition, all numeric data that does not contain signs and marks is also copied as
text data.

Getting Help

For information about all the tasks you can perform with the Edit menu choices, as
well as how to mark and then edit an area within the window, refer to the online
help:

1. Select Index from the Help menu.

2. When the help window displays, select Menu Bar Commands of the
Workstation Window .

3. Select Edit from the list of Menu Bar Commands.

Restrictions with Home3270 Attachment

When you use the Home3270 attachment, the following edit functions are restricted:

Undo function
You cannot perform the Undo function after using the Cut, Paste,
PasteNext, or Clear functions because these functions modify display areas
in the protocol converter.
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Cut and Clear functions
When an area to be cut or cleared contains a field attribute character or
protected field, or each line in that area ends at the end of an unprotected
field, the following things might occur:

v Characters in an unprotected field outside the area to be cut or cleared
might also be cleared.

v An alarm might sound.

v The cursor might not appear at the initial position.

When you perform the Cut or Clear function, specify only the minimum area
required (for example, some words or one field in one line), and then
confirm that the frame exists in an unprotected field.

Paste and PasteNext functions
When the area to be pasted contains a field attribute character or protected
field, or the end of the paste area on each line is at the end of an
unprotected field, the following things might occur:

v The character to be pasted might not be written to the expected position.

v An alarm might sound.

v The cursor might not appear at the initial position.

When you use the paste function, paste the shortest character string
possible (for example, a character string, but excluding CR/LF). Confirm
that the area to be pasted is in an unprotected field.

Input Method Editor (Japanese Only)

If you are using the Input Method Editor (IME, an editor for double-byte character
sets) on the Japanese version of Personal Communications and you encounter
problems, install a patch file as follows:

1. Copy PCSWLIB.DLL to PCSWLIB.SAV.

2. Copy PCSWLIB.NT to PCSWLIB.DLL.

This file is provided on an “as-is” basis without service. If you wish to restore the
original PCSWLIB.DLL file, copy PCSWLIB.SAV to PCSWLIB.DLL.

To create files with the Multiple Sessions utility on the Japanese version of Personal
Communications, please delete the comments from the .bch file by selecting New
from the File menu of the ″Create/Modify Batch File″ dialog before adding any files.

DBCS IME Auto-Start Switch (DBCS only)

The session default is IME auto-start, which means when the cursor moves to
DBCS field, the system selected IME is invoked automatically. In PCSWIN.INI, one
switch flag is added into [DBCS] section to disable this function.
[DBCS] IME_AUTO_START=N

The default is Yes. When ″N″ is specified in INI file, the IME would not be invoked
automatically. User needs to invoke IME by pressing system keys.
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DOS GAIJI Files (Japanese Only)

The GAIJI-editor J can only process GAIJI files that were created with the Windows
3.1 GAIJI editor. It cannot process DOS GAIJI files. The GAIJI-HENKAN-HOJO tool
(GAIJICNV.EXE) can be used to convert DOS GAIJI files as follows:

1. C:\PROGRAM FILES\PERSONAL COMMUNICATIONS\GAIJICNV.EXE

A dialog box to specify source file and target file appears.

2. Specify the source path/file C:\$SYS1Z24.FNT and the target path/file
C:\USERFONT.FON.

3. Start a conversion by clicking the Conversion button.

4. Run the Windows NT, Windows 95, or Windows 98 Gaiji-editor and capture the
file that is created by step 3, which is C:\USERFONT.FON.

For each file, you only need to convert either the 24x24 font or the 16x16 font with
GAIJICNV.EXE, not both.

Using the User Font Defined on AS/400 (Japanese Only)

You can capture the user-defined font (GAIJI) defined on AS/400 into Windows NT,
Windows 95, or Windows 98 by using IBM Personal Communications Tools/400
(PCT/400), IBM Personal Communications, and the Gaiji editor of Windows 95,
Windows 98 or Windows NT.

The capturing is done as follows:

1. PCT/400

v Copying user font (CPYUSRFNT) command

This command is executed on AS/400. It copies the user-defined font image
from DBCS font table to a file. Please refer to the PCT/400 documentation for
details of the command.

2. Personal Communications

v File transfer facility

This facility transfers the file member that is copied by the copying user font
(CPYUSRFNT) command.

– GAIJI-HENKAN-HOJO tool (GAIJICNV.EXE)

This program is executed on Windows 95, Windows 98 or Windows NT. It
converts the file copied by the copying user font (CPYUSRFNT) command
to a Windows 3.1 format GAIJI file so that it can be captured by the Gaiji
editor of Windows 95, Windows 98, or Windows NT.

3. Windows NT, Windows 95, and Windows 98

v GAIJI editor

By using the facility to capture the Windows 3.1 format GAIJI file, the file
converted by the GAIJI-HENKAN-HOJO tool (GAIJICNV.EXE) program is
captured.

Example
1. Copy the user-defined font images from the DBCS font table to a file by using

the copying user font (CPYUSRFNT) command.
a. ADDLIBLE QPCT (Add QPCT library to the library list)
b. CPYUSRFNT (Copying fonts, using default parameter)
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The physical file USRFNT is created in library QTEMP and user-defined fonts
are copied to member USRFNT from the DBCS font table.

2. Download QTEMP/USRFNT(USRFNT) to the PC as file USRFNT.FNT by using
the file transfer facility of Personal Communications.

3. Convert USRFNT.FNT by using the GAIJI-HENKAN-HOJO tool
(GAIJICNV.EXE).

v C:\PROGRAM FILES\PERSONAL COMMUNICATIONS\GAIJICNV.EXE

(This command runs GAIJICNV.EXE.):

v As the source file, specify the USRFNT.FNT file that you downloaded in step
2. Enter it as c:\usrfnt.fnt

v As the target path/file, specify c:\userfont.fon)

v Start the conversion by clicking the Conversion button.

4. Run the Windows 95, Windows 98, or Windows NT GAIJI editor to capture the
file that is created.

What Is Different from Windows 3.1
1. The GAIJI-HENKAN-HOJO tool (GAIJICNV.EXE) program is used to convert the

USRFNT.FNT. Font Setup Utility (SETUFNTV.EXE), which is provided by
PCT/400, is not used. Therefore, Font Setup Utility (SETFNTV.EXE) does not
need to be downloaded from AS/400.

2. To capture the font into Windows 95, Windows 98, or Windows NT, the GAIJI
editor of Windows 95, Windows 98, or Windows NT is used.

Transferring Files

Personal Communications enables the transfer of one or more files between a host
system and workstation. You can define file transfer options in advance to help you
transfer a variety of files quickly and easily.

With Personal Communications, you can perform the following file transfer
functions:

Send files to the host system
Send files using the Transfer menu or, from 3270 sessions, the SEND
command from the DOS prompt.

You can also send files by using an EHLLAPI or DDE application or a
macro that invokes file transfer.

Receive files from the host system
Receive files using the Transfer menu or, from 3270 sessions, the
RECEIVE command from the DOS prompt.

You can also receive files by using an EHLLAPI or DDE application or a
macro that invokes file transfer.

Data Transfer
For 5250 sessions, selecting Data Transfer from the Transfer menu
invokes data transfer. If Data Transfer is not selected, then file transfer is
invoked.

Create, test, replace, and delete templates
Create a template to have Personal Communications automatically
generate a workstation or host file name and transfer type when you select
a file to be sent or received.
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It is not possible to define a file transfer template with the long file name
naming convention.

Define transfer types
Define up to 16 transfer types for each host system. Text, binary, and
append (except for CICS) are initially set as transfer types.

Select, create, and customize translation tables
Select translation tables to define which translation table is used during file
transfer.

Select, create, and customize DBCS translation tables
Select DBCS translation tables to define which DBCS translation table is
used during file transfer. (Japanese and Korean only.)

Import or export files (PC/3270 only)
Import/Export is an office system communication program and an
application program run on the IBM Customer Information Control System
(CICS). The import/export function makes it possible to import or export
Final Form Text (FFT), Revisable Form Text (RFT), and PC documents.

When you export a file from the host, your workstation receives the file you
exported and an interchange document profile (IDP) file. Before you can
import a file to your workstation, you need to create an IDP file with
transmission information.

Create interactive document profile (IDP) files (PC/3270 only)
An IDP file contains document header information, has the same name as
the file to be transferred, and has the extension .IDP.

To create an IDP file, select Setup from the Transfer menu.

Note

When you transfer a file on a Telnet5250 session, you cannot transfer
a file that includes FFEF. The current version of the AS/400 Telnet
program misinterprets FFEF in the file as an end-of-record marker.

ASCII Host Data Transfer

When you are transferring files between two computers, specific protocols must be
followed. Files can be transferred only when your PC uses the same protocol as the
host. Personal Communications supports the XMODEM and YMODEM public
domain protocols.

For XMODEM, Personal Communications uses the XMODEM and XMODEM1K
protocols. XMODEM is a block-oriented, error checking protocol that is a single file,
half duplex protocol. XMODEM1K is the same as XMODEM, except that it uses
larger 1024 byte (1K) packets.

The YMODEM protocol is similar to the XMODEM1K protocol in that it transfers
data in 1K packets, but it also allows multiple files to be sent in one transfer.

Transferring Files

Chapter 5. Using Emulator Sessions 49



The YMODEMG protocol transfers multiple files like YMODEM, but performs no
error detection or error correction. It can be much faster than YMODEM, but
requires an error-free data connection.

With Personal Communications, you can perform the following data transfer
functions to or from ASCII hosts:

Send any type of files to the host system
Send files using the Transfer menu using XMODEM, YMODEM,
XMODEM1K, or YMODEMG.

Receive files from the host system
Receive files using the Transfer menu and XMODEM, YMODEM,
XMODEM1K, or YMODEMG.

Create, test, replace, and delete templates
Create a template to have Personal Communications automatically
generate a workstation or host file name and transfer type when you select
a file to be sent or received.

Getting Help

For more information about transferring files, refer to the online help:

1. Select Procedures from the Help menu.

2. When the help window displays, scroll down to Transferring Data .

3. Select choices from that list for detailed information.

Setting Up a Session Window’s Appearance

You can use the following functions from the Appearance menu to define the
appearance of your session window:

Display Setup
Customize a variety of characteristics, such as the cursor, pointer, rule line,
and trimming styles, graphics, sound, DBCS, and color palette, in the
display session.

Color Mapping
Set the colors used in session windows.

Font Choose the font to use for display session windows, the style, and whether
it will be an automatic sizing font or a fixed size font. If you use a fixed size
font, you can also choose its size. The set of fonts from which you can
choose depends on the type of display you are using.

Note: You cannot change the font size when the session window is
maximized.

Window Setup
Change the appearance and title of the session window and change the
session icon.

Show Show the Menu, Tool Bar and Status Bar.

Tool Bar
Add, edit, delete, move, copy, and rearrange buttons on the tool bar. for
each tool bar item. The settings are stored in a *.BAR file.

Transferring Files

50 Personal Communications Quick Beginnings



Tool Bar Setup

The tool bar displays under the menu bar in your session window to allow quick
access to the Personal Communications functions, commands, and defined macros.

Use the tool bar pop-up menu to quickly and easily create, edit, and delete tool bar
items, as well as to save and load customized tool bars. When you customize the
tool bar, you can change the order of items, add and delete items, change the
function, title, or graphic associated with any item, change the fonts, colors, and
other tool bar visual style elements.

To customize your tool bar, select Tool Bar from the Appearance menu, or display
the Tool Bar pop-up menu by clicking on the right mouse button while pointing at
any part of the tool bar.

For information about customizing the tool bar, refer to the online help from the Tool
Bar Setup window.

If you want to hide the tool bar, refer to “Showing or Hiding the Menu Bar, Status
Bar and Tool Bar”.

Showing or Hiding the Menu Bar, Status Bar and Tool Bar

You can show or hide the menu bar, status bar or tool bar. To do this:

1. Click the upper left corner of the session window to display the system menu.

v Hide Menu Bar appears when the menu bar is shown.

v Show Menu Bar appears when the menu bar is not shown.

v Hide Status Bar appears when the status bar is shown.

v Show Status Bar appears when the status bar is not shown.

v Hide Tool Bar appears when the tool bar is shown.

v Show Tool Bar appears when the tool bar is not shown.

2. To hide either the menu bar, status bar or tool bar, select Hide Menu Bar , Hide
Status Bar , or Hide Tool Bar .

3. To show either the menu bar, status bar or tool bar, select Show Menu Bar ,
Show Status Bar , or Show Tool Bar .

If you hide the menu bar, the Popup Menu Bar choice is added to the system
menu. The Popup Menu Bar shows a cascading menu that contains all
commands in the hidden menu bar.
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Windows Setup

Note

If you set the Maximized Style (in the Windows Setup dialog) to
Without Title Bar , then the Minimize All Windows option on the
Windows taskbar will not have any effect. To minimize the window,
press Alt-Space and select Minimize .

Getting Help

If you’re not sure how to set the session window’s appearance options, view the
detailed instructions in the help.

1. Select Procedures from the Help menu.

2. When the help window appears, search for appearance or scroll down to
Changing the Screen Appearance .

Select choices from that list for detailed information.

Setting Up and Using the Assist Functions

Personal Communications provides auxiliary functions that let you operate the
system more efficiently. You can use the following functions from the Assist menu of
the session window:

v Keyboard and macro functions

v Hotspots setup

v Keyboard setup

v Popup keypad setup

v Mouse setup

v Macro setup

v Scripting functions

v Web browser setup

v Tab setup

This section describes these auxiliary functions, and explains how to set up and use
them.

Keyboard, Macro and Script Functions

A Keyboard/Macro/Script Function command lets you run scripts, macros or
Personal Communications-supplied key functions without using the keyboard. Run
the scripts, macros or key functions from the current cursor position in the session
window.
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Scripting Functions

You can write, execute, record and terminate VBScripts in the emulator
environment. These scripts have access to the HACL automation API. The
programming environment includes methods, class descriptions and properties.
VBScript is a subset of the Visual Basic programming language.

Macro Functions

A macro is a sequence of key or mouse actions and host commands that you can
perform with a single action, such as a keystroke. Before you can use a macro
function, you need to define it. For more information, see “Macro/Script Setup” on
page 57.

Key Functions

Personal Communications provides many key functions that can be assigned to the
keys on the keyboard, the mouse buttons, or the buttons of the pop-up keypad. You
can also use them to generate macros.

CM Mouse (Sample Application)

CM Mouse is a sample application included with Personal Communications that
provides intelligent and programmable mouse support for 3270 and 5250 emulation
sessions. It allows users of host applications to point-and-click to perform host
functions. With its unique screen-recognition technology, CM Mouse “hotspots”
change instantly to give context-sensitive functions to each host application window.

CM Mouse pop-up menus give you instant access to lists of options and functions
simply by pointing and clicking. Pop-up menus can simplify the selection of
commands and options, and can automate repetitive tasks.

For more information about CM Mouse, see CM Mouse Support User’s Guide and
Reference.

Hotspots Setup

A hotspot is an area of the session window on which you can double-click the left
mouse button to perform a command or function. You do not need to use the
keyboard. For example, you can double-click a function key number to perform the
function.

3D Hotspots

Select Show hotspots to get three dimensional (3D) hotspots; these
only require a single click, and they stand out on your screen.

You can define the following actions for a hotspot:

v Click on a URL to connect to a World Wide Web site.

Assist Functions

Chapter 5. Using Emulator Sessions 53



v Simulate function keys.

v Play a macro that has the same name as the character string you select on the
session window.

v Enter the selected string at the cursor position.

v Simulate the Enter key at the cursor position.

v For VT, simulate two sets of function keys, PF1 through PF4 and F6 through
F20.

Using Hotspots

Note

You must have a mouse to use hotspots.

To use a hotspot:

1. Move the mouse pointer to the hotspot displayed in the session window.

2. Double-click the left button of the mouse, except for 3D hotspots, which only
require a single click.

Personal Communications determines whether you have specified a hotspot
function that matches what appears at the position of the mouse pointer. If so, it
processes the hotspot. When two or more hotspots are specified for a single
character string, the first retrieved hotspot is processed.

Hotspots are retrieved in the following order:

(1) Point-and-select (connect to Web site using URL)

(2) PFnn, FPnn, Fnn, nn

(3) Point-and-select (run the macro)

(4) Point-and-select (enter the selected string)

(5) Point-and-select (enter at the cursor position)

Keyboard Setup

You can use Keyboard Setup to modify the function defined for each key on the
keyboard, except some reserved keys.

You can define the following functions for the keys.

v Performing a key function

v Playing a macro

v Entering characters
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Note

By default, the Enter function is assigned to the Ctrl key. To change
this assignment or, if you are using a non-IBM compatible keyboard
and the Enter key does not work properly, you need to customize your
keyboard.

Keyboard File

When you specify a key, you can save the new keyboard layout in a file (.KMP). If
you create two or more keyboard files, you can alternate between them as required.

To assign a function to a key on the keyboard:

1. Select Keyboard Setup from the Assist menu or click the map icon on the tool
bar.

2. When the Keyboard Setup window appears, select Customize .

3. Assign the key functions, referring to the online help for detailed instructions.

4. Save your changes and exit the Customize Keyboard window.

5. Select OK after completing the setup.

You can reset either the entire keyboard or specific keys to defaults:

v To reset the entire keyboard, set the current keyboard to IBM Default in the
Keyboard Setup window.

v To reset specific keys, select a key in the Customize Keyboard window and then
select Default from the Current Actions for Selected Key box.

Note

There are seven keys that you cannot redefine and they are gray or
dimmed in Keyboard Setup; these keys are: Alt, AltGr, Print Screen,
Scroll Lock, CapsLock, NumLock, and Shift.

Customizing the VT Emulator Keyboard

If you are using a VT emulator session, you can represent ASCII control characters
in the character strings that you define for your customized keyboard.

Use the # character to represent the CTRL key, following it by any character from
the following list (only upper-case alphabetics are allowed):
@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]|_
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Use ## to represent an actual #. For example, 123##45 represents 123#45.

If you follow # with any other character than those shown, you will get an error
message:
PCSKBD160 - Unrecognized key-action: "character string

For example, the error for the string "#a is
PCSKBD160 - Unrecognized key-action: "#a

Here is the set of control characters:

Character pair Control Notes
#@ Control-@ NULL
#A Control-A

through
#Z Control-Z
#[ Control-[ ESC
#\ Control-\
#] Control-]
#| Control-|
#_ Control-_

Because the *.KMP file can be edited, there is a run time check to ensure that the
character string is correct. If "### is processed, then # will be displayed, followed by
a beep to signify that the entire character string was not played. If "123#a456 is
processed, then 123 will be displayed, followed by a beep.

Pop-Up Keypad Setup

The pop-up keypad is a small window in which some buttons are arranged. To
display the pop-up keypad, put the pointer anywhere in the session window and
press the right mouse button.

You can allocate the following functions to these buttons:

v A standard key function provided by Personal Communications

v A user-specified macro

v A character entry

To perform these functions, you only need to click a button on the pop-up keypad
with the left mouse button.

To view the description of a short-name key function or macro, click the right mouse
button while pointing at one of the function or macro names.

Pop-Up Keypad File

You can specify the number of buttons displayed in the pop-up keypad, the
functions allocated to those buttons, and colors of the buttons. You can save the
specified pop-up keypad contents in a pop-up keypad file (also referred to as a
poppad file).

A pop-up keypad file (*.PMP) contains the information for the number of buttons
displayed in the pop-up keypad, the functions allocated to those buttons, and color
information. You can define which pop-up keypad file is allocated to the pop-up
keypad.
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Using the Pop-Up Keypad

To use a pop-up keypad:

1. With the mouse pointer anywhere in the session window, click the right mouse
button.

2. Select Pad 1, Pad 2, Pad 3 , or Pad 4.

3. Click the required button in the pop-up keypad.

To set up the pop-up keypad:

1. Select Popup Keypad Setup from the Assist menu.

2. When the Popup Keypad Setup window appears, set the required items,
referring to the online help for detailed instructions.

If you want to edit the pop-up keypad file, select Customize and then make
your changes.

3. Select OK. The pop-up keypad you selected is ready for use.

Mouse Setup

The Mouse Setup command lets you allocate functions to the right and left buttons
of the mouse; this enables you to perform the following actions without having to
use the keyboard:

v Running the Personal Communications-supplied key functions

v Running the user-defined macros

v Running character strings

Mouse File

You can save the functions defined for the mouse buttons in a mouse file (*.MMP).
You can create two or more mouse files and switch between them as required.

To set up the mouse and assign functions to the mouse buttons:

1. Select Mouse Setup from the Assist menu.

The current settings appear in the Mouse Setup window.

2. Set up the required items, referring to the online help for detailed instructions.

If you want to create or edit a mouse file:

a. Select Customize .

b. When the Customize Mouse window appears, allocate functions to the right
and left buttons of the mouse. These appear in Current Action for Mouse
Button .

c. Select the required functions from List of Key Actions .

d. Save your changes and then select OK.

3. Select OK.

The mouse setup is complete.

Macro/Script Setup

A macro is a sequence of key or mouse actions and host commands that you can
perform with a single action, such as a keystroke. You can edit an existing macro or
create a new macro by selecting Macro/Script Setup from the Assist menu.
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A script is a VBScript program that is a subset of the Visual Basic programming
language. For information on VBScript, see the on-line help pages.

Using a Macro/Script

You can use a macro or script in various ways. Table 2 lists examples of how you
can set up and then use macros and scripts.

Table 2. Macro Use Examples and Settings

If you want to... Do this...

Automatically play a macro or script when your session
starts.

Set an Auto-Start Macro/Script .

Play a macro or script while attached to a host
application.

Start Playing Macro/Script .

Play a macro or script with the keyboard or macro
function.

Use the Keyboard/Macro/Script
Function .

Click on a hotspot to play a macro or script. Set a Hotspot .

Assign a macro or script to a pop-up keypad button. Customize the Pop-Up Keypad file.

Press the mouse button to play a macro. Customize a Mouse file.

Press a key on the keyboard to play a macro or script. Customize a Keyboard file.

Creating a Macro

You can create a macro manually or by recording some of your interactions with the
host system, such as your logon procedure.

To create a macro manually:

1. Select Macro/Script Setup from the Assist menu.

2. When the Macro/Script Setup window appears, select Customize .

3. When the Customize Macro/Script window appears, select File , then New, then
Macro , and edit the macro. You can type statements directly or select functions,
characters, or even other macros, from the list of Key Actions in the Select a
Key-Action subpanel.

Refer to the online help for detailed information.

4. Click File , then Save to save the macro file.

Macro Statements

You can use the following statements when you create a macro:

Key function
Use Personal Communications-supplied key functions

Macro Define a macro within another macro but you cannot create a macro in a
permanent loop where the first macro is repeatedly called at the end of the
macros.

Character
Use any characters in the Character list in the Customized Macro window.

Character string
Use character strings you can type from the keyboard. You must use a
double quotation mark (“) at the beginning of the character string.
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Wait condition
Specify wait conditions to stop the process until the specified time has
elapsed or the status satisfying the specified condition occurs.

Tokens
You can use tokens, such as goto and run, to add logic.

Macro loop considerations

If you use a GOTO and a label in a macro to create a loop, you may experience
unpredictable behavior if that loop executes a large number (more than 1000) of
iterations.

Creating a Script

You can create a script manually or by recording some of your interactions with the
host system, such as your logon procedure. Scripts, however, allow a higher level
of programming control unavailable with macros.

To create a script:

1. Select Macro/Script Setup from the Assist menu.

2. When the Macro/Script Setup window appears, select Customize .

3. When the Customize Macro/Script window appears, select File , then New, then
Script , and edit the script. The Select a Key-Action subpanel, in gray, is not
available for creating scripts.

Refer to the online help for detailed information.

4. Click File , then Save to save the script file.

Setting Up a Macro or Script to Autostart

To set up a macro or script to autostart:

1. Select Macro/Script Setup from the Assist menu.

The Macro/Script Setup window appears.

2. Set a macro or script to auto-start when your workstation starts.

3. Refer to the online help for detailed instructions and then select OK after
completing your setup.

Recording Macros or Scripts

To start macro or script recording, select Start Recording Macro/Script from the
Assist menu, type the macro or VBScript name, select the type of file required, and
then select OK.

To quit macro or script recording, Cancel Recording Macro/Script from the Assist
menu. The recording operation is canceled, and the macro or script is not saved.

To pause macro or script recording, select Pause Recording Macro/Script from
the Assist menu. The recording operation stops. To restart recording, select
Resume Recording Macro/Script .

To stop macro or script recording, select Stop Recording Macro/Script from the
Assist menu. Recording ends and the macro is saved in a specified file.

Assist Functions
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Playing Macros and Scripts

To start macro or script playing, select Start Playing Macro/Script from the Assist
menu, select the macro or script, and then select OK. The selected macro starts to
play.

To stop macro or script playing, select Quit Playing Macro/Script from the Assist
menu. The macro or script stops playing.

Web Browser Setup

Web Browser Setup allows you to define a preferred web browser and to use it
rather than the one that comes with your operating system.

Tab Setup

For VT, Tab Setup allows you to define tab stops for your VT session.

Managing Emulator Sessions

Personal Communications provides the following functions, in addition to those
provided by Windows, for those who work with several open session windows
simultaneously. These functions allow you to manage your session windows easily
and quickly.

Jump Use Jump to switch between the currently opened session windows.

You cannot use Jump to switch to a session window that is currently
hidden. Instead, select Show Session from the Window menu to display
the session window on the screen. Then, select Jump .

Hide Session
Use Hide Session to stop displaying a visible session window.

You cannot hide all sessions. At least one session is always shown.

Show Session
Use Show Session to display a session window that was previously hidden
with Hide Session .

View Use View to display a previously-saved arrangement of windows, or to save
an arrangement of windows.

Personal Communications can save and restore the following information
relating to the session window view:

v Position and size of each window

v Window status (standard, minimized, or maximized)

v Window font

You can save view information for up to eight windows.

Getting Help

For more information about managing session windows, refer to the online help:

1. Select Procedures from the Help menu.

2. When the help window appears, scroll down to Managing Workstation
Windows .

Assist Functions
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Select choices from that list for detailed information.

Managing Sessions
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Managing Sessions
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Chapter 6. Utilities

Personal Communications provides the following utilities:

32-bit ODBC Administrator
Allows you to add, configure, or delete an ODBC data source.

Database Access
Allows read-only access to data in the selected database after you have
configured a data source.

CM Mouse
Provides intelligent and programmable mouse support for 3270 and 5250
emulation sessions.

DOS EHLLAPI
Allows DOS-based EHLLAPI programs to communicate with the 32-bit
Personal Communications emulator.

Menu-Bar Customization
Provides a means of changing the content of the menu-bar of the Personal
Communications session window.

Multiple Sessions
Provides the capability to run multiple host sessions using a single icon.

ZipPrint
Allows you to print PROFS or OfficeVision notes, calendars, OV documents,
CMS files, XEDIT workspaces, and 3270 session screens.

Convert Macro to a VBScript
Allows an existing Personal Communications Macro file to be converted to
a VBScript file.

PC Organizer
Runs Windows applications from a 5250 display session.

Data Transfer
Transfers data from the AS/400 system to your workstation, or from your
workstation to the AS/400 system. (Record-level data transfer).

Text Assist (SBCS only)
Allows you to create or edit a document or short messages.

AS/400 Network Drives (Shared Folders)
Provides access to AS/400 folders as if they were disk drives on your
workstation.

32-bit ODBC Administrator

ODBC is a programming interface that enables applications to access data in
database management systems that use Structured Query Language (SQL) as a
data access standard.

Use the following steps to set up the Personal Communications ODBC data source:

1. Select the 32-bit ODBC Administrator icon from the Personal Communications
ODBC program group. The Data Sources window appears.

2. Select IBM DB2 ODBC Driver data source in the Data Sources (Drivers) list.
Then clickFinish .

© Copyright IBM Corp. 1989, 1999 63



3. Click Add Database . The Personal Communications Add Database SmartGuide
appears to prompt you through the set up.

4. Select the Manually Configure a Connection to a DB2 Database radio button.

5. Specify the information to set up the data source, by clicking Next .

6. When you are finished specifying the information, click Done .

7. You will be prompted to test the connection. To test the connection, click OK.
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Note

Personal Communications uses ODBC 32-bit drivers. Applications,
such as Lotus 1-2-3 included in the Lotus SmartSuite 96 package,
require a 16-bit driver and will not work with Personal
Communications. You should see your product vendor for a version
that utilizes 32-bit ODBC drivers (Lotus 1-2-3 included in Lotus
SmartSuite 97 for example).

Note

To successfully test the DB2 connection, you must start the
Personal Communications SNA subsystem with the appropriate
configuration data. This configuration data must include the
following:

v Node definition

v Device definition

v Connection definition

v Partner LU definition

v Mode definition (IBMRDB must be created)

v CPI-C Side Information

You might also need to include a Local LU 6.2 definition.

For more information on SNA Node operations, refer to the
Personal Communications Reference Volume I.

Following example is a sample .ACG file:
NODE=(

ANYNET_SUPPORT=ANYNET_SUPPORTED
CP_ALIAS=YOURALIAS
DEFAULT_PREFERENCE=NATIVE
DISCOVERY_SUPPORT=DISCOVERY_CLIENT
FQ_CP_NAME=YOUR.CPNAME * <---- Modify w/ CP Name
NODE_ID=05D00000
NODE_TYPE=END_NODE
REGISTER_WITH_CDS=1
REGISTER_WITH_NN=1

)
PORT=(

PORT_NAME=LAN0_04
DLC_DATA=00000000000004
DLC_NAME=LAN
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IMPLICIT_CP_CP_SESS_SUPPORT=1
IMPLICIT_DEACT_TIMER=0
IMPLICIT_DSPU_SERVICES=NONE
IMPLICIT_HPR_SUPPORT=1
IMPLICIT_LIMITED_RESOURCE=NO
LINK_STATION_ROLE=NEGOTIABLE
MAX_IFRM_RCVD=8
MAX_RCV_BTU_SIZE=32767
PORT_TYPE=SATF
PORT_LAN_SPECIFIC_DATA=(

ACK_DELAY=100
ACK_TIMEOUT=3000
ADAPTER_NUMBER=0
BUSY_STATE_TIMEOUT=60
IDLE_STATE_TIMEOUT=30
LOCAL_SAP=04
MAX_RETRY=10
OUTSTANDING_TRANSMITS=16
POLL_TIMEOUT=3000
POOL_SIZE=16
REJECT_RESPONSE_TIMEOUT=30
TEST_RETRY_INTERVAL=8
TEST_RETRY_LIMIT=5
XID_RETRY_INTERVAL=8
XID_RETRY_LIMIT=5

)
)
LINK_STATION=(

LS_NAME=LINKMVS
ACTIVATE_AT_STARTUP=1
ADJACENT_NODE_TYPE=APPN_NODE
AUTO_ACTIVATE_SUPPORT=0
CP_CP_SESS_SUPPORT=1
DEFAULT_NN_SERVER=0
DEST_ADDRESS=40000000000000 * <---- Modify w/ Dest
DISABLE_REMOTE_ACT=0
DSPU_SERVICES=NONE
ETHERNET_FORMAT=0
HPR_SUPPORT=0
LIMITED_RESOURCE=NO
LINK_DEACT_TIMER=0
LINK_STATION_ROLE=USE_ADAPTER_DEFAULTS
MAX_IFRM_RCVD=0
MAX_SEND_BTU_SIZE=32767
NODE_ID=05D00000
PORT_NAME=LAN0_04
SOLICIT_SSCP_SESSION=0
TARGET_PACING_COUNT=1
TG_NUMBER=0
USE_DEFAULT_TG_CHARS=1

)
DLUR_DEFAULTS=(

DEFAULT_PU_NAME=YOURALIAS * <---- Modify w/ your name
DLUS_RETRY_LIMIT=3
DLUS_RETRY_TIMEOUT=5

)
LOCAL_LU=(

LU_NAME=LUNAME * <---- Modify w/ LU Name
LU_ALIAS=LUALIAS * <---- Modify w/ LU Alias
LU_SESSION_LIMIT=0
NAU_ADDRESS=0
ROUTE_TO_CLIENT=0
DEFAULT_POOL=0

)...
PARTNER_LU=(

FQ_PLU_NAME=PARTNER.LUNAME * <---- Modify w/ Partner Info
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CONV_SECURITY_VERIFICATION=1
MAX_MC_LL_SEND_SIZE=32767
PARALLEL_SESSION_SUPPORT=1
PARTNER_LU_ALIAS=RBNAME * <---- Modify w/ Location/RDBNAME
PREFERENCE=USE_DEFAULT_PREFERENCE

)
CPIC_SIDE_INFO=(

SYM_DEST_NAME=DB2CPIC * <----- Needed for ODBC configuration
CONVERSATION_SECURITY_TYPE=NONE
MODE_NAME=IBMRDB
PARTNER_LU_NAME=USIBMNM.NM57DB21 * <---- Modify w/ Partner Info
TP_NAME=DB2DRDA * <---- Modify w/TP Name (per DB2 help)
TP_NAME_TYPE=APPLICATION_TP

)
SHARED_FOLDERS=(

CACHE_SIZE=256
)
VERIFY=(

CFG_MODIFICATION_LEVEL=13
CFG_VERSION_LEVEL=1

)

Database Access

Database Access lets you access host or PC databases and retrieve data, using
ODBC drivers. If you specify the conditions for accessing data in each window, the
desired query can be created automatically.

From Database Access, you can:

v See and modify the SQL statements that are created automatically.

v See available database-table lists.

v Copy spreadsheet data to the clipboard.

v Show data in the grid in the main window spreadsheet, send data to other
applications (for example, Lotus 1-2-3 or Microsoft Excel), or send data to a
printer.

Before using Database Access, you should read Help information on:

v Database size limits

v Installed programs

CM Mouse

CM Mouse allows users of host applications to point-and-click to perform host
functions. Clicking a CM Mouse on ″hot spots″ gives true context-sensitive function
to each host application screen. Hot spots are not fixed function or fixed placement,
but change dynamically as you move through a host application.

CM Mouse popup menus give you instant access to lists of options and functions
with a simple point-and-click. Popup menus can simplify command selection,
choose options, and automate repetitive tasks. The CM Mouse popup menu editor
allows you to quickly and easily customize the menus to your own purposes or to
create new menus.

The CM Mouse scripting language is powerful enough to automate complex host
interactions, yet simple enough for even novice users.
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Refer to the IBM eNetwork CM Mouse Support User’s Guide and Reference for
more information.

Menu-Bar-Customization

This utility enables you to remove items from the menu-bar of the Personal
Communications session window. The changes affect only the session that you
customize, so you can make different changes to each session. You can remove
three types of items:

1. A menu-bar command, such as File , Edit , Transfer , Communication

2. A pull-down-menu command, such as, New, Open... , Color Mapping ,
Configure

3. A separator-line that resides between two commands in a pull-down menu

The instructions to modify the menu-bar are saved in the workstation profile that
you choose and become active the next time you start the session.

Multiple Sessions

The Personal Communications Multiple Sessions Batch Program allows you to start
several host sessions by clicking a single icon; the necessary commands are
specified in a batch-file (*.BCH). You can include in a batch file other programs,
which may communicate with a host session via the DDE or EHLLAPI interface.

It is also possible to start multiple sessions without a batch file.

ZipPrint

ZipPrint is a 3270 utility that enables you to print PROFS or OfficeVision notes,
calendars, OV documents, CMS files, XEDIT workspaces, and 3270 session
screens. By default, it uses the Windows printer currently set up for the host
session, but you can change it if you wish.

You do not have to install ZipPrint — you just start it. It adds itself to the menu-bar
of the sessions for which you define it, so you can use it in the same way as any
other menu-bar function. You must start ZipPrint before you start a session in which
you want to use it.

ZipPrint needs the DDE/EHLLAPI, so you must make sure that this is enabled for
the sessions for which you want to use ZipPrint. (It is enabled by default, but you
should check that it has not been turned off.)

For more information about ZipPrint, see “ZipPrint (3270 Only)” on page 40.

Convert Macro to a VBScript

The Convert Macro to a VBScript utility allows you to convert an existing Personal
Communications Macro file to a VBScript file. To use the conversion utility click on
the Convert Macro to VBScript icon in the Utilities folder.

In order to convert an existing macro to a VBScript, do the following:
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1. Select the name of an existing macro to be converted.

Note: The macro must exist in the Personal Communications \private directory.

2. Enter a name for the new VBScript or accept the generated name. The
extension will be added automatically.

3. Click the OK Button.

4. Repeat these procedures to convert another macro, or click Close to end the
application.

PC Organizer

You can use the PC Organizer to run DOS commands and applications or Windows
applications from a 5250 display session.

AS/400 Requirements

Before you can use the PC Organizer, one of the following programs must
have been installed on the AS/400 system:

v Client Access/400 (or OS/400 V3 or later)

v PC Support/400 (5738-PC1)

Starting the PC Organizer

To start the PC Organizer:

1. Start a 5250 display session.

2. Sign on to the AS/400 system.

3. Enter the following command on the AS/400 command line:
STRPCO PCTA(*NO)

Note

Personal Communications does not support the PC Text Assist
(PCTA) function, so you should specify this parameter with *NO.
Even if you specify *YES, you cannot use the PC Text Assist
function provided by the PC Support/400 Workstation Feature.

You can now use the PC Organizer functions in a 5250 display session by using
one of the following methods:

v Display and then select choices from the menu.

To display the PC Support/400 or Client Access/400 Organizer menu, enter:
GO PCOMNU

v Enter PC Organizer commands.

To start the PC Organizer functions, enter:
STRPCCMD
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PCO.EXE Message
When you run a workstation command or program, you might receive a
message that the PCO.EXE program is not active. You can ignore this
message, because it is not necessary for PC400 to activate PCO.EXE.

Getting Help

Refer to the online help for more information about using the PC Organizer.

1. Select Procedures from the Help menu.

2. When the help window appears, search for organizer or scroll down to PC
Organizer (5250 Session) .

Select topics in the list to view information about starting and using the PC
Organizer, using the PC Organizer menu, and the differences between the PC
Organizer provided with PC400and PC Support/400.

Data Transfer

Personal Communications Data Transfer enables you to transfer data between an
AS/400 system and your workstation. To use the Data Transfer function, select the
Data Transfer icon.

Transferring data is quite different from transferring files, which is described in
Transferring Files.

Requirements

Before you can transfer data with Personal Communications:

v You must have an SNA connection to an AS/400 system.

v IBM PC Support/400 (5738-PC1) must be installed on your AS/400
system, unless IBM OS/400 Version 3 or later is installed.

v Data transfer cannot be used over TN5250 connection types.

There are two types of data transfer, depending on the direction of the transfer.

Data sending
Data is transferred from your workstation to the AS/400 system. You can
transfer data to any of the following destinations:

v Existing members in an existing AS/400 physical file

v New members in an existing AS/400 physical file

v New members in a new AS/400 physical file

PC Organizer
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Note

You cannot transfer data from a workstation file to an AS/400
logical file.

Data receiving
Data is transferred from the AS/400 system to your workstation.

While receiving data from the host, you can specify the data to be received
and where the data is to be output.

Receivable data includes:

v An entire AS/400 file

v Part of an AS/400 file

v Data combined from several AS/400 files

v Summary of record groups

Specify the following output destinations:

v Display

v Disk

v Printer

Also, you can specify the numeric value format.

For more information about data transfer, refer to the Personal Communications
Reference manual.

Text Assist (SBCS Only)

With Personal Communications, you can use the improved text editing capability of
Text Assist provided by the OfficeVision/400 word processing function to create a
document or short messages, or to edit an existing document.

To start the text assist function, enter WRKDUC on the 5250 command line.

For more information about using Text Assist, refer to the documents for the
OfficeVision/400 program.

The Text Assist function in Personal Communications is a “Controller Text Assist,”
not the “PC Text Assist” supported by PC Support/400 Workstation Feature.

Controller Text Assist in Personal Communications provides the following functions
that are not included in PC Text Assist:

v Line commands

v 132 columns

Data Transfer
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Controller Text Assist in Personal Communications does not, however, provide the
multicolumn edit function that is included in PC Text Assist.

Note

In the Text Assist environment, Alt key functions are assigned to the
Ctrl key state to avoid conflicts with existing emulator functions. For
example, the Word Underscore (WrdUnd) key is Ctrl+W rather than
Alt+W. Many of these functions can be remapped to the Alt key state
without conflicting with emulator functions.

When you draw a line using the cursor draw option of the OfficeVision/400 program,
the insert mode is not available.

AS/400 Software Requirements

The AS/400 system must have one of the following programs installed to
support the Text Assist features:

v OS/400 V2R2.0 with cumulative PTF C3285220 with PTF SF14687

v OS/400 V2R3.0 with PTF SF14495

v OS/400 V3R0.5

v OS/400 V3R1.0, or later

Text Assist Key Functions

Following is a list of OfficeVision/400 Text Assist key functions:

Function Description

Begin of Line Moves the cursor to the beginning of the line

Begin Bold Begins bold highlighting

Bottom of Page Moves the cursor to the bottom of the page

Carrier Return Ends a line of text or a paragraph by inserting a carrier return

Center Text Centers a line of text

End of Line Moves the cursor to the end of the line

End of Page Inserts an “end of page” character at the cursor position

End Bold/Underscore Ends bold highlighting and underlining

Half Index Down Begin subscript or end superscript

Half Index Up Begin superscript or end subscript

Insert Symbol Displays a menu for special symbols

Display Text Codes Shows hidden text controls

Next Column Inserts a “next column” instruction at the cursor position

Next Stop Code Moves the cursor to the next stop code symbol

Text Assist
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Function Description

Required Backspace Moves the cursor one space to the left

Required Space Inserts a required space to keep words together on a line

Required Tab Indents a block of text

Stop Code Inserts a stop code at the cursor position

Top of Page Moves the cursor to the top of the page

Begin Underscore Begins underlining text

Word Underscore Underlines the word that starts at the cursor position

AS/400 Network Drives (Shared Folders)

The AS/400 system uses a structure called a folder to store and organize
documents, mail, and other related objects. Personal Communications lets you
share these folders and store both AS/400 documents and your workstation files in
them.

The Network Drives function lets you access a folder on the AS/400 system as if it
were a drive on your workstation. For example, a folder on the AS/400 system
could be assigned to drive E on your workstation; you could then access drive E in
the same way as you access drive C on your hard drive.

You can use the Network Drives function to:

v Use AS/400 security to limit access to workstation files.

v Share data with multiple users at the same time.

v Back up workstation files to an AS/400 folder.

v Use workstation commands or AS/400 functions to work with workstation files.

Note

Network drives requires AS/400 Version 3 or later.

Setting Up AS/400 Network Drives

To use an AS/400 Network Drive, you must have an SNA connection - for example,
Twinax or LAN via IEEE 802.2 - to the AS/400; this can be a display or printer
session, or a separate APPC connection defined through SNA Node Configuration.
You cannot use a TCP/IP or IPX connection.

If several AS/400s are interconnected and you want to use a network drive on more
than one of them, you need a direct link only to one; since all AS/400s are SNA
Network Nodes, a connection to any of them will give you access to the others -
you need only add, to the configuration for the direct link, a Partner LU definition for
each other AS/400. You can do this through SNA Node Configuration.

Text Assist
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Assigning (Mapping) Drives

Assigning network drives on an AS/400 is much the same as on a LAN server. On
both Windows 95, Windows 98 and Windows NT, the easiest way is through the
Network Neighborhood:

1. Open the Network Neighborhood

2. Click the AS/400 server on which the folder you want to assign a drive to
resides

3. Click the folder, then click File on the menu-bar; or right-click on the folder

4. Click Map Network Drive , then choose a drive letter. If you want the drive to be
connected automatically every time you log on to Windows, check the
Reconnect at Logon box.

Note

If you have checked Reconnect at Logon, you will be asked to provide
an AS/400 user ID and password whenever you log on to Windows.
The default .ACG file will be used in this case. It is recommended that
the Reconnect at Logon box not be checked.

There are other ways to access AS/400 folders; you can use whichever
method is most convenient:

1. With the Windows Explorer

2. With the NET USE command from a DOS prompt

3. By using a UNC name

Text Assist
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Chapter 7. Enabling Client/Server Applications

Personal Communications’s support for APPN end nodes lets you take advantage
of APPN network nodes. An APPN network allows automatic locating of partner
applications and dynamic, optimized route selection. These features allow
workstations to communicate more flexibly with other systems in the network.

Personal Communications also provides support for 32-bit APPC and CPI-C APIs,
which provide convenient ways for 32-bit client application programs on your
workstation to communicate with those on other workstations.

Configuring a Node

Before you can take advantage of the client APIs and communicate with other
application programs, you first need to configure Personal Communications as an
SNA end node.

To configure the SNA node:

1. From the Start menu, select:

Programs
IBM Personal Communications

SNA Node Configuration

The Personal Communications SNA Node Configuration window appears.

2. Select the necessary Configuration Options in the order listed on the window.

To select an option, click it and then click New....

For each option, enter the appropriate information on the property pages. Most
required information is listed on the Basic page. Click OK to complete the
option. Click Help for more information about the individual parameters.

3. Click Save or Save As from the File menu.

4. Type the file name and then click Save. Note that you can choose the file type
and where to save this file. The default file type is *.ACG and the default
directory is the PRIVATE subdirectory in your Personal Communications
directory.

5. Click Exit from the File menu.
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Tip

If you have more than one configuration file, you can apply additional
configuration files to an active node. Refer to the help in the SNA
Node Operations section of the product for details.

Starting the SNA Node
1. To start the SNA node, from the Start menu, select:

Programs
IBM Personal Communications

Administrative and PD Aids
SNA Node Operations

The Personal Communications SNA Node Operations window appears.

2. Click Start Node... from the Operations menu.

The Select configuration file to use... window appears.

3. Double-click the configuration file (*.ACG) that defines the node you want to
start.

Note

Another way to start the SNA node is to use the command line. The
command to use is CSSTART. For the proper syntax see the “SNA
Node Operations” chapter of the Personal Communications V4.3
Reference Volume I.

Stopping the SNA Node
1. To stop the SNA node, from the Start menu, select:

Programs
IBM Personal Communications

Administrative and PD Aids
SNA Node Operations

The Personal Communications SNA Node Operations window appears.

2. Click a resource in the Alias column.

3. Click Stop Node... from the Operations menu.

Enabling Client/Server Applications
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Note

Another way to stop the SNA node is to use the command line. The
command to use is CSSTOP. For the proper syntax see the “SNA
Node Operations” chapter of the Personal Communications V4.3
Reference Volume I.

APING Requirements

If you wish to run the Check Connection (APING) utility provided with this package
to an AS/400 running OS/400 V3R1, you must install PTF MF10808 on the AS/400
first. If this PTF is not installed, then errors with sense codes of 080F 6051 and
1008 201D will occur.

Enabling Client/Server Applications
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Chapter 8. Where to Find More Information

This chapter discusses getting help when you are installing, configuring, or using
Personal Communications.

Online Help

The help facility describes how to install, configure, and use Personal
Communications. Online help is very extensive and includes information about
every aspect of configuring and using Personal Communications.

Use help to obtain information about:

v Menu choices

v Operation procedures

v Operations in windows

v Meanings of the terms displayed in windows

v Causes of errors and the corresponding actions to take

v Mouse-based operations

v Operation without a mouse

v Detailed explanations of specific terms

v Further technical information about Personal Communications

v Detailed explanations of operator information area (OIA) messages

How to Use Online Help

To display online help, select choices from the Help menu.

You can use Personal Communications online help just as you use the online help
for Windows 95, Windows 98, or Windows NT.

Messages

Online messages are displayed during Personal Communications sessions but a
message does not always mean an error occurred. For example, a message might
tell you that an operation is in progress or has been completed. A message can
also prompt you to wait for the completion of an operation.

Press F1 to display help for the messages that appear.

Page Fault Messages

If a message does appear in a pop-up window, you can copy its contents into the
Windows 95, Windows 98, or Windows NT clipboard. To do this:

1. Click Details Command on the pop-up window.

2. Mark the text that you want to copy.

3. Right click the marked text and then click Copy .

4. Start an editor, such as Notepad, and click Paste from the Edit menu.

5. Save the file in case an IBM Service Representative needs this information to
diagnose your problem.
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OIA Messages

Personal Communications displays messages in the operator information area (OIA)
or in a pop-up window. Messages from Personal Communications are displayed in
the message window; messages from the host system are displayed in the OIA of
the session window.

The bottom line of the session window is the OIA. The OIA indicator indicates the
status of Personal Communications as well as information about the workstation,
host system, and attachment method.

All of the OIA indicators, reminders, and messages are described in the online help.
To view this information:

1. Select Index from the Help menu.

2. Select The operator information area messages .

Tip

When the index window appears, select the Index button, and
then select Find . Type in the number of the message. Click on
Search .

Personal Communications Library

The Personal Communications library includes the following online publications:

v IBM eNetwork Personal Communications Quick Beginnings, GC31-8679

v IBM eNetwork Personal Communications Access Feature , SC31-8684

v IBM eNetwork Personal Communications Reference Volume I and Volume II ,
SC31-8680 and SC31-8682

v IBM eNetwork Personal Communications Emulator Programming, SC31-8681

v IBM eNetwork Personal Communications Client/Server Communications
Programming, SC31-8479

v IBM eNetwork Personal Communications System Management Programming,
SC31-8480

v IBM eNetwork Personal Communications Host Access Class Library, SC31-8685

v IBM eNetwork Personal Communications Configuration File Reference,
SC31-8655

v IBM eNetwork CM Mouse Support User’s Guide and Reference

Related Publications

For information about local area networks (LANs), refer to the following publications:

v IBM Local Area Network Technical Reference

v AS/400 Communications: Local Area Network (LAN) Guide Version 2

Finding More Information
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For more information about NetWare, refer to the publications for the following
products:

v For the client NetWare Client for Windows

v For NetWare for SAA NetWare for SAA

Contacting IBM

This section lists a number of ways you can reach IBM for various reasons.
Depending on the nature of you problem or concern, we will ask you to be prepared
to provide the following information to allow us to serve you better. For information
about the tools available to help with problem analysis, refer to the Personal
Communications Version 4.3 Reference Volume I.

v The environment in which the problem occurs:

– Personal Communications configuration

- Personal Communications version and CSD level

- The name of the workstation profile

- The name of the SNA Node Configuration file

– Workstation configuration

- The machine type and model, the system memory, the video adapter

- The communication adapter you are using

- Other adapters (especially communication adapters) installed

- The printer type and model

- Other devices installed, such as sound cards, modems, or fax machines

– Software configuration

- Windows version and level

- Communications and device-driver version and level

- Other communication programs (such as NetWare, Microsoft SNA Server,
or Microsoft Data Link Control) that are running and using resources

- Printer driver version and level

– Host configuration

- The upstream host connection and configuration

v Problem analysis information

– Symptoms

– Type of problem

– OIA messages or error messages (if any)

– Key factors related to the problem

If you have a technical problem, take the time to review and carry out the actions
suggested here. Use your local support personnel before contacting IBM. You can
also check the Hints and Tips on the WWW for more information. Only persons with
in-depth knowledge of the problem should contact IBM; therefore, support personnel
should act as the interface with IBM.

Support Options

If you determine that you need to contact IBM, you can do any of the following:

v Access the Personal Communications for Windows 95, Windows 98, and
Windows NT Web page:

Finding More Information
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http://www.software.ibm.com/enetwork/pcomm

v To find the phone number for IBM Software Support, U.S. customers can call
1-800-IBM-4YOU. International customers that have access to the U.S. ″800″ toll
free numbers can reach the International Support Center by calling
1-800-IBM-4YOU and asking to speak with the International Support Center (ISC)
in Atlanta. International customers without access to the U.S. toll free numbers
can call the ISC directly at 770-863-1234. The ISC’s FAX number is
770-863-3030 and is available 24 hours a day.

Finding More Information
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Appendix A. Directories and System File Modifications

This appendix describes the directories that are created and how the system files
are modified during installation.

Directories Created by the Installation Program

The program creates five subdirectories in the root of the main Personal
Communications directory: INCLUDE, LIB, PDFPDT, PRIVATE, and SAMPLES. With the
exception of the PRIVATE subdirectory, the subdirectories might contain files only
when you have selected to install them.

PRIVATE Subdirectory

This is almost empty when you first install Personal Communications (unless you
have migrated from a previous version), but if you create and save configurations,
the following types of files are stored here:

Personal files in the PRIVATE subdirectory:

v Workstation (session) profiles (*.WS)

v SNA configuration files (*.ACG)

v Batch files (to start multiple sessions) (*.BCH)

v Keyboard files (*.KMP)

v Pop-up keypad files (*.PMP)

v Mouse files (*.MMP)

v Macro files (*.MAC)

v Automatic-dial facility files (*.ADU)

v File-transfer translation files (*.XLT)

v User profile (*.UPR) (AS/400 only)

v Tool bar files (*.BAR)

v Trace log files (*.TLG)

v Message log files (*.MLG)

SAMPLES Subdirectory

This has several subdirectories, each containing the executable and source files for
a sample program. Header and LIB files are stored in the Personal
Communications\samples directory.

These programs are designed to illustrate the use of a programming interface:

DDXFER
Shows how the EHLLAPI interface can be used to create a drag-and-drop
application.

HLLSMP
Shows how the EHLLAPI interface can be used by an application on your
workstation to request keystrokes and to log on to a VM system.

LISTFILE
Illustrates how the dynamic data exchange (DDE) interface can make use
of the LOAD button to transfer files from a VM host system (3270 only).

© Copyright IBM Corp. 1989, 1999 85



PCSMAIN
Illustrates the use of the PCSAPI interface.

SPL2FILE
A DDE sample program that converts the AS/400 spooled file to the
workstation file.

SRPSMP
Shows how the SRPI SEND_REQUEST interface verb can be used by a
requester application on your workstation to invoke a server on the host.

VBDDE
Illustrates the use of the DDE interface with Microsoft Visual Basic**.

VBHLLAPI
Illustrates the use of the EHLLAPI interface with Microsoft Visual Basic.

VBPCSAPI
Illustrates the use of the PCSAPI interface with Microsoft Visual Basic.

WINAPING
Illustrates the use of CPI-C API programming.

PDFPDT Subdirectory

This directory contains PDF/PDT files used by Personal Communications print
function in PDT mode. Refer to “Using Printer Definition Table (PDT) Files” on
page 39 for more information about using PDF/PDT files.

ECL Subdirectory

The ECL subdirectory contains samples for using the Host Access Class Library for
Visual Basic (VB), Lotus Script, and C++.

Directories and System Files
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Appendix B. Attachment Considerations

This appendix describes factors you should consider when configuring Personal
Communications for the attachment types listed here.

COAX Attachment

This section describes factors you should consider when configuring Personal
Communications with a coaxial attachment.

Note

The APPC and CPI-C APIs, provided with Personal Communications,
do not support coaxial connections.

Avoiding Machine Check 207

Patch the microcode of the 3174 control unit. The following table shows the
relationship between 3174 control unit microcode levels and patch IDs:

Microcode Level
Patch ID

S0503 PCA53D1

S0504 PCA53D2

A0503 PCA53D3

A0504 PCA53D4

B0200 PCA53D5

B0401 PCA53D6

B0402 PCA53D8

C0101 PCA53D7

In addition, if you have a 3174 with Configuration Support B or higher, you can set
the following parameters:

v 3174 customization Q126 digit 2=1 to change the COAX timeout from 50 to 100
microseconds.

v 3174 customization Q125 digit 4=1 to set command chaining off.

Polling Feature

Some workstations disable interrupt-level 2 (IRQ 9) and reserve it for their own use.
IRQ 9, a redirected IRQ 2, is the only interrupt level that can be used by the IBM
3278/79 emulation adapter. Sometimes, when you try to use PC/3270 for coaxial
attachment with this type machine, you cannot connect to a host system.
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If this happens, add the Poll=Y parameter to the [CSDFT] or h[CNDFT] section of
your workstation profile (*.WS) as follows:

v SNA/DFT attachment
[CSDFT]
Poll=Y <-- add

v Non SNA/DFT attachment
[CNDFT]
Poll=Y <-- add

Sometimes PC/3270 cannot receive an interrupt from a 3270 credit card adapter
(PCMCIA). The default value of the Poll parameter is Y for a 3270 credit card
attachment.

Functions Not Available with DFT Attachment

When your workstation is configured to use a DFT attachment, the following
functions and capabilities of the IBM 3174 or 3274 Control Units are not supported:

v Programmed symbols on attached workstations

v Attachment to port 0 on attached workstations

v Database operations

v 3270 Diagnostic Reset Dump

v Patch facility

PCMCIA and PCI Configuration for a DFT Attachment

Using a Plug and Play Coax Adapter (PCMCIA or PCI)

If your workstation has an IBM 3270 Emulation Plug and Play Adapter (3270 PnP)
installed, Personal Communications uses it in the same way as the IBM 3278/79
Emulation or 3270 Connection Adapter.

You cannot use multiple 3270 PnP adapters; nor can you use a 3270 PnP at the
same time as a 3278/79 Emulation or 3270 Connection Adapter. Before you can
use a PCMCIA or PCI adapter under Windows 95 or Windows 98, you must first
install drivers for it. Refer to “Adapter Setup Hints and Tips” on page 103 for more
information.

Coax Adapters and ROM Shadowing

Personal Communications maps the shared RAM of the 3270 connection adapter
on the PC. The default values for the adapters as follows.

v Adapter #0 CE000h - CFFFFh

v Adapter #1 D0000h - D1FFFh

v Adapter #2 D2000h - D3FFFh

v Adapter #3 D4000h - D5FFFh

PCs that support ROM shadowing in BIOS may use these areas for ROM
shadowing by default (IBM PC350 P100 for example). Check the ROM shadowing
settings before installing an adapter and disable the range for the adapter you are
going to install.

Attachment Considerations
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LAN via IEEE 802.2 Attachment

Following is a description of pre-installation considerations for installing Personal
Communications for use on a LAN. For more detailed information, refer to the IBM
Local Area Network Technical Reference.

PIU Size

This value is negotiated between your workstation and the host system, unless
XID=No is defined on the PU, or the Adjacent CP type has been changed to
Host - XID0 in SNA Node Configuration. If this value is not negotiated, the Maximum
PIU Size must match the MAXDATA value defined on the host system.

Receive Window Count

This value is negotiated between your workstation and the host system, unless
XID=No is defined on the PU, or the Adjacent CP type has been changed to
Host - XID0 in SNA Node Configuration. If this value is not negotiated, the Receive
Window Count must match the MAXOUT value defined on the host system.

Using a PCMCIA Token-Ring or Ethernet Card

PC/3270 supports the IBM Token-Ring and Ethernet credit card adapters in the
same way as it does the full-size adapters.

TCP/IP Connection

This section provides information, considerations, and restrictions for Personal
Communications TCP/IP connections.

TCP/IP Protocol Driver

You must set up your Windows environment for the TCP/IP network. To verify that
the TCP/IP protocol is installed on your workstation, double-click Network in your
Control Panel and see if TCP/IP appears in the list of network components.
Double-click TCP/IP to specify your IP address and other TCP/IP properties.

Screen Size

The following four screen sizes are supported for TN3270:

24 x 80

32 x 80

43 x 80

27 x 132

The following two screen sizes are supported for TN5250:

24 x 80

27 x 132

Screen size 48X80, 62X160, and 24X132 are supported if your server/host supports
the TN3270E protocol.

Attachment Considerations
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Terminal Type to Be Negotiated With TN3270

The terminal type to be negotiated is set to IBM-3278-2-E, IBM-3278-3-E,
IBM-3278-4-E, or IBM3278-5-E according to the screen size that is specified on the
Customize Communication - 3270 Host panel. If you need to specify IBM-3279-2-E
or IBM-3279-3-E (for graphics), add the following line to the [Telnet3270] section in
the workstation profile (.WS):
TerminalType=3279

Telnet3270, TN3287, and TN3270E Connection

TN3287 (defined in RFC 1646) and TN3270E (defined in RFC 1647) were tested
with following Telnet servers:

v Communications Server for Windows NT

v Communications Server for OS/2

v TN3287 Brixton PU2.1 V3.0

– SNA Client Access for AIX Version1 Release 2

– IBM Communications Server for OS/2 Warp

v TN3270E Brixton PU2.1 V3.0

– SNA Client Access for AIX Version1 Release 2

– IBM Communications Server for OS/2 Warp

v Microsoft SNA Server

TCP/IP Function Enhancements

The following sections describe enhancements made to TCP/IP connections for
Personal Communications Version 4.3.

Service Location Protocol

Personal Communications enables connection to SLP servers that are RFC 2165
compliant. This function eliminates the need for users to know the name of a
network host supporting a specific service. SLP implementation for a Personal
Communications client allows load balancing and dynamic location of a specific LU
or LU pool across a group of servers. IntraNetware for SAA (IWSAA) 3.0 and IBM
Communications Server (CS/NT) 6.0 currently support SLP. This support can be
used in conjunction with SSL support.

Backup Server/Host with LU Name and Port Number

Personal Communications enables you to specify up to two backup host or server
names to connect to. This provides easier connections when the primary host or
server cannot be reached. A specific LU name or port number unique to that server
or host can also be specified.

Security - SSL

Personal Communications enables you to connect to a server that supports SSL
V3.0 or higher for TN3270(E), TN5250 or VT emulation. This allows you to encrypt
the data flowing on the network, and can be configured on a per session basis. This
support can be used in conjunction with SLP support.
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Connect Timeout

Personal Communications uses a non-blocking sockets when connecting to a
remote system. Personal Communications will wait three seconds, by default, to
establish the socket connection. The default can be changed by adding the
following line to the Telnet3270 or Telnet5250 section of the workstation profile:
InactiveTimeout=xx

where: xx is the time in seconds

TN5250 Enhancements

Personal Communications enables you to emulate a TN5250 printer session if the
Host carries OS/400 V4.2 or higher. A Workstation ID for display and printer
emulation sessions can also be specified.

SDLC MPA Attachment

This section describes factors you should consider when configuring Personal
Communications with an SDLC attachment.

Line Speed

For the SDLC attachment, a line speed up to 28.8 Kbps is supported. However,
actual line speed will vary depending on the carrier speed the modem supports.

V.25bis Autodial

Personal Communications only supports the bit-oriented protocol for V.25bis call
control messages. Modems must support an ASCII-coded character set consisting
of 7-bit coded ASCII characters with odd parity.

Personal Communications supports the following adapters:

v Multiprotocol (MPA) interface compatible adapters, for example:

– IBM Multiprotocol Communications Adapter (73G7099)

– IBM Multiprotocol Adapter/A (645114 or later)

– IBM SDLC/Asynch Communications Adapter (ASCA) (42H4332)

v IBM SDLC PCMCIA adapter (Japanese only)

v IBM SDLC PCMCIA modem (Japanese only)

v IBM PCI Multiprotocol Adapter (12J2981)

Performance Considerations

If you use multiple sessions in a high-speed and high-load configuration with an
SDLC attachment, the connection to the host might fail. In this case, set the host’s
timeout value to be greater than that of Personal Communications.

v To change the host timeout value, modify the following NCP parameters:

REPLYTO
The maximum duration in seconds that the host waits for a reply from the
terminal. The default is 1 second.

RETRIES=(m,t,n)
The number of recovery attempts for errors occurring during transmission
over the link. Repetitive retries are called a retry sequence. The
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maximum number of retries is specified as m, which can be from 0 to
128. NCP pause (the time between the retry sequences) is specified as t
and can be from 1 to 255 seconds. The maximum number of retry
sequences is specified by n and can be from 1 to 127. For example:

REPLYTO=1, RETRIES=(3,4,5)
(( 1(seconds) x 3(times) + 4(seconds)) x 5(times)
= 35 (seconds)

Note

In this example, the host will wait 35 seconds for the
terminal to reply.

For more details, ask your system personnel.

v To change the Personal Communications timeout value, type a new value in the
Inactivity timer field on the Performance page of the Connections property sheet
in SNA Node Configuration.

The value is in seconds and can be from 40 to 160. The default is 80.

PIU Size

This value is negotiated between your workstation and the host system, unless
XID=No is defined on the PU, or the Adjacent CP type has been changed to
Host - XID0 in SNA Node Configuration. If this value is not negotiated, the Maximum
PIU Size must match the MAXDATA value defined on the host system.

Receive Window Count

This value is negotiated between your workstation and the host system, unless
XID=No is defined on the PU, or the Adjacent CP type has been changed to
Host - XID0 in SNA Node Configuration. If this value is not negotiated, the Receive
Window Count must match the MAXOUT value defined on the host system.

Preventing Conflicts with Non-PCI MPA Adapters

The multiprotocol adapters use system resources that, in some cases, cannot be
shared. Therefore, you must make sure there are no conflicts with the following
resources:

v DMA level

v I/O addresses (MPA0 uses X'380'–X'38F' and MPA1 uses X'3A0'–X'3AF')

v IRQ level (ISA bus only)

The IBM Multiprotocol interface adapters use the following system resources:

v The AT-bus SDLC adapters require the use of IRQ3 and DMA channel 1 and
only the MPA0 communication port is supported.

v The MPA for ISA can be supported using mode 4 (IRQ3 and DMA1 channel 1) or
mode A (IRQ4 and DMA channel 1). IRQ level send/receive of 3 or 4 is
supported. The ASCA can be supported using mode 4 (IDQ3 or IRQ5 or IRQ4 or
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IRQ7 and DMA channel 1) or mode A (IRQ4 or IRQ7 and DMA channel 1). IRQ
level send/receive or 3, 4, 5, or 7 is supported. The interrupt level setting on the
configuration panel in Personal Communications must match the value on the
adapter card.

Note

When the MPA is configured for mode 4, the device will not be
allowed to use the other IRQ even though only one interrupt is
claimed.

Personal Communications supports the MPA0 or MPA1 communication ports.
Some sound cards use an I/O address within the range X'380'–X'38F'. MPA1
should be used to avoid a conflict.

v The MPA/A for a microchannel-bus workstation uses IRQ3, and the DMA level is
configurable. Both the MPA0 and MPA1 communication ports can be active at the
same time and the interrupt is claimed as sharable.

IBM Global Network - SNA over Async Attachment

IBM Global Network - SNA over Async is supported using 8-bit no parity; SNA
session-level compression and decompression is not supported.

Line Speed

Line speeds up to 115.2 Kbps are supported. However, the maximum usable line
speed depends on the speed of the processor or communication port. If
communication stops or becomes exceedingly slow, reduce the line speed.

Updating Phone List

To update the phone number list for IBM Global Network SNA over Async, do the
following:

1. Click the Used Phone Book button on the Define a Com Port Connection
panel.

2. Click the Download Phone Numbers button.

Personal Communications FTPs to the IGN server and downloads the phone
number file and converts it to the correct format.
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Note

Sockets over SNA or Proxy must be configured in order for this
procedure to work.

IBM Global Network Connection Attachment

Note

This attachment type is not available in Japan.

IBM Global Network Connection supports only a single communication port.

Line Speed

IBM Global Network Connection supports up to 115.2 kbps as the line speed.
However, the maximum usable line speed depends on the speed of the processor
or communication port. If communication stops or becomes exceedingly slow,
reduce the line speed.

Updating Phone List

To update the phone number list for IBM Global Network SNA over Async, click the
Download Phone Numbers button from the Configuration panel. When this
button is selected, Personal Communications FTPs to the IGN server and
downloads the phone number file and converts it to the correct format.
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Note

Sockets over SNA or Proxy must be configured in order for this
procedure to work.

Functions Not Available with the IBM Global Network Connection

You cannot use the following functions:

v Import/Export

v Host graphics

v Host print

v Server-Requester Programming Interface (SRPI)

v Concurrent multiple file transfers

Home3270 Attachment

Because Home3270 supports only a single COM port, only one session is available
for use at a time.

Setting the Screen Colors in a Home3270 Session

Because protocol converters translate the 3270 (EBCDIC) data stream into an
ASCII data stream, the original information about the 3270 fields is lost, and all the
field attributes of the 3270 screen are treated as extended attributes. Because of
this, you must select the Extended Color category in order to change the colors of
characters on the screen. Changing base colors will have no effect.

For example, if you want to change the color of characters that appear in green on
a black background, select Extended Color - Green , then click or drag-and-drop
the color you want for the characters (and for the background if you wish). Do not
change the appropriate Base Color because the change will have no effect.

Line Speed

Line speeds up to 115,200 bps are supported. However, characters might be lost on
high-speed lines, depending on the processor speed. If communication stops or
becomes exceedingly slow, reduce the line speed.

Unsupported Character Sequences

The following character sequence is valid for the Home3270 attachment. However,
it performs no function.

v ESC P 1 (Block cursor command)

v ESC P 0 (Underline cursor command)

v DLE DC2 (Printer start command)

v DLE DC4 (Printer end command)

Attachment Considerations

Appendix B. Attachment Considerations 95



Conditions for Communication Check 50x

Home3270 requires both Data Set Ready (DSR) and Carrier Detect (CD) to
determine the state of the attachment with the host system. If DSR is not
recognized, communication check 501 appears in the operator information area.
When DSR is recognized, if CD is not recognized, communication check 504
appears in the operator information area.

When you select ROLMphone** with DCM in the Home3270 configuration,
communication check 504 does not appear.

Home3270 and OIA message COMM 504

If you run Home3270 sessions at a speed of 28.8 kbps or higher and the session
disconnects with a COMM504 in the OIA, try lowering the port speed to equal the
line speed of the Protocol Converter you are connecting to.

Note

DBCS is not available with this attachment.

Restrictions

The following functions are not available with this attachment:

v Host graphics

v Host print

v Server Requester Programming Interface

3270 Attachment via the AS/400 System

This section provides information, considerations, and restrictions for PC/3270
connections through an AS/400 system.

AS/400 System Setup

PC/3270 can connect to a host computer via one or more AS/400 systems by using
the passthrough function (usable with OS/400 Version 2.2.0 or later).

To use this function, set the following communication configuration descriptions in
the AS/400 system to on (Vary On):

v Line description

v Controller description

v Printer description
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Error Messages from the AS/400 System

When this system is connected to an S/390 host system via the AS/400 system, the
following message might appear on the screen.

AS/400 CPI5xxx

The message might appear for the following reasons:

v Line error between the AS/400 system and the host system.

v Communication configuration description error in the AS/400 system.

v The communication configuration description in the AS/400 system is set off
(Vary Off).

When this message appears, detailed error information is saved in the AS/400
system operator message queue. Refer to the error message that corresponds to
the number displayed on the screen and then correct the cause of the error.

IBM PC720 Modem Initialization (Japan Only)

In the Japanese version of Personal Communications, if you use an IBM PC720
and connect it via a dial connection, the error message “COMDIA15 Unable to
initialize modem” may appear at startup. To correct this condition, increase the
value of Retries in Initialization to more than 1 by using the Modem Information
panel.

Practical Peripherals 14400MT Modem Considerations

The Practical Peripherals 14400MT modem does not always work properly when
receiving incoming connections. If it appears that the modem is not answering an
incoming call, then do the following:

1. Using the Node Operations panel, stop the Device associated with the modem.

2. Turn off power to the modem and then back on.

3. Using the Node Operations panel, start the Device associated with the modem.

Twinax Attachments

Personal Communications supports the following IBM adapters:

v IBM Enhanced 5250 Display Station Emulation Adapter

v IBM AT-Bus Communication Adapter (DBCS-unique adapter)

v IBM 5250 Emulation PCMCIA Adapter

v IBM 5250 PCMCIA Adapter (DBCS-unique adapter)

v IBM System36/38 Workstation Emulation Adapter /A

v IBM 5250 Emulation Adapter /A

v IBM 5250 Emulation PCI Adapter

v IBM 5250 Express ISA Adapter

v IBM 5250 Express PC Card

v IBM 5250 Express PCI Adapter

v Other Twinax Adapters (OEM)
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IBM SDLC PCMCIA Adapter and Modem (Japan Only)

For Windows 95 and Windows 98: The support uses the Configuration Manager
for Plug and Play support, which will automatically configure IRQ number, I/O ports
and memory addresses as required. IBMSDLC.INF (installed in the Personal
Communications installation directory) describes the SDLC PCMCIA cards to the
operating system. When you insert the PCMCIA card, Windows 95 and Windows 98
prompt you for the adapter drivers. You must specify the Personal Communications
installation directory and select OK. To verify that the adapter is functioning
properly, select the appropriate PCMCIA adapter under Other Device on the
System Property page’s Device Manager property sheet.

For Windows NT: Plug and Play is not supported. During installation the registry is
updated, using default parameters. When the configuration is started and an
incoming or outbound connection is enabled, the device attempts to load, using the
stored parameters from the registry. If a card is found and a conflict is detected, the
registry is updated with values that do not conflict and you are notified to restart the
system.

Note

The system must be restarted for these values to take affect.

No more than one SDLC PCMCIA card can be used concurrently. Because a
common driver supports both SDLC PCMCIA and MPA interface cards, an MPA
cannot be used concurrently with SDLC PCMCIA.

IBM SDLC PCMCIA Adapter

This card supports:

v Leased and switched connections

v Speeds up to 19.2 Kbps

v Switched and Constant Request To Send (RTS)

v NRZ and NRZI encoding schemes

The IRQ number on the device page’s adapter property sheet is ignored.

IBM SDLC PCMCIA Modem

This card supports:

v Switched V.26bis connections only

v Speeds up to 2400 baud

v Switched RTS only

The configured value on the constant RTS and IRQ level send/receive device
page’s adapter property sheet are ignored.
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Note

The receive window count in the SDLC-MPA device page’s
performance property sheet and the SDLC-MPA connections page’s
performance property sheet must be set to 1.

SDLC Attachment and IBM 7852 Modems

To use the SDLC attachment with an IBM 7852-013 modem, make sure that NRZI
encoding is not selected. If you experience problems look on the IBM PC Company
bulletin board for flash updates for this modem.

IBM PCI Multiprotocol Adapter

Refer to the Quick Installation Guide in the PCI Multiprotocol Adapter User’s Guide
for instructions on installing this adapter under Windows 95, Windows 98, and
Windows NT.

Two IBM PCI Multiprotocol Adapter’s can operate concurrently. The configuration
specifies one adapter with Communication Port MPA0 and the second adapter with
Communication Port MPA1. When the link is activated, MPA0 is the first PCI
Multiprotocol Adapter that the operating system finds and MPA1 is the second
adapter found. If more than one PCI Multiprotocol adapter is installed on a machine
and you are unsure which adapter the operating system will find first, you may want
to perform an isolated test to determine which adapter is connected to which
Communication Port. One suggestion is to disconnect the modems connected to
the adapter from the telephone line and then try to start each link individually. By
watching the modems, you should be able to determine which modem is connected
to which Communication Port. Then the modems can be attached to the proper
network. If a single PCI Multiprotocol Adapter is used, the configuration file must
specify MPA0 as the Communication Port.

If a Personal Communications configuration is using this adapter, and a PCI
MPA adapter is added or removed from the system, Personal
Communications may have to be reconfigured.

An ISA-bus MPA and IBM PCI Multiprotocol Adapter can be used concurrently, as
long as the ISA-bus MPA adapter is configured as MPA1.

This adapter supports:

v Leased and switched connections

v Speeds up to 56 kbps
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v Switched and Constant Request To Send (RTS)

v NRZ and NRZI encoding schemes

The IRQ number on the device page adapter property sheet is ignored.

WAC Attachments

This section describes factors you should consider when configuring Personal
Communications to communicate via a Wide Area Connector (WAC) adapter.

EIB Support

All available Electrical Interface Boards (EIBs) are supported for the WAC adapter.

Supported Adapters

The IBM WAC adapters for bus types ISA and MCA are supported. Note: At this
time, the new IBM PCI bus WAC adapter is NOT supported by Personal
Communications.

Potential Configuration Issues

When configuring both ports (upper and lower) on a single WAC adapter, you must
create two logical devices, using the configuration utility. Be careful to configure the
same Shared Ram Address for both devices, using the same adapter number. If
you do not do this, the Shared Ram Address for the first device activated will be
used for the second device.

For ISA systems, the adapter number is obtained from the interpretation of the
on-board DIP switch settings. Switches 1-3 determine the Interrupt level, and
switches 4-7 (read in reverse order) determine the adapter number. Please consult
the adapter installation publication for additional information. Adapter numbers 0
and 1 are logically the same. This is also true for adapter numbers 8 and 9.

On some IBM ValuePoint systems, intermittent problems can occur. If you are using
one of these systems and are having problems, ensure that the adapter’s DIP
switch settings are such that Interrupt Level 9 is being used.

If you intend to use the WAC adapter in a system and you also plan on using
Hayes AutoSync function, then you might experience problems with your async
connection. To find appropriate Shared Memory values, you should use the adapter
diagnostic disk provided with the adapter.

For MCA systems, the adapter number is the slot number in which the adapter
physically resides. You can easily obtain this number via the MCA Configuration
utility that was provided with your system. For IBM systems, you can determine this
number by looking at the back of the system unit and providing the number
displayed for the selected slot.

System Resources

The Wide Area Connector adapter utilizes the following system resources per each
adapter installed:
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v 32 bytes of IO addresses (differs depending upon the adapter number used on
ISA; see help on the configuration panel for additional information, or via MCA
adapter config.)

v Interrupt level (1 level can be used on MCA if all adapters share the same, ISA
adapters must have unique interrupt numbers.)

v 16KB of shared memory

For ISA adapters, you should consult your WAC installation publication for
information concerning the IRQ used and the adapter number configured, both of
which are configured via the adapter’s DIP switches.

3174 Peer Communications Support (Lan over Coax)

The Lan over Coax function provides peer-to-peer communication for workstations
connected to an IBM 3174 Control Unit via an IBM 3270 communication adapter. It
provides support for any NDIS protocol stack capable of utilizing the IEEE 802.5
(Token Ring) frame format such as IEEE 802.2 (SNA), Netbios, TCP/IP, or LLC2.

Installation

To install the 3174 Peer Communications Adapter Support, from the Network
Control Panel, choose to install a new adapter, and, when prompted, select the
Have Disk option, and direct the installation program to the XLNCOAX subdirectory in
the Personal Communications installation directory.

The .INF file will install the new adapter support and bind the adapter to all valid
protocol stacks. To utilize the new adapter, after installing and rebooting, configure
Personal Communications to utilize a LAN adapter, and enter the adapter number
that corresponds to the 3174 Peer Communications adapter number found under
the LLC Protocol for this adapter. The 3174 Peer Communications RPQ is also
required on the 3174.

Configuration

Configure by using the Network Control Panel’s Properties button for the selected
adapter.

Options
Network Address

Overrides the burned in adapter address.

Queued Transmits
Number of queued transmit elements to support.

Slot Number
Required for MCA bus systems, not applicable to others; indicates the
adapter to use in a specific MCA slot.

On Micro Channel workstations, you can use up to 4 type-B 3270 Connection
Adapters (but only 1 type A). When you configure Personal Communications, you
must specify the physical slot in which each adapter is installed.
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System Resources

On ISA Bus systems, the following system resources are used:

v Interrupt Level 2

v IO address 0x2d0 through 0x2df

v Shared memory address 0xce000

These resources are not changeable. On MCA systems, these resources are
configured via the MCA adapter configuration, with the exception for the Interrupt
number, which is Interrupt 2.

Multiple Adapter Coexistence

If you use type-B adapters, you can use one or more for DFT connections
concurrently with 3174 Peer Communications. If you want to do this, the Peer
Communications adapter(s) must be in higher-numbered slots than the DFT
adapter(s) because DFT connections will, by design, use the first adapter(s) they
find, searching from slot 1.

Twinaxial Console

You can configure Personal Communications to act as the console for an AS/400. If
you want to use full-function 5250 emulation, you must not use the console
attachment; you must use Twinaxial Data Link Control (APPC).

Restrictions:

v The Setup API functions of the File menu cannot be used.

v Copy is the only editing function available.

v The file transfer function cannot be used.

v The session type cannot be set to Printer. (AS/400)

v Multiple console sessions cannot be used.

v The Enhanced Non-programmable Terminal User Interface (ENPTUI) cannot be
transferred from the host system.

v The PC Organizer cannot be used.

v The screen size is always 24 x 80, even if 27 x 132 is specified.

v The cursor position cannot be moved by the mouse.

Asynchronous Console

For the asynchronous console attachment, you must have a 2609 or 2612 adapter
for the Multiple Function I/O Processor (MFIOP) on the AS/400 system. This
connection also requires a special cable. The part numbers for the cables are
46G0450 (6m) and 46G0479 (2.5m).
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Note

The AS/400 Advanced Portable Model P02 does not support the
asynchronous console attachment.

Restrictions for Asynchronous Console Sessions

An asynchronous console has the following restrictions:

v Multiple console sessions cannot be used.

v APIs are not supported

v The session type cannot be set to the Printer .

v The file transfer functions is not supported.

v The PC Organizer cannot be used.

Adapter Setup Hints and Tips

The following sections describe how to configure adapters, including PCMCIA and
PCI cards.

Using Coax (3270) Adapters

Personal Communications supports IBM AT-bus, Micro Channel (MCA), and Plug
and Play coax adapters; the configuration of each is described in the following
sections.

3278/79 Emulation Adapter (AT-Bus)

This adapter has a fixed I/O-port address and interrupt level (IRQ), but you have to
set the memory address, which you can do only through the Personal
Communications configuration.

The buffer address must be set. The default is CE000. If you happen to know that
this address is already being used by another device, you should change it, but,
when you first try to connect, Personal Communications will check the registry to
find an available address anyway.

IBM 3270 Connection Adapter (Micro Channel)

Micro Channel adapters need the same types of resource as AT-bus but
configuration is much easier because the resources are all set by the workstation’s
hardware configuration and Personal Communications is able to read them.

Configure Personal Communications in the normal way. The default buffer address
will be the one set in the system configuration. You should not change it.
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Plug and Play Adapters

Configure Personal Communications in the normal way; you will notice that the Plug
and Play radio button is active and that you do not have to configure the buffer
address.

The first time that you insert the 3270 Emulation Credit Card Adapter into a
PCMCIA slot or start your PC with the PCI card installed, Windows 95/98 will
prompt you for the location of the card’s driver. The driver (IBM3270.INF) is located
in the directory where Personal Communications is installed.

Note

Removing the card while you have an active connection will have
unpredictable results.

3270 ISA-Bus and MCA Adapters and ROM Shadowing

These adapters use 8Kb of workstation memory; the default values for the memory
addresses are as follows:

v Adapter #0 CE000h - CFFFFh

v Adapter #1 D0000h - D1FFFh

v Adapter #2 D2000h - D3FFFh

v Adapter #3 D4000h - D5FFFh

Some types of workstation may use these areas, by default, for ROM shadowing in
BIOS (the IBM PC350 for example). You should check the ROM-shadowing settings
before installing an adapter, and disable the range that will be used by the adapter
that you are going to install.

OEM Adapters

Personal Communications has an open API that enables vendors and Other
Equipment Manufacturers (OEMs) to provide adapter cards that allow for additional
connectivity options, for example, additional X.25, ISDN, SDLC. or twinax support.
After installing the OEM adapter, you can begin to configure it in the usual manner
described in “Creating a Configuration” on page 25. However, at some point in the
configuration process you may need to provide information required by the
manufacturer of the OEM adapter card.

Using Twinax (5250) Adapters

Personal Communications supports AT-bus, Micro Channel, PCI, and PCMCIA
twinax adapters; the configuration of each is described in the following sections. All
the IBM adapters are supported; OEM adapters are supported if their manufacturer
has created a device driver that is compatible with the IBM driver.
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AT-Bus Adapters

The adapters have switches that allow you to set the I/O port address. You also
have to set the memory address and the interrupt level (IRQ) but you can do this
only through the program that is going to use the adapter.

When you configure Personal Communications, the interrupt level, I/O-port address,
and memory address must be set. In most cases, you can use the defaults; if you
change a setting, make sure that the value does not conflict with that for another
device.

Micro Channel (MCA) and PCI Adapters

Micro Channel adapters and PCI adapters need the same types of resource as
AT-bus but configuration is much easier because the resources are all set by the
workstation’s hardware configuration, and Personal Communications is able to read
them.

Configure Personal Communications in the normal way; you will see that the three
adapter configuration fields are grayed out. No configuration is required.

These adapters may not be able to register themselves with Windows NT, so you
may not see them in Device Manager.

IBM 5250 PCI Emulator Adapter

If you experience problems getting a host connection with the 5250 Emulation PCI
Adapter and you have an IBM PC, upgrading your PC’s BIOS might solve the
problem. You can find the date of your system’s BIOS by going into your system
setup when you boot your PC. Then you can look on the Internet to see if there is a
later version for your PC. The IBM File Library WEB site that has the latest BIOS
upgrade files is located at: www.pc.ibm.com/listfiles.html

From here you can search for your specific IBM PC. If there is a flash BIOS
upgrade date later than that on your PC, download the file to your PC and follow
the instructions that come with the file. For non-IBM PCs, contact the manufacturer
of your PC for BIOS upgrade information.
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Appendix C. AS/400 Configuration Examples

To connect to an AS/400 system, you need to specify configuration information in
the workstation profile that accurately corresponds to the information specified in
the AS/400 system (referred to as the device description).

For example, the LAN attachment via IEEE 802.2 in the following figure shows how
the configuration information specified in the AS/400 workstation profile corresponds
to the configuration information in the AS/400 system.

AS/400 PC400

Network Attribute
Local Network ID
Local Location Name

Line Description
Local Adapter Address
Source Service Access Point (SSAP)

Controller Description
Controller Category (*APPC)
Remote Network ID
Remote Control Point
LAN Remote Adapter Address
(PC LAN Adapter Address)

LAN DSAP
LAN SSAP

Device Description
Device Category (*APPC)
Remote Location
Remote Network ID Code
APPN available (*YES)

Configure Communication

Session Type
Host Code Page
System Location Name

Field 1
Field 2

PC Location Name
Field 1
Field 2

Workstation ID
Device Description

Device Category (*DSP, *PRT)
Device Type (3197/3477, 3812)
Device Class (*VRT)
Device Format (C1/FC,1)
Keyboard Language Type (USB)
Character Identifier (697 037)

Configure Link
(LAN via IEEE 802.2)

Destination Address
Remote SAP

(Select Advanced)

Local SAP

© Copyright IBM Corp. 1989, 1999 107



AS/400 Device Description

To configure 5250 display or printer sessions, the following values must be set in
the AS/400 device description:

AS/400 Device
Description

Display Session

Printer Session24 x 80 27 x 132

Device category *DSP *DSP *PRT

Device class *VRT *VRT *VRT

Device type 3197 3477 3812

Device model C1 FC 1

Keyboard language
type

USB+ USB+ -

Character identify
code

697 037+ 697 037+ -

: + For SBCS, depends on the host code page selection.

The following table applies to DBCS only.

AS/400 Device Description

Display Session Printer
SessionHost Code Page

931
Host Code Page

939

Device category *DSP *PRT

Device class *VRT *VRT

Device type 5555 5555

C01 C01

JUB JPB -

Character identify code 101 037 -

DBCS device feature 2424J0 2424J0 2424J0

5250 Sessions through One Link

If you want all your 5250 sessions to connect through one link to an AS/400
system, use the same PC Location Name and the same Link Parameters for all
the sessions.

For example, you can configure two display sessions and one printer session
connected to an AS/400 system using APPN.PC5250 as the Location Name .

AS/400 Device Description
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Session A : Session Type : Display
(Display) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : (not specified)

Session B : Session Type : Display
(Display) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : (not specified)

Session C : Session Type : Printer
(Printer) System Location Name : APPN.S7801234

PC Location Name : APPN.PC5250
Workstation ID : PCLOCALP1

In this example, the AS/400 network attributes are:

Local network ID : APPN
Local location : S7801234

Tip

Enter DSPNETA from a 5250 session to display AS/400 network
attributes.

AS/400 System Mode Description

PC400 initially uses mode description QPCSUPP on the AS/400 system. If the PC
Support/400 program or Client Access/400 is installed on the AS/400 system,
QPCSUPP need not be created. If mode description QPCSUPP does not exist on
the AS/400 system, create the mode description:

1. Enter the following command on the command line of the main menu of the
AS/400 system:

CRTMODD

The Creating Mode Description panel appears.

AS/400 Device Description
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Creating Mode Description (CRTMODD)

Type the selected items, and push the Enter key.

Mode Description................. Name
Maximum Session.................. 8 1-512
Maximum number of interaction.... 8 1-512
Number of Local Control Sessions. 4 0-512
Number of Pre-joined Sessions.... 0 0-512
Inbound Pacing Value............. 7 0-63
Outbound Pacing Value............ 7 0-63
Maximum Length of Request Unit... *CALC 241-16384, *CALC
Text Description ................ *BLANK

End
F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

2. Type the necessary values in each field, according to the following table.

Field Name Input Value

Mode description QPCSUPP

Maximum session 64

Maximum number of interactions 64

Number of local control sessions 0

Number of pre-joined sessions 0

Inbound pacing value 7

Outbound pacing value 7

Maximum length of request unit *CALC

Text description This field is optional

3. After you type all the values, press the Enter key.

This completes the creation of the mode description QPCSUPP.

AS/400 Device Description for Twinaxial Attachments (APPC) Example

If you want to use a twinaxial (TDLC) attachment, the AS/400 system requires that
you specify a device description. When the automatic device configuration indicator
(QAUTOCFG) is set to ON in the AS/400 system, the device description is created
automatically. When the indicator is set to OFF, create the device description, as
follows:

1. Enter the following command on the command line of the AS/400 system main
menu:
CRTDEVDSP

The Creating Device Description (Display) panel appears.

AS/400 System Mode Description
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Creating Device Description(Display) (CRTDEVDSP)

Type the selected item, and push Enter key.

Device Description... Name
Device Class.......... *LCL, *RMT, *VRT, *SNPT
Device Type........... 3101, 3151, 3161, 3162...
Device Format........ 0, 1, 2, 4, 11, 12, 23...

End
F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

2. Type the values in each field, according to the following table.

Field Name Input Value

Device description This is an optional field

Device class *LCL

Device type 5150

Device format 2

3. After you type all values, press the Enter key.

The following screen appears:

Creating Device Description(Display) (CRTDEVDSP)

Type the selected item, and push Enter key.

Device Description..........>TWXP0A1 Name
Device Class................>*LCL *LCL, *RMT, *VRT, *SNPT
Device Type.................>5150 3101, 3151, 3161, 3162...
Device Format...............>2 0, 1, 2, 4, 11, 12, 23...
Port Number................. 0-17
Switch Setting.............. 0, 1, 2, 4, 5, 6
Online when IPL.............>*YES *YES, *NO
Controller to be attached... Name
Keyboard Word Type..........>*SYSVAL *SYSVAL,AGB,AGI,BLI...
Text Description............>*BLANK

F3=Exit F4=Prompt F5=Reshow F10=Add parameter F12= Cancel
F13=How to use this panel F24=More key

4. Type the values for each field, according to the following table.

Field Name Input Value

Port number Number of the port to be attached

Switch setting Device address

Controller to be attached Descriptive name of the controller to be attached
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Field Name Input Value

Keyboard word type USB1

: 1 Depends on the host code page selection.

5. After you enter all the values, press the Enter key.

This completes the creation of the device description for the twinaxial
attachment.

AS/400 Device Description for Asynchronous Attachment Example

If you want to use an asynchronous dial attachment, the AS/400 system requires
that you specify configuration parameters for the controller/line/devices to be used.

The following sample is a typical configuration on the AS/400 system for an
asynchronous dialed connection through an ASCII Workstation Controller.

1. Enter the following command on the command line of the AS/400 system main
menu:
WRKCFGSTS *CTL CTL03

where CTL03 is the name of your controller.

The Work with Configuration Status panel appears.

Work with Configuration Status

Position to . . . . . _____________ Starting characters

Type options, press Enter
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9-Display mode status ...

Opt Description Status -------------Job--------------
8_ CTL03 ACTIVE
__ ADLCTST VARY ON PENDING
__ ASYNC VARY ON PENDING
__ ASYNCD VARY ON PENDING
__ EZASYNC VARY ON PENDING
__ ASYNCP0 VARY ON PENDING
__ ASYNRTR ACTIVE

BOTTOM
Parameters or command
===>

F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys

2. Enter 8 in the Opt field to work with the controller description for CTL03.

The Work with Controller Descriptions panel appears.

Twinaxial Attachments
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Work with Controller Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source 12=Print device addresses

Opt Controller Type Text
2_ CTL03 6141 CREATED BY AUTO-CONFIGURATION

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

3. Enter 2 in the Opt field to change the controller description for CTL03.

The Change Controller Description panel appears.

Change Ctl Desc (local WS) (CHGCTLLWS)

Controller Description . . . . . . : CTL03
Option . . . . . . . . . . . . . . : *BASIC
Category of controller . . . . . . : *LWS

Controller type . . . . . . . . . : 6141
Controller model . . . . . . . . . : 1
Resource name . . . . . . . . . . : CTL03
TDLC line . . . . . . . . . . . . : QTDL429000
Online at IPL . . . . . . . . . . : *YES
Auto-configuration controller . . : *YES
Text . . . . . . . . . . . . . . . : CREATED BY AUTO-CONFIGURATION
Device wait timer . . . . . . . . : 10

Press Enter to continue.
===>

BOTTOM
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

4. Type the values in each field, according to the following table.

Field Name Input Value

Controller description CTL03

Resource name CTL03

Online at IPL *YES

Device wait timer 10

Auto-configuration controller *YES

Text description This field is optional

The Work with Controller Descriptions panel appears.
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Work with Controller Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source 12=Print device addresses

Opt Controller Type Text
8_ CTL03 6141 Created by auto-configuration

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

5. Enter 8 in the Opt field to work with the configuration status.

The Work with Configuration Status panel appears.

Work with Configuration Status

Position to . . . . . _____________ Starting characters

Type options, press Enter
1=Vary on 2=Vary off 5=Work with job 8=Work with description
9-Display mode status ...

Opt Description Status -------------Job--------------
__ CTL03 ACTIVE
__ ADLCTST VARY ON PENDING
__ ASYNCPERTH VARY ON PENDING
__ ASYNCD VARY ON PENDING
__ EZASYNC VARY ON PENDING
__ ASYNCP0 VARY ON PENDING
8_ ASYNRTR ACTIVE

BOTTOM
Parameters or command
===>

F3=Exit F4=Prompt F12=Cancel F23=More options F24=More keys

6. Enter 8 in the Opt field next to ASYNRTR to work with the display device
description.

The Work with Device Descriptions panel appears.
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Work with Device Descriptions

Position to . . . . . _____________ Starting characters

Type options, press Enter
2=Change 3=Copy 4=Delete 5=Display 6=Print 7=Rename
8=Work with status 9=Retrieve source

Opt Controller Type Text
2_ ASYNRTR 5150 FOR PC400

BOTTOM
Parameters or command
===>
F3=Exit F4=Prompt F5=Refresh F6=Create F9=Retrieve F12=Cancel
F14=Work with status

7. Enter 2 in the Opt field to change the device description.

The Change Device Description panel appears.

Change Device Desc (Display) (CHGDEVDSP)

Type choices, press Enter.

Device description . . . . . . . . > ASYNRTR Name
Port number . . . . . . . . . . . 4 0-17, *SAME
Switch setting . . . . . . . . . . 0 0-6, *SAME
Online at IPL . . . . . . . . . . *YES *SAME, *YES, *NO
Keyboard language type . . . . . . USI *SAME, *SYSVAL, *NONE, AGB...

Character identifier:
Graphic character set . . . . . *KBDTYPE 1-32767, *KBDTYPE, *SYSVAL...
Code page . . . . . . . . . . . 1-32767

Allow blinking cursor . . . . . . *YES *SAME, *YES, *NO
Print device . . . . . . . . . . . *SYSVAL Name, *SAME, *SYSVAL
Output queue . . . . . . . . . . . *DEV Name, *SAME, *DEV

Library . . . . . . . . . . . . Name, *LIBL, *CURLIB
Printer file . . . . . . . . . . . QSYSPRT Name, *SAME

Library . . . . . . . . . . . . *LIBL Name, *LIBL, *CURLIB
More...

Press Enter to continue.
===>
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

This completes the creation of the controller and display device descriptions for
an asynchronous dial attachment.

AS/400 VT Asynchronous Attachment Example

The following sample is a typical configuration on the AS/400 system for a VT
asynchronous dialed connection through an ASCII Workstation Controller. For more
details on AS/400 for VT asynchronous attachments, refer to the AS/400 ASCII
Workstation Reference (SA41-3130-00).

1. Enter the following command on the command line of the AS/400 system main
menu:

CRTDEVDSP
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The Create Device Description panel appears, in a first and second screen, as
shown for the configuration of a VT100 device below. When filling in the panel,
make sure that the name of the attached controller (arbitrarily shown as CTL05
here) matches the name of the twinaxial controller configured on your AS/400.

Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Device description . . . . . . . > VT100 Name
Device class . . . . . . . . . . > *LCL *LCL, *RMT, *VRT, *SNPT
Device type . . . . . . . . . . > V100 3101, 3151, 3161, 3162...
Device model . . . . . . . . . . > *ASCII 0, 1, 2, 4, 5, 12, 23 ...
Emulated twinaxial device . . . > *TYPE 3196A2, 3197D2, *TYPE
Port number . . . . . . . . . . > 1 0-17
Emulating ASCII device . . . . . > *NO *NO, *YES
Physical attachment . . . . . . > *MODEM *DIRECT, *PTT, *MODEM...
Online at IPL . . . . . . . . . > *YES *YES, *NO
Attached controller . . . . . . > CTL05 Name
Keyboard language type . . . . . > USB *SYSVAL, AGB, AGI, ALI...
Inactivity timer . . . . . . . . > *NOMAX 1-30, *ATTACH, *NOMAX...
Line speed . . . . . . . . . . . > 19200 *TYPE, *CALC, 150, 300...
Word length . . . . . . . . . . > 8 *TYPE, *CALC, 7, 8
Type of parity . . . . . . . . . > *NONE *TYPE, *CALC, *EVEN, *ODD...
Stop bits . . . . . . . . . . . > 2 *TYPE, 1, 2

More...
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Text 'description' . . . . . . . > 'dec vt100 device description test'

Additional Parameters
Character identifier:
Graphic character set . . . . > *KBDTYPE 1-32767, *SYSVAL, *KBDTYPE
Code page . . . . . . . . . . 1-32767

Print device . . . . . . . . . . > *SYSVAL Name, *SYSVAL
Output queue . . . . . . . . . . > *DEV Name, *DEV

Library . . . . . . . . . . . Name, *LIBL, *CURLIB
Printer file . . . . . . . . . . > QSYSPRT Name

Library . . . . . . . . . . . > *LIBL Name, *LIBL, *CURLIB

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

2. Here is a similar configuration for a VT220.

Use the same command, CRTDEVDSP, on the command line of the AS/400
system main menu. Again, the same kind of panels appear. You must make
sure that the name of the attached controller matches the name of the twinaxial
controller configured on your AS/400.
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Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Device description . . . . . . . VT220 Name
Device class . . . . . . . . . . > *LCL *LCL, *RMT, *VRT, *SNPT
Device type . . . . . . . . . . > V220 3101, 3151, 3161, 3162...
Device model . . . . . . . . . . > *ASCII 0, 1, 2, 4, 5, 12, 23
Emulated twinaxial device . . . > *TYPE 3196A2, 3197D2, *TYPE
Port number . . . . . . . . . . > 2 0-17
Emulating ASCII device . . . . . > *NO *NO, *YES
Physical attachment . . . . . . > *MODEM *DIRECT, *PTT, *MODEM...
Online at IPL . . . . . . . . . > *YES *YES, *NO
Attached controller . . . . . . > CTL05 Name
Keyboard language type . . . . . > USB *SYSVAL, AGB, AGI, ALI...
Inactivity timer . . . . . . . . > *NOMAX 1-30, *ATTACH, *NOMAX...
Line speed . . . . . . . . . . . > 19200 *TYPE, *CALC, 150, 300...
Word length . . . . . . . . . . > 8 *TYPE, *CALC, 7, 8
Type of parity . . . . . . . . . > *NONE *TYPE, *CALC, *EVEN, *ODD...
Stop bits . . . . . . . . . . . > 1 *TYPE, 1, 2

More...
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Create Device Desc (Display) (CRTDEVDSP)

Type choices, press Enter.

Text 'description' . . . . . . . > 'dec vt220 device description test'

Additional Parameters

Character identifier:
Graphic character set . . . . > *KBDTYPE 1-32767, *SYSVAL, *KBDTYPE
Code page . . . . . . . . . . 1-32767

Print device . . . . . . . . . . > *SYSVAL Name, *SYSVAL
Output queue . . . . . . . . . . > *DEV Name, *DEV
Library . . . . . . . . . . . Name, *LIBL, *CURLIB

Printer file . . . . . . . . . . > QSYSPRT Name
Library . . . . . . . . . . . > *LIBL Name, *LIBL, *CURLIB

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

AS/400 Configuration for SDLC Example

The following examples refer to SDLC and Hayes AutoSync:

Network Attributes

To display the network attributes for the AS/400 to which you are connecting, enter
the command dspneta on the AS/400 Main Menu.
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MAIN AS/400 Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access tasks

90. Sign off

Selection or command
===> dspneta

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press Enter.

The Display Network Attributes screen is displayed.

Display Network Attributes

System: RALYAS4B
Current system name . . . . . . . . . . . . . . : RALYAS4B

Pending system name . . . . . . . . . . . . . :
Local network ID . . . . . . . . . . . . . . . . : USIBMRA
Local control point name . . . . . . . . . . . . : RALYAS4B
Default local location . . . . . . . . . . . . . : RALYAS4B
Default mode . . . . . . . . . . . . . . . . . . : BLANK
APPN node type . . . . . . . . . . . . . . . . . : *NETNODE
Data compression . . . . . . . . . . . . . . . . : *NONE
Intermediate data compression . . . . . . . . . : *NONE
Maximum number of intermediate sessions . . . . : 200
Route addition resistance . . . . . . . . . . . : 128
Server network ID/control point name . . . . . . : *LCLNETID *ANY

More...
Press Enter to continue.

F3=Exit F12=Cancel

The network attributes include the AS/400 Network ID and CP name.

SDLC Leased Configuration

Several descriptions must be created on the AS/400; examples are given below.

Creating a SDLC Line Description

To create an SDLC leased line description, enter the command crtlinsdlc on the
AS/400 Main Menu.
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MAIN AS/400 Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access tasks

90. Sign off

Selection or command
===> crtlinsdlc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt).

The Create LIne Description panel is displayed. Enter the values for each
parameter on the panel.

Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Line description . . . . . . . . > PCOMMSDLCL Name
Resource names . . . . . . . . . > LIN021 Name

+ for more values
Online at IPL . . . . . . . . . *YES *YES, *NO
Data link role . . . . . . . . . *NEG *NEG, *PRI, *SEC
Physical interface . . . . . . . *RS232V24 *RS232V24, *V35, *X21, ...
Connection type . . . . . . . . *NONSWTPP *NONSWTPP, *SWTPP, *MP, *SHM
Switched network backup . . . . *NO *NO, *YES
Exchange identifier . . . . . . *SYSGEN 05600000-056FFFFF, *SYSGEN
NRZI data encoding . . . . . . . *YES *YES, *NO
Line speed . . . . . . . . . . . 9600 600, 1200, 2400, 4800...
Modem type supported . . . . . . *NORMAL *NORMAL, *V54, *IBMWRAP...
Maximum frame size . . . . . . . 521 265, 521, 1033, 2057
Duplex . . . . . . . . . . . . . *HALF *HALF, *FULL
Inactivity timer . . . . . . . . 300 *NOMAX, 150-4200 (0.1 sec)
Poll response delay . . . . . . 0 0-2048 (0.0001 seconds)

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Nonproductive receive timer . . 320 160-4200 (0.1 seconds)
Idle timer . . . . . . . . . . . 30 5-300 (0.1 seconds)
Connect poll timer . . . . . . . 30 2-300 (0.1 seconds)
Poll cycle pause . . . . . . . . 0 0-2048 (0.0001 seconds)
Frame retry . . . . . . . . . . 7 0-64
Text 'description' . . . . . . . PCOMM SDLC leased line

Additional Parameters

Attached nonswitched ctls . . . Name
+ for more values

Modem data rate select . . . . . *FULL *FULL, *HALF
Error threshold level . . . . . *OFF *OFF, *MIN, *MED, *MAX
Modulus . . . . . . . . . . . . 8 8, 128
Maximum outstanding frames . . . 7 1-28

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter to save the line description pcommsdlcl.

SDLC Controller Description

To create the SDLC controller description for the line PCOMMSDLCL, enter
crtctlappc on the AS/400 Main Menu.

MAIN AS/400 Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access tasks

90. Sign off

Selection or command
===> crtctlappc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt). The Create Controller Description panel is displayed. Enter
values for each parameter on the following two panels.
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Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

Controller description . . . . . > PCOMMSDLCL Name
Link type . . . . . . . . . . . > *SDLC *ANYNW, *FAX, *FR, *IDLC...
Online at IPL . . . . . . . . . *YES *YES, *NO
Switched connection . . . . . . *NO *NO, *YES
Switched network backup . . . . *NO *NO, *YES
APPN-capable . . . . . . . . . . *YES *YES, *NO
Attached nonswitched line . . . > PCOMMSDLCL Name
Maximum frame size . . . . . . . *LINKTYPE 265-16393, 256, 265, 512...
Remote network identifier . . . > USIBMRA Name, *NETATR, *NONE, *ANY
Remote control point . . . . . . > PCOMMCP Name, *ANY
Exchange identifier . . . . . . 00000000-FFFFFFFF
Data link role . . . . . . . . . *NEG *NEG, *PRI, *SEC
Station address . . . . . . . . C1 00-FE
APPN CP session support . . . . *NO *YES, *NO
APPN node type . . . . . . . . . *LENNODE *ENDNODE, *LENNODE...
APPN transmission group number 1 1-20, *CALC

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

Autocreate device . . . . . . . *ALL *ALL, *NONE
Autodelete device . . . . . . . 1440 1-10000, *NO
User-defined 1 . . . . . . . . . *LIND 0-255, *LIND
User-defined 2 . . . . . . . . . *LIND 0-255, *LIND
User-defined 3 . . . . . . . . . *LIND 0-255, *LIND
Text 'description' . . . . . . . PCOMM SDLC Leased

Additional Parameters

Attached devices . . . . . . . . Name
+ for more values

Character code . . . . . . . . . *EBCDIC *EBCDIC, *ASCII
SSCP identifier . . . . . . . . 000000000001-FFFFFFFFFFFF
IDLC window size . . . . . . . . *LIND 1-31, *LIND
IDLC frame retry . . . . . . . . *LIND 0-100, *LIND

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter.

The APPC Device Description will create itself automatically.

SDLC Switched Configuration

The following examples contain information about the SDLC switched configuration
on the AS/400.

SDLC Line Description

To create an SDLC switched line definition on the AS/400, enter the command
crtlinsdlc on the AS/400 Main Menu.
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MAIN AS/400 Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access tasks

90. Sign off

Selection or command
===> crtlinsdlc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt).

The Create Ctl Description panel is displayed. Enter values for each parameter on
the panel.

Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Line description . . . . . . . . > PCOMSDLCSW Name
Resource names . . . . . . . . . > LIN051 Name

+ for more values
Online at IPL . . . . . . . . . *YES *YES, *NO
Data link role . . . . . . . . . > *PRI *NEG, *PRI, *SEC
Physical interface . . . . . . . *RS232V24 *RS232V24, *V35, *X21, ...
Connection type . . . . . . . . > *SWTPP *NONSWTPP, *SWTPP, *MP, *SHM
Vary on wait . . . . . . . . . . *NOWAIT *NOWAIT, 15-180 (1 second)
Autocall unit . . . . . . . . . *NO *NO, *YES
Exchange identifier . . . . . . *SYSGEN 05600000-056FFFFF, *SYSGEN
NRZI data encoding . . . . . . . *YES *YES, *NO
Line speed . . . . . . . . . . . 9600 600, 1200, 2400, 4800...
Modem type supported . . . . . . *NORMAL *NORMAL, *V54, *IBMWRAP...
Switched connection type . . . . *BOTH *BOTH, *ANS, *DIAL
Autoanswer . . . . . . . . . . . *YES *YES, *NO
Autodial . . . . . . . . . . . . *NO *NO, *YES

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Create Line Desc (SDLC) (CRTLINSDLC)

Type choices, press Enter.

Calling number . . . . . . . . . *NONE
Connect poll retry . . . . . . . 7 0-64
Maximum frame size . . . . . . . 521 265, 521, 1033, 2057
Duplex . . . . . . . . . . . . . *HALF *HALF, *FULL
Nonproductive receive timer . . 320 160-4200 (0.1 seconds)
Idle timer . . . . . . . . . . . 30 5-300 (0.1 seconds)
Connect poll timer . . . . . . . 30 2-300 (0.1 seconds)
Poll cycle pause . . . . . . . . 0 0-2048 (0.0001 seconds)
Frame retry . . . . . . . . . . 7 0-64
Data Set Ready drop timer . . . 6 3-60 (seconds)
Autoanswer type . . . . . . . . *DTR *DTR, *CDSTL
Remote answer timer . . . . . . 60 30, 35, 40, 45 (seconds)...
Text 'description' . . . . . . . PCOMM SDLC switched line

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter to save the description pcomsdlcsw.

SDLC Controller Description

To create the controller description for the switched SDLC line, enter crtctlappc on
the AS/400 Main Menu.

MAIN AS/400 Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access tasks

90. Sign off

Selection or command
===> crtctlappc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt).

The Create Controller Description panel is displayed. Enter values for each
parameter on the panel.
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Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

Controller description . . . . . > PCOMSDLCSW Name
Link type . . . . . . . . . . . > *SDLC *ANYNW, *FAX, *FR, *IDLC...
Online at IPL . . . . . . . . . *YES *YES, *NO
Switched connection . . . . . . > *YES *NO, *YES
Short hold mode . . . . . . . . *NO *NO, *YES
APPN-capable . . . . . . . . . . *YES *YES, *NO
Switched line list . . . . . . . > PCOMSDLCSW Name

+ for more values
Maximum frame size . . . . . . . *LINKTYPE 265-16393, 256, 265, 512...
Remote network identifier . . . *NETATR Name, *NETATR, *NONE, *ANY
Remote control point . . . . . . > JO Name, *ANY
Exchange identifier . . . . . . > 00000000 00000000-FFFFFFFF
Initial connection . . . . . . . > *ANS *DIAL, *ANS
Connection number . . . . . . . > 123
Data link role . . . . . . . . . > *SEC *NEG, *PRI, *SEC
Station address . . . . . . . . 01 00-FE

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

APPN CP session support . . . . *NO *YES, *NO
APPN node type . . . . . . . . . *LENNODE *ENDNODE, *LENNODE...
APPN transmission group number 1 1-20, *CALC
APPN minimum switched status . . *VRYONPND *VRYONPND, *VRYON
Autocreate device . . . . . . . *ALL *ALL, *NONE
Autodelete device . . . . . . . 1440 1-10000, *NO
User-defined 1 . . . . . . . . . *LIND 0-255, *LIND
User-defined 2 . . . . . . . . . *LIND 0-255, *LIND
User-defined 3 . . . . . . . . . *LIND 0-255, *LIND
Text 'description' . . . . . . . PCOM SDLC switched line

Additional Parameters

Attached devices . . . . . . . . Name
+ for more values

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys

Press Enter to save the controller description pcomsdlcsw.

The APPC Device Description will create itself automatically once Personal
Communications attaches to the AS/400 using the line and controller descriptions
that were just created.

LAN Configuration Example

This example assumes that a line description (token-ring or Ethernet) is already in
place. This is a shared configuration object—all connections on that adapter will use
the same line description. In the configuration example shown, the line description
name is TRN2619.
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LAN Controller Description

The normal method would be to let the APPC controller create itself automatically.
However, if preferred, the following command can be used to manually create the
APPC controller.

To create a LAN controller description, enter crtctlappc on the AS/400 Main Menu.

MAIN AS/400 Main Menu
System: RALYAS4B

Select one of the following:

1. User tasks
2. Office tasks
3. General system tasks
4. Files, libraries, and folders
5. Programming
6. Communications
7. Define or change the system
8. Problem handling
9. Display a menu
10. Information Assistant options
11. Client Access tasks

90. Sign off

Selection or command
===> crtctlappc

F3=Exit F4=Prompt F9=Retrieve F12=Cancel F13=Information Assistant
F23=Set initial menu

Press F4 (Prompt). The Create Controller Description panel will be displayed.

Enter values for each parameter on the panel.

Create Ctl Desc (APPC) (CRTCTLAPPC)

Controller description . . . . . > PCOMMLAN Name
Link type . . . . . . . . . . . > *LAN *ANYNW, *FAX, *FR, *IDLC...
Online at IPL . . . . . . . . . *YES *YES, *NO
APPN-capable . . . . . . . . . . *YES *YES, *NO
Switched line list . . . . . . . > TRN2619 Name

+ for more values
Maximum frame size . . . . . . . *LINKTYPE 265-16393, 256, 265, 512...
Remote network identifier . . . *NETATR Name, *NETATR, *NONE, *ANY
Remote control point . . . . . . > PEPE Name, *ANY
Exchange identifier . . . . . . 00000000-FFFFFFFF
Initial connection . . . . . . . *DIAL *DIAL, *ANS
Dial initiation . . . . . . . . *LINKTYPE *LINKTYPE, *IMMED, *DELAY
LAN remote adapter address . . . 400052005109 000000000001-FFFFFFFFFFFF
APPN CP session support . . . . *NO *YES, *NO
APPN node type . . . . . . . . . *LENNODE *ENDNODE, *LENNODE...
APPN/HPR capable . . . . . . . . *YES *YES, *NO

More...
F3=Exit F4=Prompt F5=Refresh F12=Cancel F13=How to use this display
F24=More keys
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Create Ctl Desc (APPC) (CRTCTLAPPC)

Type choices, press Enter.

APPN transmission group number 1 1-20, *CALC
APPN minimum switched status . . *VRYONPND *VRYONPND, *VRYON
Autocreate device . . . . . . . *ALL *ALL, *NONE
Autodelete device . . . . . . . 1440 1-10000, *NO
User-defined 1 . . . . . . . . . *LIND 0-255, *LIND
User-defined 2 . . . . . . . . . *LIND 0-255, *LIND
User-defined 3 . . . . . . . . . *LIND 0-255, *LIND
Model controller description . . *NO *NO, *YES
Text 'description' . . . . . . . PCOMM token-ring

Bottom
F3=Exit F4=Prompt F5=Refresh F10=Additional parameters F12=Cancel
F13=How to use this display F24=More keys

Press Enter to save the controller description pcommlan.

The APPC Device Description will create itself automatically. Personal
Communications attaches to the AS/400 using the controller description that was
just created.

LAN Attachments

126 Personal Communications Quick Beginnings



Appendix D. AnyNet Configuration Examples

This section includes examples of AnyNet running SNA over IP connections. The
following configuration instructions are complete only for the Windows NT and
Windows 95 operating systems. In all examples, the SNA domain name suffix is
SNA.IBM.COM.

For more information about AnyNet as part of Personal Communications, refer to
the Personal Communications V4.3 Reference Volume II. For more information
about configuring AnyNet for any other platforms mentioned in this section (such as
VTAM or AS/400), refer to the appropriate product documentation.

Example 1. 5250 Emulation Over a TCP/IP Network

Steps

Follow these steps to establish communications between the Windows 95
workstation (Node A) and the AS/400 host (Node B).

For Windows 95 Node A, do as follows:

1. Add the following entries to the local HOSTS file:
10.1.1.1 CPNAME1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: AS/400

v Interface: AnyNet

v Attachment: TCP/IP 5250

c. Click on Configure .

d. Click on Configure Link .

e. On the Configure Local System window, enter:

CP name: NETA.CPNAME2
IP address: 10.2.1.1

IP
Network

Personal
Communications

• AnyNet SNA
over TCP/IP

Node A: Windows 95

CP name: NETA.CPNAME1
IP address: 10.1.1.1

OS/400

• AnyNet SNA
over TCP/IP

• TCP/IP

Node B: AS/400 Host
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v PC Location Name: NETA.CPNAME2

On the Configure Logical Connection Windows, enter:

v System Location Name: NETA.CPNAME1

f. Save your workstation profile.

For AS/400 Node B, add the following entry to the local HOSTS file:
10.2.1.1 CPNAME2.NETA.SNA.IBM.COM

Example 2. Running APPC or CPI-C Applications over a TCP/IP
Network

Steps

Follow these steps to establish communications between a Windows NT node and
a Windows 95 node. Note that in this example, the CP names are used as LU
names.

For Windows 95 Node A, do as follows:

1. Add the following entry to the local HOSTS file:
172.25.11.2 CP2.NETA.SNA.IBM.COM

2. Create a configuration using the Personal Communications configuration tool:

a. Click on the SNA Node Configuration icon. The Personal Communications
SNA Node Configuration window is displayed.

b. In the Configuration Options list, choose Configure Node and click on New.

c. On the Define the Node window on the Basic tab, enter:

v Fully qualified CP name: NETA.CP1

Click on OK to complete node configuration.

d. Choose Configure Devices . In the DLCs list, choose AnyNet SNA/IP and
click on New.

e. On the Define an AnyNet SNA over TCP/IP Device window on the Basic tab,
enter:

LU name: NETA.CP1
IP address: 172.25.11.1

IP
Network

Node A: Windows 95

LU name: NETA.CP2
IP address: 172.25.11.2

Node B: Windows NT

Application A

Personal
Communications

• AnyNet SNA
over TCP/IP

Application B

Personal
Communications

• AnyNet SNA
over TCP/IP

AnyNet Examples

128 Personal Communications Quick Beginnings



v SNA domain name suffix: SNA.IBM.COM

f. Click on the Routing Preferences tab:

v Default Routing Preference: Non-native only

Click on OK to complete configuration of the AnyNet device.

g. From the Personal Communications SNA Node Configuration window, click
on File . Click on Save as... and enter the desired file name to save.

For Windows NT Node B, do as follows:

1. Add the following entry to the local HOSTS file:
172.25.11.1 CP1.NETA.SNA.IBM.COM

2. Create a configuration using the Personal Communications configuration tool:

a. Click on the SNA Node Configuration icon. The Personal Communications
SNA Node Configuration window is displayed.

b. In the Configuration Options list, choose Configure Node and click on New.

c. On the Define the Node window on the Basic tab, enter:

v Fully qualified CP name: NETA.CP2

Click on OK to complete node configuration.

d. Choose Configure Devices . In the DLCs list, choose AnyNet SNA/IP and
click on New.

e. On the Define an AnyNet SNA over TCP/IP Device window on the Basic tab,
enter:

v SNA domain name suffix: SNA.IBM.COM

f. Click on the Routing Preferences tab:

v Default Routing Preference: Non-native only

Click on OK to complete configuration of the AnyNet device.

g. From the Personal Communications SNA Node Configuration window, click
on File . Click on Save as... and enter the desired file name to save.

3. Start Personal Communications on each machine.

4. Start your applications (for example APING).
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Example 3. APPC3270 Emulation over a TCP/IP Network

Steps

Follow these steps to establish communications between the VTAM host (Node A)
and the Windows 95 (Node B).

For VTAM Node A, add the following entry to the local HOSTS file:
10.2.1.2 LUNAME2.NETA.SNA.IBM.COM

For Windows 95 Node B, do as follows:

1. Add the following entry to the local HOSTS file:
10.1.1.1 LUNAME1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: S/390

v Interface: AnyNet

v Attachment: APPC3270

c. Click on Configure .

d. Click on Configure Link .

e. On the Configure Local System window, enter:

v PC Location Name: NETA.LUNAME2

f. On the Configure Logical Connection window, enter:

v System location name: NETA.LUNAME1

v Routing Preference: Non-native only

g. On the Configure AnyNet Connection window, enter:

v SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

IP
Network

VTAM

• AnyNet SNA
over TCP/IP

Node A: VTAM

Personal
Communications

• AnyNet SNA
over TCP/IP

Node B: Windows 95

LU name: NETA.LUNAME1
IP address: 10.2.1.1

LU name: NETA.LUNAME2
IP address: 10.2.1.2
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Example 4. 3270 Emulation via DLUR over a TCP/IP Network

Steps

Follow these steps to establish communications between the VTAM Host (Node A)
and the Windows 95 workstation (Node B).

For VTAM Node A, add the following entry to the HOSTS file:
192.168.7.10 CP2.NETA.SNA.IBM.COM
192.168.7.10 DEPLU1.NETA.SNA.IBM.COM

For Windows 95 Node B, do as follows:

1. Add the following entry to the local HOSTS file:
192.168.7.8 CP1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: S/390

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

c. Click on Configure .

d. Click on Configure Link .

e. On the Configure Local System window, enter:

v PC Location Name: NETA.CP2

f. On the Configure DLUR window, enter:

v DLUS name: NETA.CP1

v Routing Preference: Non-native only

g. On the Configure AnyNet Connection window, enter:

v SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

CP name: NETA.CP1
IP address: 192.168.7.8

IP
Network

VTAM

• AnyNet SNA
over TCP/IP

• DLUS

Node A: VTAM

CP name: NETA.CP2
IP address: 192.168.7.10
Dependent LU name: NETA.DEPLU1

Personal
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• DLUR
• AnyNet SNA

over TCP/IP

Node B: Windows 95
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Example 5. 3270 Emulation over a TCP/IP Network via an SNA Gateway
to a VTAM Host on an SNA Network

Steps

For OS/2 (or Windows NT) Node A, add the following entry to the HOSTS file:
172.16.5.6 CP1.NETA.SNA.IBM.COM

Follow these steps to establish communications between the Windows 95
workstation (Node B) and the VTAM host.

For Windows 95 Node B, do as follows:

1. Add the following entry to the local HOSTS file:
172.16.3.4 CP2.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: S/390

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3

c. Click on Configure .

d. Click on Configure Link .

e. On the Configure Local System window, enter:

v PC Location Name: NETA.CP1

f. On the Configure AnyNet Connection window, enter:

v SNA domain name suffix: SNA.IBM.COM

v Fully qualified CP name: NETA.CP2

g. Save your workstation profile.

CP name: NETA.CP2
IP address: 172.16.3.4

IP
Network

Communications
Server

• SNA Gateway
• AnyNet SNA

over TCP/IP

Node A: OS/2 or Windows NT

CP name: NETA.CP1
IP address: 172.16.5.6

Personal
Communications

• AnyNet SNA
over TCP/IP

Node B: Windows 95

SNAVTAM

PLU

AnyNet Examples
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Example 6. 3270 Emulation via an SNA Gateway over a TCP/IP Network

Steps

Follow these steps to establish communications between the Windows 95
Workstation (Node C) and the VTAM host (Node A).

For VTAM Node A, add the following entry to the HOSTS file:
10.1.1.2 CP2.NETA.SNA.IBM.COM
10.1.1.2 DEPLU1.NETA.SNA.IBM.COM

For OS/2 Node B, add the following entry to the HOSTS file:
10.1.1.3 CP1.NETA.SNA.IBM.COM
10.1.1.1 CP3.NETA.SNA.IBM.COM

For Windows 95 Node C, do as follows:

1. Add the following entry to the local HOSTS file:
10.1.1.2 CP2.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: S/390

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3

c. Click on Configure .

d. Click on Configure Link .

e. On the Configure Local System window, enter:

v PC Location Name: NETA.CP1

f. On the Configure AnyNet Connection window, enter:

v SNA domain name suffix: SNA.IBM.COM

v Fully qualified CP name: NETA.CP2

CP name: NETA.CP2
IP address: 10.1.1.2

IP
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Communications
Server

• SNA Gateway
• DLUR
• AnyNet SNA

over TCP/IP

Node B: OS/2 or Windows NT

CP name: NETA.CP1
IP address: 10.1.1.3
Dependent LU name: NETA.DEPLU1

Personal
Communications

• AnyNet SNA
over TCP/IP

Node C: Windows 95

CP name: NETA.CP3
IP address: 10.1.1.1

VTAM

• AnyNet SNA
over TCP/IP

• DLUS

Node A: VTAM
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g. Save your workstation profile.

Example 7. 3270 Emulation over a TCP/IP Network via an AnyNet
SNA/IP Gateway to a VTAM Host on an APPN Network

Steps

Follow these steps to establish communications between the OS/2 (or Windows NT)
workstation (Node B) and the Windows 95 workstation (Node C).

For OS/2 (or Windows NT) Node B, add the following entries to the HOSTS file:
192.168.1.2 CP2.NETA.SNA.IBM.COM
127.0.0.2 DEPLU1.NETA.SNA.IBM.COM
192.168.1.2 DEPLU1.NETA.SNA.IBM.COM

For Windows 95 Node C, do as follows:

1. Add the following entry to the local HOSTS file:
192.168.1.1 CP1.NETA.SNA.IBM.COM

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: S/390

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

c. Click on Configure .

d. Click on Configure Link .

e. On the Configure Local System window, enter:

v PC Location Name: NETA.CP2

f. On the Configure DLUR window, enter:

v DLUS name: NETA.CP1

IP address: 192.168.1.1

IP
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Communications
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• AnyNet SNA
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Node B: OS/2 or Windows NT

CP name: NETA.CP2
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v Routing Preference: Non-native only

g. On the Configure AnyNet Connection window, enter:

v SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

Example 8. 3270 Emulation from a Windows NT Workstation and a
Windows 95 Workstation on Different IP Networks

Steps

Follow these steps to establish communications from the Windows NT workstation
(Node A), and from Windows 95 (Node D), to the VTAM Host (Node E).

For Windows NT Node A, do as follows:

1. Add the following entries to the local HOSTS file:

PLU

CP name: NETB.CP2
IP address: 10.2.4.8

Node B: OS/2 or Windows NT

IP
Network
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10.2.4.8 CP5.NETB.SNA.IBM.COM
127.0.0.4 IPNET1.GWCNET
127.0.0.3 IPNET1.CP1

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: S/390

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

c. Click on Configure .

d. Click on Configure Link .

e. On the Configure Local System window, enter:

v PC Location Name: NETA.CP1

f. On the Configure DLUR window, enter:

v DLUS name: NETB.CP5

v Routing Preference: Non-native only

g. On the Configure AnyNet Connection window, enter:

v SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.

For OS/2 (or Windows NT) Node B, add the following entries to the HOSTS file:
10.2.4.6 CP1.NETA.SNA.IBM.COM
127.0.0.2 DEPLU1.NETA.SNA.IBM.COM
10.2.4.6 DEPLU1.NETA.SNA.IBM.COM
127.0.0.4 IPNET1.GWCNET
127.0.0.3 IPNET1.CP1

For OS/2 (or Windows NT) Node C, add the following entries to the HOSTS file:
172.20.1.2 CP4.NETC.SNA.IBM.COM
127.0.0.2 DEPLU2.NETC.SNA.IBM.COM
172.20.1.2 DEPLU2.NETC.SNA.IBM.COM
127.0.0.4 IPNET2.GWCNET
127.0.0.3 IPNET2.CP2

For Windows NT Node D, do as follows:

1. Add the following entry to the local HOSTS file:
172.20.1.1 CP5.NETB.SNA.IBM.COM
127.0.0.4 IPNET2.GWCNET
127.0.0.3 IPNET2.CP2

2. Create a workstation profile using the Personal Communications configuration
tool:

a. Click on the Start/Configure Session icon. The Customize Communication
window is displayed.

b. Select the following options:

v Host: S/390

v Interface: AnyNet

v Attachment: TCP/IP LU 0,1,2,3 via DLUR

c. Click on Configure .

d. Click on Configure Link .

AnyNet Examples

136 Personal Communications Quick Beginnings



e. On the Configure Local System window, enter:

v PC Location Name: NETC.CP4

f. On the Configure DLUR window, enter:

v DLUS name: NETB.CP5

v Routing Preference: Non-native only

g. On the Configure AnyNet Connection window, enter:

v SNA domain name suffix: SNA.IBM.COM

h. Save your workstation profile.
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Appendix E. Configuring Multiple Links

Many customers must attach to multiple AS/400 and S/390 mainframe systems.
Personal Communications allows this type of configuration. The following sections
explain how to do this.

Note: You do not need to read this section if you want to create multiple sessions
on the same host.

Configuring a Second 3270 Emulation Link

Recommendation

If you want a second SNA connection (link) to run concurrently, we strongly
recommend that you configure it in the same .PCG file as the first one; this
will avoid any possible conflict of settings.

Here are the steps you should follow. You can make the configuration even if the
first link is active.

1. Double-click the Start or Configure Session icon to start a new session.

2. Choose the host, interface, and attachment type, as usual.

3. Configure the session parameters, then click Configure Link .

4. In the Configure Local System panel, check that the default .PCG file is the
one in which you saved the configuration for the first link. If not, click Existing
and choose the correct file from the list.

5. Check that the settings for the PC Location Name are correct. Click Next .

6. The LAN Device Connection panel appears. Under Device Selection, be sure
that the device used for the first link is displayed. Under Connection Selection,
select New Connection . Notice that the connection name has changed to
show a new link name. Click Next .

7. The Configure LAN Connection panel is displayed. The Destination Address
field will show 400000000000. Enter the Destination Address for the second
link, and change the additional parameters if needed.

8. Click Advanced .

9. The Advanced dialog panel shows the default values for block ID and PU ID.
Change them as necessary to the values for the second link. Click OK.

10. Click Next , then Finish , and save the .ACG file (replace the existing file). Then
click OK until you return to the session window. If you have done everything
correctly, and if the gateway or controller is running, you should get a
connection.

You can add further 3270 links in the same way.

Configuring a Second 5250 Emulation Link

The steps you should follow are almost the same as for 3270. You can make the
configuration even if the first link is active:

1. Double-click the Start or Configure Session icon to start a new session.

2. Choose the host, interface, and attachment type, as usual.
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3. Configure the session parameters, then click Configure Link.

4. In the Configure Local System panel, check that the default .PCG file is the one
in which you saved the configuration for the first link. If not, click Existing and
choose the correct file from the list.

5. Check that the settings for the first link are correct. Click Next.

6. The Configure Logical Connection panel appears, showing the settings for the
first link. If you are going to connect to a different AS/400, change the System
Location Name. Click Next.

7. The Configure LAN Connection panel appears. If the Link Station Name has not
changed, change it.

8. Change the Destination Address (and the other parameters if necessary). If you
want to change the Local SAP number or the Receive Buffer Count, (which is
unlikely), click Advanced. If not, click Next , then Finish , and save the .ACG file
(replace the existing file), then click OK until you return to the session window.

You can add further 5250 links in the same way.

Configuring a Second Link of a Different Kind

The rules about this are similar to those for the configurations just described and
they apply equally whether you are going to configure two (or more) links that use
the same connection type, or links that use different connection types. In this
example, we shall assume that you have already configured a 3270 connection and
now want to add a 5250 connection. As before, you can make the configuration
even if the first link is active.

1. Double-click the Start or Configure Session icon to start a new session.

2. Choose AS/400, the LAN interface and the IEEE 802.2 attachment type.

3. Configure the session parameters, then click Configure Link.

4. In the Configure Local System panel, check that the default .ACG file is the one
in which you saved the configuration for the 3270 link. If not, click Existing and
choose the correct file from the list. Notice that the PC Location Name is
already there. Click Next.

5. The Configure Logical Connection panel appears. Enter the System Location
Name and click Next .

6. Notice that the Link Station Name has changed. Enter the Destination Address
of the AS/400. Click Next , then Finish , and save the .ACG file (replace the
existing file); then click OK until you return to the session window.
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Appendix F. Default Key Function Assignments

This appendix lists the functions assigned, by default, to each key on your
keyboard.

For more information about each function, refer to the Keyboard choice on the
Help menu.

You can change the default key assignments to the following default function tables,
by selecting Keyboard Setup from the Assist menu.

When the Keyboard Setup window appears, select one of the following choices:

v 3270 for a 3270 keyboard layout

v 5250 for a 5250 keyboard layout

v 3270+5250 for a combined keyboard layout

v VT for a DEC VT220 keyboard layout

Default Key Functions for a 3270 Layout

Table 3 shows the default key functions for PC/3270. The key used is the same for
all the supported keyboard types.

Table 3. Default Key Functions for a 3270 Layout

Function of Key Key

APL Ctrl+F8

Attention Esc

Alternate Cursor Alt+F11

Backspace Í─ (Backspace)

Back Tab Shift+─Ê|

Back Tab Word Alt+←

Break Break

Change Format Toggle Alt+F3

Change Screen Ctrl+PageUp

Clear Pause

Color Blue Ctrl+Shift+F5

Color Field Inherit Ctrl+Shift+F8

Color Green Ctrl+Shift+F3

Color Pink Ctrl+Shift+F2

Color Red Ctrl+Shift+F1

Color Turquoise Ctrl+Shift+F6

Color White Ctrl+Shift+F7

Color Yellow Ctrl+Shift+F4

Cursor Blink Ctrl+F10

Cursor Down ↓ or 2(pad)

Cursor Left ← or 4(pad)

Cursor Right → or 6(pad)
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Table 3. Default Key Functions for a 3270 Layout (continued)

Function of Key Key

Cursor Select Ctrl+F9

Cursor Up ↑ or 8(pad)

Delete Character Delete or
.(pad)

Delete Word Ctrl+Delete or
Ctrl+.(pad)

Document Mode Toggle Alt+F1

Dup Shift+Insert²

Edit Copy Ctrl+Insert

Edit Cut Shift+Delete

Edit Paste Shift+PageDown or
Ctrl+Shift+Insert

Edit Undo Alt+Í─ (Backspace)

End Field Pad End

Enter Right Ctrl

Enter/Control Right Ctrl

Erase EOF End²

Erase Field Shift+End²

Erase Input Alt+End²

Fast Cursor Down Alt+↓ or
Alt+2(pad)

Fast Cursor Up Alt+↑ or
Alt+8(pad)

Field Mark Shift+Home²

Graphic Cursor Alt+F12

Highlighting Field Inherit Alt+3(pad)

Highlighting Reverse Alt+*(pad)

Highlighting Underscore Alt+6(pad)

Home Home or 7(pad)

Insert Insert or 0(pad)

Jump Next Alt+PageUp

New Line Í┘ (Enter)

Mark Down Shift+↓

Mark Left Shift+←

Mark Right Shift+→

Mark Up Shift+↑

Move Mark Down Ctrl+↓ or
Ctrl+2(pad)

Move Mark Left Ctrl+← or
Ctrl+4(pad)

Move Mark Right Ctrl+→ or
Ctrl+6(pad)
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Table 3. Default Key Functions for a 3270 Layout (continued)

Function of Key Key

Move Mark Up Ctrl+↑ or
Ctrl+8(pad)

PA1 Alt+Insert²

PA2 Alt+Home²

PA3 Shift+PageUp²

Pause Ctrl+F7

PF1 to PF12 F1 to F12

PF13 to PF24 Shift+F1 to F12

Play Ctrl+F6

PS Field Inherit Ctrl+Shift+(pad)0

Print (Local Copy) Not assigned

Quit (Device Cancel) Alt+Left Ctrl

Record Ctrl+F5

Reset/Control Left Ctrl

Response Time Monitor Ctrl+F11

Rule Ctrl+Home

Sys Request Shift+Esc

Tab Field ─Ê| or Shift+─Ê|(pad)

Tab Word Alt+→

Test Ctrl+PageDown

Transparency Field Inherit Ctrl+Shift+8(pad)

Transparency Opaque Ctrl+Shift+/(pad)

Word Wrap Toggle Alt+F2

Note:

² Indicates the key on the main keyboard.

(pad) Indicates a key on the numeric keypad.

Note: The Enhanced keyboard has some duplicated keys. The functions
of the duplicated keys are the same except when you specify a single
key. For example, Del means any Delete key, whereas Pad Del specifies
only the Delete key on the numeric keypad.

Default Key Functions for a 5250 Layout

Table 4 on page 144 shows the default key functions for AS/400. The key used is
the same for all the supported keyboard types.

Note: If you use AS/400 from the combined package, see “Default Key Functions
for the Combined Package” on page 146.
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Note

The default key functions for a 5250 layout are not available by
default. To make these functions available perform the procedures in
“Setting the 5250 Keyboard Layout Default” on page 146.

Table 4. Default Key Functions for a 5250 Layout

Function of Key Key

Alternate Cursor Ctrl+F11

Attention Esc

Backspace Í─ (Backspace)

Backtab Shift+─Ê|

Backtab Word Alt+←

Begin Bold* Ctrl+B

Begin of line* Ctrl+4(pad)

Begin Underscore* Ctrl+U

Bottom of Page* Ctrl+2(pad)

Carrier Return Ctrl+Enter or
Ctrl+− (pad) or
Ctrl++ (pad)

Center Text* Ctrl+C

Clear Pause

Cursor Blink Ctrl+F10

Cursor Down ↓ or 2(pad)

Cursor Left ← or 4(pad)

Cursor Right → or 6(pad)

Cursor Up ↑ or 8(pad)

Delete Character Delete or .(pad)

Delete Word Ctrl+Delete or
Ctrl+.(pad)

Display Text Code Alt+Insert

Dup Shift+Insert

Edit Copy Ctrl+Insert

Edit Cut Shift+Delete ¬ 1-

Edit Paste Shift+PageDown or
Ctrl+Shift+Insert

Edit Undo Alt+Í─ (Backspace)

End Bold/Underscore* Ctrl+J

End of line* Ctrl+6(pad)
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Table 4. Default Key Functions for a 5250 Layout (continued)

Function of Key Key

End of page* Ctrl+P

Enter/Control Right Ctrl

Erase EOF End or 1(pad)

Erase Input Alt+End

Fast Cursor Down Alt+↓ or
Alt+2(pad)

Fast Cursor Up Alt+↑ or
Alt+8(pad)

Field Exit Enter(pad) or
Í┘ (Enter)

Field Mark Shift+Home

Field Minus (−) −(pad)

Field Plus (+) + (pad)

Half Index Down* Ctrl+H

Half Index Up* Ctrl+Y

Help Alt+F1

Home Home or 7(pad)

Host Print Ctrl+Pause

Insert Insert or
0 (pad)

Insert Symbol* Ctrl+A

Jump Next Alt+PageUp

Mark Down Shift+↓

Mark Left Shift+←

Mark Right Shift+→

Mark Up Shift+↑

Move Mark Down Ctrl+↓

Move Mark Left Ctrl+←

Move Mark Right Ctrl+→

Move Mark Up Ctrl+↑

New Line Shift+Í┘ (Enter)

Next Column* Ctrl+D

Next Stop* Ctrl+N

Pause Ctrl+F7

PF1 to PF12 F1 to F12

PF13 to PF24 Shift+F1 to F12

Play Ctrl+F6

Quit Alt+Left Ctrl

Record Ctrl+F5

Required Backspace Ctrl+Í─ (Backspace)

Required Space* Ctrl+Space
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Table 4. Default Key Functions for a 5250 Layout (continued)

Function of Key Key

Required Tab* Ctrl+─Ê|

Reset/Control Left Ctrl

Roll Down 9(pad) or PageUp

Roll Up 3(pad) or PageDown

Rule Ctrl+Home

Stop Code* Ctrl+S

System Request Shift+Esc

Tab Field ─Ê|

Tab Word Alt+→

Test Request Alt+Pause

Top of Page* Ctrl+8(pad)

Word Underscore* Ctrl+W

Note:

(pad) indicates a key on the numeric keypad.

* indicates a Text Assist Key (SBCS only).

Setting the 5250 Keyboard Layout Default

To make the 5250 keyboard layout defaults available, do the following:

1. Select Keyboard Setup from the Assist menu. The Keyboard dialog box is
displayed.

2. Select the IBM Default radio button next to Current Keyboard.

3. Click OK.

Default Key Functions for the Combined Package

Table 5 shows the default key functions for the combined package. The key used is
the same for all the supported keyboard types.

When you use the 3270+5250 keyboard layout, the key definitions for the 3270 and
5250 layouts are combined with those listed here.

Table 5. Default Key Functions for the Combined Package

Function of Key Key

Change Screen Not assigned

Character Advance Shift+BackSpace

Help Not assigned

Host Print Not assigned

PA3 Not assigned

Roll Down PageUp

Roll Up PageDown
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Default Key Functions for the VT Emulator Layout

Table 6 shows the default key functions for VT220, VT100 and VT52. The key used
is the same for all the supported keyboard types. The VT emulator keyboard gets
selected as the default only when the ″VT Component″ is selected in the installation
path.

Table 6. Default Key Functions for a VT Emulator Layout

Function of Key Key

Backspace Í─ (Backspace)

Break Ctrl+Pause

CAN Ctrl+Í─ (Backspace)

Cursor Down ↓ or 2(pad)

Cursor Left ← or 4(pad)

Cursor Right → or 6(pad)

Cursor Up ↑ or 8(pad)

Edit Copy Ctrl+Insert

Edit Cut Shift+Delete

Edit Paste Shift+PageDown or
Ctrl+Shift+Insert

Edit Undo Alt+Í─ (Backspace)

ESC ESC

Jump Next Alt+PageUp

New Line Í┘ (Enter)

Mark Down Shift+↓

Mark Left Shift+←

Mark Right Shift+→

Mark Up Shift+↑

Move Mark Down Ctrl+↓ or
Ctrl+2(pad)

Move Mark Left Ctrl+← or
Ctrl+4(pad)

Move Mark Right Ctrl+→ or
Ctrl+6(pad)

Move Mark Up Ctrl+↑ or
Ctrl+8(pad)

PF6 to PF12 F6 to F12

PF13 to PF20 Shift+F1 to F8

Rule Ctrl+Home

Tab Field ─Ê| or Shift+─Ê|

VT Enter Shift+Enter(pad)

VT Find End² or
1(pad)

VT Hold Pause

VT Insert Insert or 0(pad)
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Table 6. Default Key Functions for a VT Emulator Layout (continued)

Function of Key Key

VT Next Page Down² or
3(pad)

VT Numpad 0 to VT Numpad 9 Shift+0(pad) to
Shift+9(pad)

VT Numpad Comma Shift++(pad)

VT Numpad Minus -(pad) or Shift+-(pad)

VT Numpad Period Shift+.(pad)

VT PF1 to VT PF4 F1 to F4

VT Prev Page Up² or
9(pad)

VT Remove Delete or .(pad)

VT Select Home² or
7(pad)

VT User F6 to VT User F12 Ctrl+F6 to F12

VT User F13 to VT User F20 Ctrl+Shift+F1 to F8

Note:

² Indicates the key on the main keyboard.

(pad) Indicates a key on the numeric keypad.

Note: The Enhanced keyboard has some duplicated keys. The functions
of the duplicated keys are the same except when you specify a single
key. For example, Del means any Delete key, whereas Pad Del specifies
only the Delete key on the numeric keypad.
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Appendix G. Configuring Your Workstation for Thai, Arabic, or
Hebrew

Configuring for Thai

To configure for the Thai language:

1. Select Communication menu.

2. Select Configure... .

3. For each configuration, select Host Code-Page to be one of the following:

v 838 Thai

v 037 Thai/US

To enable Thai keyboard input:

1. Select Assist menu.

2. Select Keyboard Setup... .

3. Select Keyboard Layout: Thai .

Note: Thai features are enabled when running on Windows 95 and Windows 98
Thai only and these Thai settings are defaults.

Configuring for Arabic or Hebrew

To set up an Arabic or Hebrew workstation, verify that you have fulfilled the
following definitions:

1. Select Configure from the Communication pull-down menu and then select
Configure once again to display the Customize Communication panel. Select
420 Arabic Speaking for Arabic or 424 Hebrew (Bulletin Code) or 803
Hebrew (Old Code) as the host code page for Hebrew.

2. Select Keyboard Setup from the Assist pull-down menu. Select Arabic
Speaking as the keyboard layout for Arabic. Select 424 Hebrew (Bulletin
Code) or 803 Hebrew (Old Code) as the keyboard layout for Hebrew.

3. Select Font Size from the Appearance pull-down menu. For Arabic, choose
ARB3270 at the Automatic Sizing list box or at the Fixed size font selection. For
Hebrew, select HEB3270 in these same places.

4. Select API Setting from the Files pull-down menu and then select 864 as the
DDE/EHLLAPI PC Code-Page for Arabic. For Hebrew, select 862 in the same
place.

For Arabic, to setup for Numeric Swapping or Symmetric Swapping:

1. Select Display Setup from the Appearance pull-down.

2. Select Swapping from the list box at the left; the settings for numerics and
symmetric characters are displayed. Changes are immediately reflected on the
active session.

Note: Numeric Swapping is a 3270-only feature. This function will not be
selectable if the session is an AS/400 session.
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File Transfer

For Arabic, when transferring files between the PC and the host, the available PC
code pages are code page 864 (the IBM PC Arabic code page) and code page
1256, the Microsoft Arabic windows code page.

For Hebrew, when transferring files between the PC and the host, the available PC
code pages are code page 862 (the IBM PC Hebrew code page) and code page
916 for the Hebrew ISO-conforming code page.

For Code Page 1256 Only

You must set the parameter for the orientation of the HOST File. Set the parameter
as follows:

Select Transfer →Setup →Miscellaneous Settings

1. For right-to-left host file orientation, mark the HostFile Orientation box.

2. For left-to-right host file orientation, unmark the HostFile Orientation box.

Data Transfer for Arabic

When transferring SQL Data between the PC and the AS/400, the available PC
code page is code page 864 (the IBM Arabic Code page) and code page 1256 for
the Microsoft Arabic windows code page. To transfer data, do as follows:

1. Select Setup → Translation Table Setup .

2. Select User Defined .

3. Select Host Codepage : 420 Arabic Speaking .

4. Select PC Codepage : 864 or 1256 .

If code page 1256 is selected, the user must then set the parameter for the
orientation of the host file, as explained above.

Refer to the Personal Communications V4.3 Reference Volume II, where the
chapter “Country Codes, Code Pages and Character Sets” shows the actual code
pages, and where the Appendix “Bidirectional Language Support” provides
additional information.

Configuring for Thai, Arabic or Hebrew
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Appendix H. Installation and Limitations of Personal
Communications on ChineseStar and RichWin

This appendix describes how to install Personal Communications on ChineseStar
(CStar) and RichWin, and the limitations of running Personal Communications on
CStar and RichWin.

Installing Personal Communications on ChineseStar and RichWin

Before installing Personal Communications, you must make sure that CStar or
RichWin is installed and running on the English version of Windows 95, Windows
98, or Windows NT. Once CStar or RichWin is installed and running, install
Personal Communications by following the steps described in the Personal
Communications Version 4.3 CD-ROM Guide to Installation.

Limitations of Personal Communications on ChineseStar and RichWin

Running Personal Communications on CStar and RichWin has the following
limitations:

v Personal Communications supports only the GBK code page.

v RichWin does not support 3270 APL functions.

v CStar and RichWin support single Input Method Editor (IME) only.

For example, if you open IME in multiple windows, IME behavior is synchronized
in those windows. This is a platform limitation and it applies to Personal
Communications as well.

v Although CStar and RichWin provide many true type fonts, Personal
Communications supports only fixed pitch fonts.
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Appendix I. API Client Attachments

Communications Server for Windows NT and NetWare for SAA

Support for Communications Server/NT

If you are connecting to a Communications Server for Windows NT by using the
Communications Server/NT client or installing on the Communications Server/NT
machine, configure Personal Communications to use the SNA API client interface.

Three different connectivities apply:

Host 390
APPC3270 or LUA3270

AS/400
5250

Support for NetWare for SAA

If you are connecting to NetWare SAA Version 2.0 or later, or IBM Communications
Server for Windows NT 5.0 or later, the API Client for these two gateways is
included on the Personal Communications CD. First install the client, then install
Personal Communications. When you select to install the API Client for NetWare for
SAA, you will be prompted to specify the type of server that you use. In the
configuration step, choose API Client for the interface and then choose the
connectivity that applies.

Refer to the API Client documentation for further information.

Load Balancing

Personal Communictions now supports load balancing for all client types. Load
balancing enables you to distribute LU 0 to 3 and LU 6.2 sessions across Personal
Communications and NetWare for SAA servers. The server advertises services
including load factors, which the clients or servers can gather and organize to select
a server.

3270 via NWSAA or IBM Personal Communications (IPX/SPX-IP)

Load Balancing over IPX/SPX Protocols: Load balancing over IPX/SPX is a key
feature for NWSAA 2.0 and later versions. This feature dynamically balances
dependent LU2 (host-to-workstation) sessions. For LU2 sessions over IPX/SPX
connections, the load is distributed across host links on servers to a named LU2
pool.

Note: For true load balancing use a wild card (’*’) Server Name and Service Name,
and use the pooled LU category with a LU-Pool Name.

Load Balancing over TCP/IP Protocols: Load Balancing over TCP/IP protocols
is a key feature for IWSAA 3.0 and CS/NT 5.1. This feature dynamically balances
dependent LU2 (host-to-workstation) sessions. For LU2 sessions over TCP/IP
connections, the load is distributed across servers within a named LU2 pool and a
named scope. That is the server with the least overall load within the named scope
supporting the named LU2 pool will satisfy a given LU2 connection request.
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Note: IBMSLP.DLL should be available on the client workstation system directory.
Refer to your Server documentation for information about where to obtain
this dynamic load library file.

Note: For true load balancing use a wild card (’*’) Server Name and Service Name,
and use the pooled LU category with a LU-Pool Name.

Hot Standby over IPX/SPX and TCP/IP

The NWSAA Hot Standby feature enables to ensure that configured connections to
a host can continue to function when a critical server goes down by triggering
activation of alternative connections on a backup server. Load Balancing can be
used in conjunction with Hot Standby.

If the active session to the server goes down because of server or link failure,
Personal Communications will try to reconnect the session with the provided backup
server name, service name, or pool name.

IBMSLP.DLL should be available on the client workstation system directory.

NetWare Coexisting with LAN

If you want to use LAN via NetWare for SAA, or if you want to use NetWare Client
and the LAN connection of Personal Communications simultaneously, you should
use the NDIS driver.

The API client attachments let you use an interface provided by another application
to make a Personal Communications connection.

Three interfaces are supported:

v Communications Server for Windows NT

You can run Personal Communications on a Communications Server; it uses
Communications Server’s protocol stack to connect to the host.

v Client for Communications Server for Windows NT

For client workstations, Communications Server has a client that communicates
with the server and provides an interface that Personal Communications can use.
The client must be installed on your workstation before you install Personal
Communications.

v Client for NetWare for SAA

NetWare for SAA provides ’hot backup’ and ’load balancing’. The requirements
are:

– The Novell NetWare client for Windows NT must be installed.

– The NetWare for SAA client must be installed. This client is provided with
Personal Communications.

– Both clients must be installed before you install Personal Communications.

– If you are using NetWare for SAA 2.0, you must create an INI file for the
NetWare for SAA client, as described in the client Readme file.

Notes:

1. You cannot install Personal Communications’ own SNA protocol drivers if you
intend to use the API Client interface. You can, however, use the non-SNA
attachment types, which include HPO, Home3270, TN3270, and IPX/SPX.

SAA Server and Communications Server
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2. The Netware for SAA connections discussed here are separate from the
IPX/SPX connection which you can configure through the LAN interface.

The API client interface lets you make the following attachments:

– 3270 emulation

LUA - LU 0, 1, 2 or 3 via the WinRUI interface. This lets you have normal
display or printer sessions.

– APPC3270

This provides 3270 display sessions (not printer) over an LU 6.2 connection to
the host.

– 5250 emulation

This provides 5250 display and printer sessions through APPC.

SAA Server and Communications Server
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SAA Server and Communications Server
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Appendix J. Trademarks

The following terms are trademarks of the IBM Corporation in the United States or
other countries, or both:

400
ACF/VTAM
AFP
AIX
AIXwindows
APL2
APPN
AS/400
AT
Advanced Peer-to-Peer Networking
AnyNet
Application System/400
BookManager
CICS
CICS/MVS
CICS/VSE
COBOL/2
CUA
Common User Access
Client Access
Client Access/400
Current
DB2
DB2/400
DRDA
DisplayWrite
Distributed Relational Database Architecture
ExecJet
GDDM
Global Network
IBM
IBMLink
IIN
IMS
InfoWindow
MVS/ESA
MVS/XA

NetView
OS/2
OS/400
OfficeVision
OfficeVision/400
OfficeVision/MVS
Open Blueprint
PROFS
PS/2
PSF
Personal System/2
Presentation Manager
Proprinter
PRS/6000
Quickwriter
Quietwriter
S/390
SAA
SP
Series/1
System/36
System/370
System/38
System/390
Systems Application Architecture
TalkLink
ThinkPad
VM/ESA
VM/XA
VTAM
ValuePoint
Virtual Machine/Enterprise Systems Architecture
WIN-OS/2
WebExplorer
XGA
XT

Microsoft, Windows, Windows NT©, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

Tivoli is a trademark of Tivoli Systems Inc. in the United States and/or other
countries.

Java and all Java-based trademarks and logos are trademarks of Sun
Microsystems, Inc. in the United States and/or other countries.

PC Direct is a registered trademark of Ziff Communications Company and is used
by IBM Corporation under license.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through X/Open Company Limited.
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C-bus is a trademark of Corollary, Inc.

ActionMedia, LANDesk, MMX, Pentium, and ProShare are trademarks or registered
trademarks of Intel Corporation in the U.S. and other countries.

Other company, product, and service names may be trademarks or service marks
of others.

Trademarks
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Appendix K. Notices

This information was developed for products and services offered in the United
States. IBM may not offer the products, services, or features discussed in this
information in other countries. Consult your local IBM representative for information
on the products and services currently available in your area. Any reference to an
IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this information. The furnishing of this information does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

500 Columbus Avenue

Thornwood, NY 10594

U.S.A

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation

Licensing

2-31 Roppongi 3-chome, Minato-ku

Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local
law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
INFORMATION AS IS WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the information. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this information at
any time without notice.

Any references in this information to non-IBM documentation or non-IBM Web sites
are provided for convenience only and do not in any manner serve as an
endorsement of those documents or Web sites. The materials for those documents
or Web sites are not part of the materials for this IBM product and use of those
documents or Web sites is at your own risk.

Licensees of this program who wish to have information about it for the purpose of
enabling:(i) the exchange of information between independently created programs
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and other programs (including this one) and (ii) the mutual use of the information
which has been exchanged, should contact:

IBM Corporation

Department T01

Building 062

P.O. Box 12195

Research Triangle Park, NC 27709-2195

The licensed program described in this information and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Programming License Agreement, or any equivalent agreement
between us.

Information concerning non-IBM products was obtained from the suppliers of those
products, their published announcements or other publicly available sources. IBM
has not tested those products and cannot confirm the accuracy of performance,
compatibility or any other claims related to non-IBM products. Questions on the
capabilities of non-IBM products should be addressed to the suppliers of those
products.

Notices
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Glossary

The complete IBM Software Glossary is available
on the World Wide Web at
www.networking.ibm.com/nsg/nsgmain.htm .

A
access control. In computer security, ensuring that
the resources of a computer system can be accessed
only by authorized users in authorized ways.

access control profile. A list of the access privileges
assigned to users and groups for a particular network
resource in a domain.

access priority. In the IBM Token-Ring Network, the
maximum priority a token can be given by the adapter
for transmission.

ACF/NCP. Advanced Communication Function for the
Network Control Program.

ACF/TCAM. Advanced Communication Function for
the Telecommunications Access Method.

ActiveX. A diverse set of technologies using COM.

adapter. A part that electrically or physically connects
a device to a computer or to another device.

Advanced Communications Function (ACF). A
group of IBM licensed programs, principally VTAM,
TCAM, NCP, and SSP, that use the concepts of
Systems Network Architecture (SNA), including
distribution of function and resource sharing.

Advanced Communication Function for the
Telecommunications Access Method (ACF/TCAM).
A network host communication program.

Advanced Communication Function for the Network
Control Program (ACF/NCP). A network host
communication program.

Advanced Communication Function for the Virtual
Telecommunications Access Method (ACF/VTAM).
A network host communication program.

Advanced Peer-to-Peer Networking (APPN). An
extension to SNA featuring (a) greater distributed
network control that avoids critical hierarchical
dependencies, thereby isolating the effects of single
points of failure; (b) dynamic exchange of network
topology information to foster ease of connection,
reconfiguration, and adaptive route selection; (c)
dynamic definition of network resources; and (d)
automated resource registration and directory lookup.
APPN extends the LU 6.2 peer orientation for end-user
services to network control and supports multiple LU
types, including LU 2, LU 3, and LU 6.2.

Advanced Peer-to-Peer Networking (APPN) end
node. A node that provides a broad range of end-user
services and supports sessions between its local control
point (CP) and the CP in an adjacent network node. It
uses these sessions to dynamically register its
resources with the adjacent CP (its network node
server), to send and receive directory search requests,
and to obtain management services. An APPN end
node can also attach to other end nodes.

Advanced Peer-to-Peer Networking (APPN)
network. A collection of interconnected network nodes
and their client end nodes.

Advanced Peer-to-Peer Networking (APPN) network
node. A node that offers a broad range of end-user
services and that can provide the following:

v Distributed directory services, including registration of
its domain resources to a central directory server

v Topology database exchanges with other APPN
network nodes, enabling network nodes throughout
the network to select optimal routes for LU-LU
sessions based on requested classes of service

v Session services for its local LUs and client end
nodes

v Intermediate routing services within an APPN network

Advanced Peer-to-Peer Networking (APPN) node.
An APPN network node or an APPN end node.

advanced program-to-program communication
(APPC). (1) The general facility characterizing the LU
6.2 architecture and its various implementations in
products. (2) Sometimes used to refer to the LU 6.2
architecture and its product implementations as a whole,
or to an LU 6.2 product feature in particular, such as an
APPC application programming interface.

AID key. A control key that generates a host attention
interrupt.

alert. (1) A message sent to a management services
focal point in a network to identify a problem or an
impending problem. (2) In SNA management services
(SNA/MS), a high priority event that warrants immediate
attention.

alias name. A name that is defined in one network to
represent a logical unit name in another interconnected
network. The alias name does not have to be the same
as the real name; if these names are not the same,
translation is required.

American National Standard Code for Information
Interchange (ASCII). A character set standard
established by the American National Standards
Institute, using a set of 7-bit binary-coded characters (8
bits including parity check). ASCII is used for
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information interchange among data processing
systems, data communication systems, and associated
equipment. An extended, 8-bit version of this code is
used in the personal computer. It consists of control
characters and graphic characters in addition to the
7-bit ASCII characters. See also extended binary-coded
decimal interchange code.

American National Standards Institute (ANSI). An
organization consisting of producers, consumers, and
general interest groups, that establishes the procedures
by which accredited organizations create and maintain
voluntary industry standards in the United States. (A)

ANSI. American National Standards Institute.

AnyNet product family. A group of IBM products that
implement the multiprotocol transport networking
(MPTN) architecture, thus enabling application programs
to communicate independently of the underlying
network transport protocol.

API. Application programming interface.

APL. A programming language requiring the use of a
special keyboard to represent various operator symbols.

APPC. Advanced program-to-program
communications.

application. A collection of software components used
to perform specific types of user-oriented work on a
computer.

application program. (1) A program written for or by a
user that applies to the user’s work, such as a program
that does inventory control or payroll. (2) A program
used to connect and communicate with stations in a
network, enabling users to perform application-oriented
activities.

application programming interface (API). (1) The set
of programming language constructs or statements that
can be coded in an application program to obtain the
specific functions and services provided by an
underlying operating system or service program. (2) In
VTAM, the language structure used in control blocks so
that application programs can reference them and be
identified to VTAM.

application transaction program. A program written
for or by a user to process the user’s application; in an
SNA network, a user of a type 6.2 logical unit. Contrast
with service transaction program.

APPN. Advanced Peer-to-Peer Networking.

APPN end node. See Advanced Peer-to-Peer
Networking (APPN) end node.

APPN network node. See Advanced Peer-to-Peer
Networking (APPN) network node.

ASCII (American National Standard Code for
Information Interchange). The standard code, using a
coded character set consisting of 7-bit coded characters
(8 bits including parity check), that is used for
information interchange among data processing
systems, data communication systems, and associated
equipment. The ASCII set consists of control characters
and graphic characters. (A)

ASYNC. Asynchronous.

asynchronous (ASYNC). (1) Pertaining to two or
more processes that do not depend upon the
occurrence of specific events such as common timing
signals. (T) (2) Without regular time relationship;
unexpected or unpredictable with respect to the
execution of program instructions.

Asynchronous Data Link Control (ASYNCH). A
discipline for managing asynchronous, serial-by-bit
information transfer over a line connection.

asynchronous transmission. A data communication
method wherein character strings of variable length are
transmitted serially at a variable transmission rate. Each
character or defined block of characters has a constant
transmission duration.

atom. Represents a character string that has been
reduced to a unique integer value.

attention identifier. See AID key.

attachment. A communication link used by Personal
Communications to connect a personal computer to a
host system, consisting of an adapter and controlling
software.

audit trail. A history of network activity on a server.

AUTOEXEC.BAT file. In the DOS operating system, a
batch file that resides in the root directory of the boot
drive. AUTOEXEC.BAT contains commands that DOS
executes every time the PC is booted.

automatic access utility. A utility that allows you to
create and edit the files that control the automatic-dial,
automatic-logon, and modem control programs.

autoskip. A field defined as protected and numeric.
Causes the cursor to skip to the next unprotected field.

B
backup diskette. A diskette that contains information
copied from a Personal Communications diskette.

base-color mode. The mode in which a terminal
operates if the host system does not supply color
information.
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Basic Input/Output System (BIOS). Code that
controls basic hardware operations, such as interactions
with diskette drives, hard disk drives, and the keyboard.

binary. Pertaining to the base two system of numbers.
The binary digits are 0 and 1. Executable files are
generally in binary format rather than the character
string format that text files are composed of.

BIOS. (1) Basic Input/Output System. (2) See also
NetBIOS.

bis. A suffix used to designate the second version of a
standard, as in ITU-T Recommendation V.25 bis.

bit map. A representation of an image by an array of
bits.

C
Caps Lock. The personal computer keyboard mode
entered after the Caps Lock key is pressed. This mode
is indicated by a capital A in the operator information
area (OIA). When the Shift key is pressed while in this
mode, Caps Lock is temporarily discontinued and the
OIA indicator changes. Pressing the Shift key again
returns the Caps Lock mode.

character cell. The maximum physical boundary of a
character on a display screen.

character set. A finite group of characters defined for
a keyboard or output device.

CICS/VS. Customer Information Control System for
Virtual Storage.

code page. (1) An assignment of graphic characters
and control function meanings to all code points; for
example, assignment of characters and meanings to
256 code points for an 8-bit code, assignment of
characters and meanings to 128 code points for a 7-bit
code. (2) A particular assignment of hexadecimal
identifiers to graphic characters.

COM. Component Object Model.

Component Object Model. An architecture developed
by Microsoft defining a common paradigm for interaction
among software components independent of source
language.

Common Programming Interface for
Communications (CPI-C). An evolving application
programming interface (API), embracing functions to
meet the growing demands from different application
environments and to achieve openness as an industry
standard for communications programming. CPI-C
provides access to interprogram services such as (a)
sending and receiving data, (b) synchronizing
processing between programs, and (c) notifying a
partner of errors in the communication.

configuration. (1) The manner in which the hardware
and software of an information processing system are
organized (2) In Personal Communications, the
arrangement of personal computers connected to one or
more host systems by one or more attachment types.

configuration file. A file that specifies the
characteristics of a system device or network.

continuous carrier. A characteristic of the modem
used in an SDLC type of attachment; frequency capable
of being modulated or impressed with a second
(informative carrier) signal.

control unit. A device that manages the flow of data
between personal computers used with Personal
Communications and a host system.

conversation. A logical connection between two
transaction programs using an LU 6.2 session.
Conversations are delimited by brackets to gain
exclusive use of a session.

CP. Control point.

CPI-C. Common Programming Interface for
Communications.

CP name. A network-qualified name of a control point
(CP), consisting of a network ID qualifier identifying the
network (or name space) to which the CP’s node
belongs, and a unique name within the scope of that
network ID identifying the CP. Each APPN or LEN node
has one CP name, assigned to it at system-definition
time.

CSD. Corrective service diskette.

Customer Information Control System for Virtual
Storage (CICS/VS). An IBM licensed program that can
be used in a communications network.

customization. The process of configuring one or
more personal computers connected to a host system
by the SDLC, LAN, ASYNCH, X.25, DFT, or other
attachment. Customization precedes Personal
Communications installation and includes the definition
of the sessions to be carried out by Personal
Communications.

D
DBCS. Double-byte character set

default. A value, attribute, or option that is assumed
when no differing selection is made.

definition file. A file loaded by default that contains
keyboard and screen color characteristics that can be
adapted for a particular session. The lines of a definition
file must be coded according to a strict layout.
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delimiter. In the IBM Token-Ring Network, a bit pattern
that defines the limits of a frame or token.

dependent LU. See SSCP-dependent LU.

dependent LU requester (DLUR). An APPN end node
or an APPN network node that owns dependent LUs,
but requests that a dependent LU server provide the
SSCP services for those dependent LUs.

dependent LU server (DLUS). An APPN network
node that provides SSCP services for a dependent LU
in its own or another APPN network. Contrast with
dependent LU requester.

DFT. See distributed function terminal.

diacritic key. A key that allows a character to be
entered without the cursor position being changed.
When you enter an accent mark or a tilde, for example,
the cursor does not advance to the next position until
you enter the corresponding alphabetic character.

dial-up line. See switched line.

direct memory access (DMA). The system facility
that allows a device on the Micro Channel bus to get
direct access to the system or bus memory without the
intervention of the system processor.

distributed function terminal (DFT). A terminal that
supports multiple concurrent logical terminal sessions.

distributed function terminal attachment. The
connection of a personal computer with an IBM 3174 or
3274 Control Unit using a coaxial cable and software
that provides DFT capabilities.

directory. A named hierarchical grouping of files in a
file system.

DLUR. Dependent LU requester.

DLUS. Dependent LU server.

DMA. See direct memory access.

domain. A set of servers that allocate shared network
resources within a single logical system.

DOS session. A session in which a personal computer
operates as a stand-alone computer, running under Disk
Operating System (DOS). See host session.

download. The transfer of a file from a host system to
a personal computer.

double-byte character set (DBCS). A set of
characters in which each character is represented by 2
bytes. Languages such as Japanese, Chinese, and
Korean, which contain more symbols than can be
reqpresented by 256 code points, require double-byte
character sets. Because each character requires 2
bytes, the typing, display, and printing of DBCS

characters requires hardware and programs that support
DBCS. Contrast with single-byte character (SBCS).

DRDA. Distributed Relational Database Architecture.

dynamic data exchange (DDE). A protocol that allows
applications to exchange data.

E
EBCDIC. See extended binary-coded decimal
interchange code.

ECF. See Enhanced Connectivity Facilities.

EGA. See enhanced graphics adapter.

EHLLAPI. See Emulator High-Level Language
Application Programming Interface.

EIA 232. A standard established by the Electronic
Industries Association for direct linkage for serial binary
data transfer between a computer and peripheral
equipment, such as a modem or printer. See V.24.

EMM. See Expanded Memory Manager.

EMS. See Expanded Memory Specification.

emulator. A program that allows a device to operate
as if it were a different type of device. Personal
Communications, for example, allows supported
personal computers and printers to operate as if they
were 3270-series or 5250-series workstations.

Emulator High-Level Language Application
Programming Interface (EHLLAPI). A programming
interface that permits workstation-based programs to
access host computer presentation space.

end node (EN). See Advanced Peer-to-Peer
Networking (APPN) end node and low-entry networking
(LEN) end node.

Enhanced Connectivity Facilities (ECF). An IBM
communication utility that provides the ability to share
resources between workstations and host systems.

enhanced graphics adapter (EGA). An adapter, such
as the IBM Enhanced Graphics Adapter, that provides
high-resolution graphics, allowing the use of a color
display for text processing as well as graphics
applications.

EOF. End of Field

EOT. End of Text

error log. A file that stores error information for later
access.

Ethernet. A 10-Mbps baseband local area network that
allows multiple stations to access the transmission
medium at will without prior coordination, avoids
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contention by using carrier sense and deference, and
resolves contention by using collision detection and
delayed retransmission. Ethernet uses carrier sense
multiple access with collision detection (CSMA/CD).

exit function. A function that allows the user to switch
from a host session to a DOS session. The key
sequence for exit is Ctrl+End .

Expanded Memory Manager (EMM). A standard
device driver that manages expanded memory in 16-KB
logical pages. The EMM maps a set of logical pages
into a page frame using the physical address space that
is available in memory above 640 KB, storing the map
into conventional memory. The application then
accesses the expanded memory thus created as though
it were conventional memory.

Expanded Memory Specification (EMS). A
specification for accessing memory above the
conventional DOS memory address space, 0–640 KB.
See Expanded Memory Manager, LIM EMS 3.2, and
LIM EMS 4.0.

extended binary-coded decimal interchange code
(EBCDIC). The standard code, using a character set
consisting of 8-bit coded characters, used by Personal
Communications for information interchange between
personal computers and a host system. See also
American National Standard Code for Information
Interchange.

extended-color mode. The mode in which a terminal
operates if the host system supplies color information.

extended error code. An 8-byte data string returned
by Query System generated by an internal system
error that is used by service personnel for diagnosis.

extended memory. Memory above 1 MB that can be
accessed and used by 80286 and 80386** (or greater)
CPUs to run applications in protected mode. PC DOS
does not normally access memory above 640 KB. This
memory is useful only for applications that are written
specifically to use extended memory. Successful use of
extended memory by an application usually requires the
use of an 80386 or greater CPU, which provides
machine instructions to handle the use of extended
memory.

external resource. A file, directory, or device supplied
by a server outside the current domain.

F
field. (1) An area in a record or panel used to contain
data. (2) In the IBM 3270 data stream, a group of
consecutive positions on a presentation space having
similar characteristics that are defined by a field
attribute byte at the beginning of the field.

field delimiters. Symbols (often brackets) that indicate
the limits of a data entry field.

file mode. In VM/CMS, the third field of the file
identifier, which indicates the assigned virtual disk
wherein the file resides.

file type. In VM/CMS, the second field of the file
identifier. The file type can be arbitrary, or of
significance to the system (for example, SCRIPT,
LIST3270, and NOTEBOOK file types).

fixed disk. See hard disk.

flag. A character or bit sequence that marks an
occurrence or boundary, such as the end of a word or
the beginning or end of a data transmission block.

frame. A data structure (data frame) composed of
fields meeting the field specifications of a type of
communication protocol. Frames are used to control
data transfer across a data link. In SDLC, a frame is a
sequence of bits delimited by an opening and closing
flag. In X.25 packet switching data networks, frames are
composed of 8-bit byte sequences delimited by
beginning and ending flags; the frames in X.25 control
various functions, data transfer, and transmission
checking.

G
gateway. A station in a local area network through
which a connection to a host system or a separate
network is established.

gateway status utility. A utility that allows a user to
check the status of sessions in a gateway network.

GDDM. See Graphical Data Display Manager.

GDDM-PCLK. A personal computer application
program that supports host GDDM graphics
applications. This application requires an LLAPI
interface for PC/3270.

Graphical Data Display Manager (GDDM). An IBM
host function that processes text and graphics for output
to a display, printer, or graphic output device.

H
hard disk. A rigid-magnetic disk such as the internal
disks used in the system units of personal computers
and in external hard disk drives (also known as fixed
disks).

High-Level Language Application Programming
Interface (HLLAPI). A software product that supports
interaction between a host program and an application
program running on a personal computer in terminal
emulation (usually 3270 terminal emulation).
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High-Performance Routing (HPR). An addition to
APPN that enhances data-routing performance and
session reliability.

HLLAPI. See High-Level Language Application
Programming Interface.

host address. A LAN address used by the host
controller.

host code page. The character code page used by
the host system to which a gateway connects.

host print. A printer session on a local personal
computer directed by the host system.

host profile. A configuration profile that identifies a
gateway by name, and establishes LU addresses and
types for connected logical units.

host session. A logical connection that enables a
personal computer to communicate with a host system.
A session can be identified by LU address, LT number,
or session ID. See DOS session. See also logical
terminal.

host short name. See short name.

host system. In Personal Communications, the
computer linked to one or more personal computers by
the SDLC, LAN, ASYNCH, X.25, or DFT attachment.

hot key. A keystroke or keystroke combination that
initiates the hotkey function. See hotkey function.

hotkey function. A function that allows you to switch
to the next logical terminal or DOS, on whichever
screen it last appeared, without exiting the current
application.

HPR. High-Performance Routing.

I
IBM PC Network. A local area network providing
peer-to-peer communication among IBM personal
computers, allowing them to share resources. It utilizes
carrier sense multiple access/collision detect
(CSMA/CD) protocol and supports a data transmission
rate of 2 million bits per second. Broadband and
baseband versions are available.

IBM Token-Ring Network. A general-purpose
baseband token-ring local area network for
interconnecting information processing equipment at a
local site. It uses a token-ring access protocol and
supports a data rate of either 4 or 16 million bits per
second. It conforms to the IEEE 802.5 (token-ring) and
IEEE 802.2 (logical link control) standards.

IBM NCP Packet Switching Interface Program
(NPSI). A network host communication product that
runs in an IBM 3745 communications controller and

enables it to connect to an ITU-TS X.25
recommendation packet-switching data network.

idles. In a token-ring network, the signals sent when
neither frames nor tokens are being transmitted.

IEEE. See Institute of Electrical and Electronics
Engineers.

IEEE 802.2. An IEEE standard for logical link control in
local area networks.

initial program load (IPL). The initialization procedure
that starts an operating system, or the process of
loading programs and preparing a system to run jobs.

installation. In Personal Communications, the process
of loading microcode from the Personal
Communicationsdiskettes.

Institute of Electrical and Electronics Engineers
(IEEE). An organization that establishes and promotes
standards in related industries.

integrated services digital network. A digital
end-to-end telecommunication network that supports
multiple services including, but not limited to, voice and
data.

interleave. In Personal Communications, to arrange
parts of a transmission sequence so that they are
interspersed with parts of one or more other
transmission sequences of the same nature, with each
sequence retaining distinct meaning and identity. See
also packet-switching data network and X.25
Recommendation.

International Telecommunication Union (ITU). The
specialized telecommunication agency of the United
Nations, established to provide standardized
communication procedures and practices, including
frequency allocation and radio regulations worldwide.

interrupt level. A number assigned to an interrupt to
indicate priority. The interrupt with the lowest number
has the highest priority.

IPL. See initial program load.

ISDN. Integrated services digital network.

ITU-TS. See ITU-T.

ITU-T. International Telecommunication Union -
Telecommunication Standardization Sector. The part of
the International Telecommunication Union (ITU) that is
reponsible for developing recommendations for
telecommunications. (Formerly known as the CCITT.)

J
jump. To start the jump function.
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jump function. A switch to the logical terminal session
specified.

K
key assignment. The character, numeral, symbol, or
function generated when a keyboard key is pressed. All
keys have default assignments that can be customized.

keyboard definition. Definitions of keyboard keys as
stored on one of the Personal Communications
diskettes.

keyboard template. An overlay placed on a keyboard
to explain the function of each key.

L
LAN. See local area network.

leased line. See nonswitched line.

LEN. Low-entry networking.

LEN node. A node that supports independent LU
protocols but does not support CP-CP sessions. It may
be a peripheral node attached to a boundary node in a
subarea network, an end node attached to an APPN
network node in an APPN network, or a peer-connected
node directly attached to another LEN node or APPN
end node. See also low-entry networking (LEN) end
node.

LIM EMS 3.2. An expanded memory specification
agreed to in 1984 by the computer software
manufacturers Lotus**, Intel**, and Microsoft** to access
memory above the DOS conventional memory area,
0–640 KB, using an EMM device driver. LIM EMS 3.2
allows an application to store up to 8 MB of data in
expanded memory, in 512 logical pages of 16 KB. The
EMS 3.2 expanded memory manager maps up to 64 KB
of expanded memory in the PC BIOS memory area.
See also LIM EMS 4.0 and Expanded Memory
Manager.

LIM EMS 4.0. An extended expanded memory
specification (EEMS) pioneered by AST** Research
Corporation as an extension to LIM EMS 3.2 to permit
expanded memory to be used for directly executing
programs through multitasking, and to expand the areas
accessible for mapping expanded memory beyond the
conventional memory barrier, up to 1024 KB. The EEMS
was further improved and defined by agreement of
Lotus, Intel, and Microsoft corporations to better support
windowing and multitasking operating environments.
With appropriate hardware support, LIM EMS 4.0
supports up to 32 MB of expanded memory. Its EMM
can create page frames up to 896 KB, and up to 2048
logical pages of 16-KB memory.

line speed. The speed at which data is transferred
over an analog (telephone) line. Line speeds depend on
the quality of the line.

local area network (LAN). (1) A computer network
located on a user’s premises within a limited
geographical area. Communication within a local area
network is not subject to external regulations; however,
communication across the LAN boundary may be
subject to some form of regulation. (T) (2) A network
in which a set of devices are connected to one another
for communication and that can be connected to a
larger network. (3) See also Ethernet and token ring.

local copy. A printer session initiated by a personal
computer user or host that reproduces a presentation
space with all supported graphics.

local LU. A logical unit not distributed over the LAN,
but controlled by a gateway personal computer. This is
normally a physical device such as a workstation,
printer, or terminal.

logical terminal (LT). (1) A terminal with a name
related to one or more physical terminals. (2) The
definition of a specific 3270 terminal emulation session.
See also host session.

logical terminal ID. See logical terminal identifier.

logical terminal identifier (LT ID). An identifier for the
LU type specified in the gateway host profile. In
Personal Communications, up to 8 (unchangeable) IDs
can be displayed. See session ID.

logical terminal number. A number used to identify
DFT host sessions. A 3270 control unit controls some
number of sessions with the host. The control unit then
assigns from 1 to 5 of these sessions to a particular
coaxial connection and assigns each session an LT
number from 1 to 5.

logical unit (LU). A type of network accessible unit
that enables users to gain access to network resources
and communicate with each other.

logon. The process of accessing a domain and
assuming a user ID.

LT. See logical terminal.

LU. Logical unit.

LU 2. A type of LU for an application program that
communicates with a single display workstation in an
interactive environment, using the SNA 3270 data
stream.

LU 3. A type of LU for an application program that
communicates with a single printer, using the SNA 3270
data stream.

LU 6.2. A type of LU that supports sessions between
two applications in a distributed data processing
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environment using the SNA general data stream, which
is a structured-field data stream, or a user-defined data
stream.

LU address. In Personal Communications, a number
from 02 to 254 assigned by the host to represent the
remote partner in an SNA session.

M
MAN. Metropolitan area network.

mantissa. The decimal part of a common logarithm.

mark. A symbol or sequence of symbols that indicate
the beginning or end of a field, word, data item, or data
set.

menu. A list of available operations. You select which
operation you want from the list.

messaging name. A name under which messages
can be received.

metropolitan area network (MAN). A network formed
by the interconnection of two or more networks which
may operate at higher speed than those networks, may
cross administrative boundaries, and may use multiple
access methods. (T) Contrast with local area network
(LAN) and wide area network (WAN).

modem. A serial data translator that converts digital
signals into analog signals at transmission, and on
reception, converts analog signals back into digital
signals. Modems are used primarily for telephonic
computer communication. Synonymous with
modulator/demodulator.

multiplexer (mux). A device capable of interleaving
events of two or more activities, or of spreading the
events of an interleaved sequence of the multiple
activities.

mux. See multiplexer.

MVS. See Operating System/Virtual Storage Version 2.

N
NA. Not applicable. When this appears in a calling
parameter position, it means that PC400 EHLLAPI does
not require this parameter to perform the specific
function.

NCB. See network control block.

netID. See network identifier.

NetBIOS. Network Basic Input/Output System. In
Personal Communications, an interface for application
programs (API) between a LAN adapter and a
token-ring network.

netname. The name used to identify a shared
resource on the network.

network. (1) An arrangement of nodes and connecting
branches. (T) (2) A configuration of data processing
devices and software connected for information
interchange. (3) A group of nodes and the links
interconnecting them.

network accessible unit (NAU). A logical unit (LU),
physical unit (PU), control point (CP), or system
services control point (SSCP). It is the origin or the
destination of information transmitted by the path control
network. Synonymous with network addressable unit.

network address. (1) According to ISO 7498-3, a
name, unambiguous within the OSI environment, that
identifies a set of network service access points. (2) In a
subarea network, an address, consisting of subarea and
element fields, that identifies a link, link station, physical
unit, logical unit, or system services control point.
Subarea nodes use network addresses; peripheral
nodes use local addresses or local-form session
identifiers (LFSIDs). The boundary function in the
subarea node to which a peripheral node is attached
transforms local addresses or LFSIDs to network
addresses and vice versa. Contrast with network name.

network addressable unit (NAU). Synonym for
network accessible unit.

network administrator. A person who manages the
use and maintenance of a network.

network application program. In the IBM Token-Ring
Network, a program used to connect and communicate
with adapters on a network, enabling users to perform
application-oriented activities and to run other
application programs.

network control block (NCB). A part of the network
control program that controls the resources used by the
communication network in a LAN attachment.

network name. The symbolic identifier by which users
refer to a network accessible unit, a link, or a link
station within a given subnetwork. In APPN networks,
network names are also used for routing purposes.
Contrast with network address.

network node (NN). See Advanced Peer-to-Peer
Networking (APPN) network node.

network node server. An APPN network node that
provides network services for its local LUs and client
end nodes.

node. (1) In a network, a point at which one or more
functional units connect channels or data circuits. (I)
(2) Any device, attached to a network, that transmits
and receives data. (3) An endpoint of a link or a junction
common to two or more links in a network. Nodes can
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be processors, communication controllers, cluster
controllers, or terminals. Nodes can vary in routing and
other functional capabilities.

non-return-to-zero inverted encoding (NRZI). A data
encoding method that ensures correct synchronization
of information in an analog data stream transmission.

nonswitched line. A communication line (such as is
used in the SDLC attachment) that is permanently
connected and does not require dialing to establish
communication. Contrast with switched line.

NPSI. See IBM NCP Packet Switching Interface
Program.

NRZI. See non-return-to-zero inverted encoding.

NUL. A transmission control character used as a filler
or for sequence control in network communication.

Num Lock. The keyboard mode entered after the
Num Lock key is pressed. When the Shift key is
pressed while in this mode, Num Lock is temporarily
discontinued.

O
ODBC. Open Data Base Connectivity. An interface that
allows applications to access data from many sources
using Structured Query Language (SQL) as a standard
for accessing data.

OIA. See operator information area.

OIA indicator. Characters or symbols in the operator
information area providing information about network,
workstation, gateway, or interface status. See also
operator information area.

operator information area (OIA). The bottom line of a
session window that shows information on status and
Personal Communications connections.

OLE. Object Linking and Embedding; OLE is a
COM-based technology that allows for the creation of
compound documents.

Operating System/Virtual Storage Version 2
(OS/VS2). A set of commands, subcommands, and
operands recognized by the host computer.
Synonymous with MVS.

P
packet. A discrete unit of information including
addressing and sequence information that can be sent
interleaved with other packets of the same and other
transmission sequences. Packets sent over X.25 virtual
circuits always follow the same route and arrive in the
order they were sent.

packet assembler/disassembler (PAD). A functional
unit that enables data terminal equipment (DTEs) not
equipped with an X.25 interface to use a
packet-switching data network. On the most common
PAD, data from ASCII start/stop DTEs is tranformed to
and from X.25 packets. See also packet,
packet-switching data network.

packet-switching data network (PSDN). A data
transmission system consisting of one or more host
systems and one or more network stations that
communicates using packets of information. The data is
sent in interleaved packets to distribute the flow of
information and maximize the data transmission
capabilities of the network. X.25 is a packet-switching
data network communication protocol. See X.25
network.

PAD. See packet assembler/disassembler.

parity bit. A binary digit appended to a group of binary
digits as needed to make the sum of all the digits either
odd (odd parity) or even (even parity).

PC Network. See IBM PC network.

PCSDIAL. A program that automatically dials a host
number, permitting a fast connection.

permanent virtual circuit (PVC). An X.25 virtual
circuit that is permanently established (by subscription)
and, therefore, needs no call-establishment protocol.
Contrast with switched virtual circuit.

physical unit (PU). The component that manages and
monitors the resources (such as attached links and
adjacent link stations) associated with a node, as
requested by an SSCP via an SSCP-PU session. An
SSCP activates a session with the physical unit in order
to indirectly manage, through the PU, resources of the
node such as attached links. This term applies to type
2.0, type 4, and type 5 nodes only.

physical unit identifier (PUID). In the gateway status
utility, five hexadecimal digits used to identify the
network station to the gateway.

PIU. Path information unit.

pooled LUs. Logical units that share host sessions in
a common pool to save system resources.

POR. See power-on reset function.

port number. In DFT attachment, the logical ports
assigned to a terminal by a control unit.

power-on reset (POR) function. A function that
allows the user to reset all logical terminals. The key
sequence for POR is Ctrl+Pause using the Enhanced
or Space Saving keyboards. Otherwise, the sequence is
Ctrl+F2 .
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preallocated LUs. Logical units only available to a
specified network station.

presentation space. The host display space for the
window.

presentation space position parameter. One of the
four parameters that you must specify for some
EHLLAPI functions. A position in the presentation space
from 1 to 3564.

printer utility. A utility that allows users to check the
status of the printers in their network.

private application. An application maintained for use
only on one computer or user, that is not available on
the network for other users.

program operator. The EHLLAPI program that
performs and monitors activities in a workstation
presentation space.

programmed symbol set (PS). A set of fonts that can
be system-defined or defined by the user and to which
a code can be assigned.

protected field. A field that holds data for viewing; the
data cannot be changed (at the current screen) by the
user.

protocol. A specification for the format and timing of
data exchanged between communicating systems. Also,
the set of rules governing the operation of units of the
communication system to facilitate communication.

PSDN. See packet-switching data network.

PSID. Presentation Space Identifier; a short
one-character or one-letter name of the presentation
space.

PU. Physical unit. See also physical unit identifier.

public application. An application shared among
users on a network.

PUID. See physical unit identifier.

PVC. See permanent virtual circuit.

Q
queue. A list of pending tasks for a computer or server
to execute in order.

R
redefinition file. See definition file.

request. A message unit that signals initiation of a
particular action or protocol. For example, Initiate-Self is
a request for activation of an LU-LU session.

requester. A computer that accesses shared network
resources through a server.

resource. A directory (files resource) or device used
by computers on a network.

response time monitor. A function that measures and
displays the host response time

RS-232C. See EIA 232 and V.24.

RSAP. Remote service access point. See service
access point.

run book. A supplemental guide, controlled by a
system administrator, that describes the implementation
and usage of a specific system configuration.

S
SAP. See service access point.

SAS. See session active screen.

SBCS. See single-byte character set.

SDLC. See Synchronous Data Link Control.

SDLC command. The control information in the C-field
of the link header, sent from a primary station to a
secondary station.

Server-Requester Programming Interface (SRPI).
An IBM application programming interface (API) used by
requester and server programs to communicate with the
personal computer or host routers.

service access point (SAP). The gateway address of
the controller. An SAP provides a point to link the
controller to the host system.

service coordinator. The person in your organization
responsible for answering hardware and software
computing questions.

service transaction program. Any IBM-supplied
transaction program running in a network accessible
unit. Contrast with application transaction program.

session. (1) A logical connection between a server
and a requester that was initiated by a successful
request for a shared resource. See also host session
and DOS session. (2) A logical connection between two
network addressable units that can be activated, tailored
to provide various protocols, and deactivated, as
requested.

session active screen (SAS). The display that is
active for the current communication session. See also
next-session-active-screen function.

session ID. An alphabetic ID (a through h) assigned
by Personal Communications to each session or screen.
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This applies to all types of host sessions and is used in
file transfers. See also short name.

shared resource. A directory or device made available
to users on a network. A shared resource is attached to
a server, but it is not attached to the requesters that use
them.

Shift Lock. The personal computer keyboard mode
entered after the Shift Lock key is pressed. In this
mode, the keyboard performs the function printed on the
upper half of the keytop. Press the Shift key to cancel
the Shift Lock mode.

short name. In Personal Communications, a character
displayed in column 7 of the operator information area
that shows the session ID. See also session ID and
operator information area.

single-byte character set. A character set in which
each character is represented by a one-byte code.

SMS Install. The Microsoft Systems Management
Server (SMS) product provides for the remote
installation and uninstallation of Personal
Communications.

SNA. See Systems Network Architecture.

SNA network. The part of a user-application network
that conforms to the formats and protocols of Systems
Network Architecture. It enables reliable transfer of data
among users and provides protocols for controlling the
resources of various network configurations. The SNA
network consists of network accessible units (NAUs),
boundary function, gateway function, and intermediate
session routing function components; and the transport
network.

Sockets over SNA. The AnyNet Sockets over SNA
access node function of Personal Communications
enables TCP/IP application programs using the
WinSock interface to communicate over an SNA
network.

source diskette. In a diskette copying procedure, the
diskette from which information is read.

SRPI. Server-Requester Programming Interface.

SSCP. System services control point.

SSCP-dependent LU. An LU that requires assistance
from a system services control point (SSCP) in order to
initiate an LU-LU session. It requires an SSCP-LU
session.

SVC. See switched virtual circuit.

switched line. A telecommunication line in which the
connection is established by dialing. See also switched
virtual circuit. Contrast with nonswitched line.

switched virtual circuit (SVC). An X.25 virtual circuit
that is dynamically established when needed. The X.25
equivalent of a switched line. Also known as a virtual
call. Contrast with permanent virtual circuit (PVC).

switch-screen function. A function that switches
keyboard control to the other screen, if two screens are
used. The key sequence for switch-screen is Alt+Tab .

Synchronous Data Link Control (SDLC). A discipline
for managing synchronous, code-transparent,
serial-by-bit information transfer over a line connection.
Transmission exchanges can be duplex (in both
directions at the same time) or half-duplex (in either
direction, one direction at a time) over switched lines or
direct lines.

system services control point (SSCP). A component
within a subarea network for managing the
configuration, coordinating network operator and
problem determination requests, and providing directory
services and other session services for users of the
network. Multiple SSCPs, cooperating as peers with one
another, can divide the network into domains of control,
with each SSCP having a hierarchical control
relationship to the physical units and logical units within
its own domain.

Systems Network Architecture (SNA). The
description of the logical structure, formats, protocols,
and operational sequences for transmitting information
units through, and controlling the configuration and
operation of, networks. The layered structure of SNA
allows the ultimate origins and destinations of
information, that is, the users, to be independent of and
unaffected by the specific SNA network services and
facilities used for information exchange.

T
target diskette. In a diskette or storage copying
procedure, the diskette onto which information is written.

template. See keyboard template.

terminal emulator. See emulator.

terminal operator. The human user of a EHLLAPI
application program. Contrast with program operator.

Time Sharing Option (TSO). A set of commands,
subcommands, and operands recognized by the host
computer.

token ring. (1) According to IEEE 802.5, network
technology that controls media access by passing a
token (special packet or frame) between media-attached
stations. (2) A FDDI or IEEE 802.5 network with a ring
topology that passes tokens from one attaching ring
station (node) to another. (3) See also local area
network (LAN).
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token-ring network. (1) A ring network that allows
unidirectional data transmission between data stations,
by a token passing procedure, such that the transmitted
data return to the transmitting station. (T) (2) A network
that uses a ring topology, in which tokens are passed in
a circuit from node to node. A node that is ready to
send can capture the token and insert data for
transmission.

trace size. See trace table.

trace table. A storage area that contains the records
of all Personal Communications operations. The trace
information can either be directed to the standard output
destination, or it can be redirected to a file.

transaction program (TP). A program that processes
transactions in an SNA network. There are two kinds of
transaction programs: application transaction programs
and service transaction programs. See also
conversation.

transferring files. Sending files from a personal
computer to a host system or vice versa. See download
and upload.

TSO. See Time Sharing Option.

U
UID. See user identifier.

unprotected field. A field that is available for the user
to enter or modify data.

upload. The transfer of a file from a personal
computer to a host system.

user ID. See user identifier.

user identifier (UID). A name that uniquely identifies a
user on a network or system.

user profile. A file containing values for setting up the
user environment, and that can be automatically
accessed when a user logs on.

utility programs. Programs that support operations of
Personal Communications, such as file transfer and
keyboard redefinitions.

V
V.24. An ITU-T recommendation that defines
interchange circuits between data terminal equipment
(DTE) and data circuit-terminating equipment (DCE).
When combined with the specification of electrical
characteristics given in ITU-T recommendation V.28, it
specifies a modem interface for data rates below 20
kilobits per second (which is equivalent to EIA 232).

V.35. An ITU-T recommendation that defines
interchange circuits and electrical characteristics
between data terminal equipment (DTE) and data
circuit-terminating equipment (DCE) at various data
rates. Originally defined for wideband modems, but now
commonly used for various data network services.

valid key. A key that is recognized by the host
session.

VB Scripting. An interface used with Personal
Communications to define and execute Visual Basic
scripts.

VGA. See video graphics adapter.

video graphics adapter (VGA). A computer adapter
that provides high-resolution graphics and a total of 256
colors. See also enhanced graphics adapter (EGA).

virtual machine (VM). A time sharing control program.

VM. See virtual machine.

VM/CMS. See Virtual Machine/Conversational
Monitoring System.

Virtual Machine/Conversational Monitoring System
(VM/CMS). A time sharing system control program that
manages the resources of an IBM System/370 such that
multiple remote terminal users have a functioning
simulation of a computing system at their disposal. The
Conversational Monitoring System provides general time
sharing, development, and problem-solving facilities.

Virtual Telecommunications Access Method
(VTAM). A host program for communication using
switched lines. See also switched line.

virtual route (VR). In SNA, either (a) a logical
connection between two subarea nodes that is
physically realized as a particular explicit route or (b) a
logical connection that is contained wholly within a
subarea node for intranode sessions. See also Systems
Network Architecture.

VR. See virtual route.

VS. Virtual storage.

VT terminal. A series of general purpose ASCII
terminals that were introduced by Digital Equipment
Company.

VTAM. See Virtual Telecommunications Access
Method.

W
WAN. See wide area network.

wide area network (WAN). (1) A network that provides
communication services to a geographic area larger
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than that served by a local area network or a
metropolitan area network, and that may use or provide
public communication facilities. (T) (2) A data
communication network designed to serve an area of
hundreds or thousands of miles; for example, public and
private packet-switching networks, and national
telephone networks. (3) Contrast with local area network
(LAN) and metropolitan area network (MAN).

X
X.21. An ITU-T recommendation for a general-purpose
interface between data terminal equipment and data
circuit-terminating equipment for synchronous operation
on a public data network.

X.25 network. A packet-switching data network linked
in accordance with ITU-T recommendation X.25.

X.25 Recommendation. An ITU-T recommendation for
the interface between data terminal equipment and
packet-switched data networks.

X.400. The message-handling services standard of
ITU-T and ISO.

XID. SNA exchange identification command. See also
Systems Network Architecture.

Numbers
3270 numeric field. A display field that accepts only
numerics (0–9), a minus sign, a period, a comma, and
DUP keyboard entries.
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error messages 97
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112
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B
batch file

editing 37
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batch file (continued)
using 34

C
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communications protocols

APPC 14
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changing
SNA 28
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saving

SNA 27
workstation profiles 27

Configuration Update File Support 18
configuring

an emulator session 25
AS/400 107
CM Mouse 8
SNA nodes 75

conflicts, preventing 92
connection

checking 7
considerations and restrictions

attachment via AS/400 system 96
coax attachment 87
Home3270 95
IBM Global Network - SNA over Async 93
IBM Global Network Connection 94
LAN via IEEE 802.2 89
SDLC 91
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ZipPrint 41
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copylink 43
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a script 59
the AS/400 system mode description 109

customizing the menu bar 9

D
Data Transfer

description 63
data transfer
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Data Transfer
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DDE/EHLLAPI 43
default key functions
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combined package 146
PC/3270 package 141
VT220 package 147
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desktop 33
device description

AS/400 108
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DFT attachment, functions not available 88
directories created during installation 85
DOS EHLLAPI 8

E
edit-function restrictions with Home3270 attachment 45
emulator sessions
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exiting 38
starting 33
stopping 38

enabling
client/server applications 75
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end node 75
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error messages from the AS/400 system 97
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F
file transfer 9
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FTP 9
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G
Global Network 94
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the tool bar 51
windows 60
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Home3270 95
hotspots 53, 54
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IBM Global Network Connection considerations 94
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Information Bundler 4
installation planning 23
Internet Service 4
IWSAA Support 17

J
Java Interface for HACL 17

K
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default 141, 143, 147
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keyboard
file 55
functions 52, 143
setup 54

L
LAN adapter considerations 89
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licensing agreement 160
line speed

Home3270 attachment 95
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SDLC attachment 91

Load Balancing 17
Log Viewer 5
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LU 6.2 communications protocol 14
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macro
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functions 52, 53
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usage 58

memory requirements
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for Windows 95 24
for Windows 98 24
for Windows NT 24

menu bar
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messages
OIA 80
page fault 79

Migration Utility 5
mouse

file 57
setup 57

multiple sessions 9, 34

N
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NetWare for SAA Client (SNA) 153
Network Drives 73

Assigning 74
Setting up 73

network protocols
APPN 14

O
object-oriented API 16
ODBC Administrator 7
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OIA messages 79
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online help 79
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pastelink 43
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PCI MPA Adapter 18
PCMCIA configuration 88
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PCSWS.EXE

example 34
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options 36

PDT files 39
Personal Communications

directories 85
functions 9
icons 3
library 80
overview 9
program folder 3
requirements 23
subdirectories 85

ping 7
Polish Keyboard 457 19
pop-up keypad 57

(poppad) file 56
setup 56

poppad color 56
print screen 39
printer definition

file 39
table 39

printing
description 39
function 40
PROFS/OV note, calendar, document 40
ZipPrint 9, 41

private subdirectory 85
processing environment 23
PROFS/OV note, calendar, document printing 40

Q
q option 36
quit macro recording select 59

R
receiving data from the host 71
related publications 80
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hardware 23
software 24
storage 23
workstation 23

RichWin 19
running
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S
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sample 108
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saving
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script functions 52
SDLC attachment

considerations 91
performance consideration 91

Secure Sockets Layer 18
sending data to the host 70
sessions

automatically starting 38
configuring 4, 25
exiting 38
icons for 25, 33
IDs for 36
multiple 34
starting 33
starting specific session ID 36
stopping 38
window 33

setting up
a macro 59
a window’s appearance 50
the mouse 57
the pop-up keypad 57

Shared Folders
Assigning 74
overview 73
Setting Up 73

sharing system resources with MPA 92
show 50
showing

the menu bar 51
the status bar 51
the tool bar 51
windows 60

SLI 17
SLP Support

IP/IPX (QEL/MU) 17
TN3270 17
TN5250 17

SNA
node configuration 25

SNA node
configuration 4, 75
starting 76
stopping 76

SNA Node Configuration Verification 5
SNA Node Operations 5
SNA Sense Data 4
software requirements 24
spreadsheet, copying table data 44
starting

configuration setup 25
from the session window 33
macro playing 60
multiple sessions 34
sessions 33
SNA nodes 76
with a batch program 34
workstation profiles from the Start menu 34

stopping
macro playing 60
sessions 38

stopping (continued)
SNA nodes 76

storage requirements 23
subdirectories

PDFPDT 86
PRIVATE 85
samples 85

T
TCP/IP

connection considerations 89
protocol driver 89

Text Assist 71
Thai Language 149
Tivoli Support

Install 18
tool bar

setup 51
trace functions 5
trademarks 157
transferring

data 70
files 48

trim print 39
twinax

adapters, using 104
attachment, AS/400 device description 110

types of
hotspots 54
sessions 10

U
unsupported character sequences 95

V
VBScript 9
VT Enhancements 19

W
window

appearance 50
setup 50
view 60

Windows printer driver 39
WinHLLAPI 17
WinSock 3
Winsock 15
workstation profile 27, 34
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X
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Z
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